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1. Comparison: Free Viewer, Basic, Advanced, And Premium

Use the following comparison of 3D-Tool versions to find the version that matches your needs.

The major difference between the Basic, the Advanced, and the Premium version is the file formats that are
supported. Additionally, the Premium Version of 3D-Tool contains the 3D-NativeCAD Converter.

The 3D-Tool Free Viewer supports the 3D-Tool EXE and DDD file format and the STL format.
It is not possible to load more than one model at a time. Also, the Free Viewer cannot publish/save files and has

limited features.

Function

Free
Viewer

3D-Tool
Basic

3D-Tool
Advanced

3D-Tool
Premium

3D-NativeCAD-Converter

Convert CATIA, Pro/Engineer, Inventor, UG/Siemens NX,
SolidWorks, SolidEdge, STEP, IGS, VDA, SAT, Parasolid,
DWG, DXF, Rhino and JT files to CATIA, STEP, IGS, VDA,
SAT, SAB, X_T, ASAT, and STL.

3D Premium Import

CATIA V4 - *.exp, *.model, *.session
(Catia 4.1.9 - Catia 4.2.4)

CATIA V5 - *.catproduct, *.catpart, *.3dxml, *.cgr
(V5R8 - V5-6R2023)

CATIA V6 - *.catpart, *.catproduct, *cgr
(R2013 - V6R2023)

Pro/Engineer, Creo - *.prt, *.asm, *.xpr, *.xam
(16 - Creo 10.0)

Autodesk Inventor - *.iam, *.ipt

(11 -2024)

Unigraphics - *.prt

(11 - 18, NX - NX 2306)

SolidWorks - *.sldprt, *.sldasm

(98 - 2023)

SolidEdge - *.par, *.psm, *.asm

(18 - 2023)

JT - *jt

(V8 -V8-10.3, 10.5, 10.6, 10.7)

Rhino - *.3dm

(Version 2 - 7)

3DXML - *3dxml

(Version 4.0 - 4.3)

DWG / DXF - *.dwg, *.dxf (2.5 - 2024)

Product Manufacturing Information (PMI)

Display of Product Manufacturing Information for native 3D-
models out of CATIA V5/V6, UG/Siemens NX (from NX 6),
Pro/Engineer, Creo, SolidWorks, JT (from 10.2).

3D Advanced Import
3D Advanced Formats: STEP, IGS, VDA, SAT, and
PARASOLID.

3D Basic Import
3D Basic Formats: STL, 3MF VRML, SLP, XGL, OBJ, PLY,
3DS, ASC, IV

Import 3MF and STL files
Import models in 3MF and STL file format.

Import 2D Premium file formats
2D file formats: CATIA V5/V6 CATDrawing up to V5-6R2023,
SolidWorks up to 2023

Import 2D file formats
2D file formats: DXF, DWG, HPGL / HPGL2

Load 3D-Tool EXE/DDD files
Import 3D-Tool EXE and DDD files.

32bit and 64bit support
Both Viewer and Interfaces support 32bit and 64bit.

Load multiple files simultaneously
Merge multiple 3D-models and 2D-drawings.

Publish EXE/DDD files
Publish 3D-models and 2D-drawings together with the 3D-Tool
Viewer as directly executable EXE-files. DDD-files can be
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viewed using the 3D-Tool Free Viewer.

Publish 3D-PDF files
Publish models as 3D-PDF files to be viewed with the Acrobat
Reader.( 7.0.7 or higher).

Save as STL, VRML, 3DS, PLY, OBJ and U3D
Export the models from the 3D-Tool Viewer as faceted data
(mesh) into STL,VRML, 3DS, PLY, OBJ, or U3D files.

Support of 3D mouses
Use 3Dconnexion 3D mouses e.g. SpaceNavigator,
SpaceExplorer, SpacePilot, SpaceTraveller

Print
Print any 3D and 2D view or a combination of views.

Create PNG/BMP/JPG pictures
Save any 3D or 2D view or a combination of views as PNG,
BMP or JPG file.

Capture to clipboard
Select and copy a section of the screen to the Clipboard.

Hide and show parts
Hide and show parts, assemblies, and models.

Change the display of parts

Change the color of parts and assemblies, switch them
transparent, and show them in different render modes, e.g.
shaded, shaded with edges, hidden lines.

Custom Views

Save any 3D or 2D view as Custom View. Custom Views
contain the state and orientation of the model as well as all
display settings.

Cross sections
Create cross sections of the model, its assemblies, and parts.
Save the cross section line to a DXF-file.

3D annotations and dimensions
Measure distances, angles, radii, wall thickness, clearances,
minimal box, and contour length or make annotations.

2D markups and dimensions
Measure distances, angles, radii, add redline markups, and
insert text and pictures.

Assembly explode
Create exploded views of the model.

Animation
Combine Custom Views to animations.

Animation export as AVI video
Export 3D-Tool animations as AVI video.

Model compare
Graphically highlight the differences between two models.

Reference Points
Create reference points.

Tooling analysis
Display cavities, draft angles and undercuts and calculate the
projected area.

Wall thickness analysis
Calculate and display the wall thicknesses of a model.

Model-Info
Display the volume, the surface area, the dimensions, center of
mass, and the weight of models and parts.

Report
Create a summary Report with part information, BOM,
overview of the Custom Views.

Position and copy parts
Move, rotate, mirror, scale, and copy parts.

Property Editor
Change names, colors, and transparencies of parts and
assemblies.

Custom View Editor
Change the order and the names of Custom Views.
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Placement
Position and align parts.

Repair
Delete faces, reposition flipped faces, and connect open
edges.

RP-Layout
Place parts on a Rapid Prototyping System platform.
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2. Hardware And Software Requirements
Consider the following hardware and software requirements when you install 3D-Tool.

Hardware Requirements

We recommend a Desktop-PC, Laptop, or Tablet with a standard processor, at least4GB of RAM, and a screen

resolution of 1024 x 768 pixels or more. For bigger and more complex CAD models, we recommend a graphics
card which supports OpenGL 3.3 or higher.

The opening and conversion speed of CAD files when using the 3D-Tool Advanced and Premium interfaces
depend on the processor speed and the amount of RAM available. With increasing size CAD models require more

computing power and main memory. For big and complex CAD models we recommend a fast up-to-date
processor and 8GB of RAM or more.

Test of the Hardware Acceleration of the Graphics Card

The hardware acceleration of the graphics card can be activated to optimize the display speed. In order to activate
the appropriate hardware acceleration setting, 3D-Tool performs a short graphics card test.

Select "Start test" from the dialog window to start the hardware acceleration test or "Do not activate Hardware
Acceleration" to reject it.

o Depending on the result, the hardware acceleration with OpenGL 3.3 function is activated.

[ ]

If the graphics card does not support OpenGL 3.3 function, the hardware acceleration can also be activated
without it.

¢ Tip
Before starting the test, you should save your work in all other applications.
@ Note

Older graphics drivers could cause display errors after activation. In case of a faulty program display, disable

OpenGL 3.3 and, if necessary, the hardware acceleration under Preferences. Options tab > Preferences group >
Preferences button > Hardware.

Software Requirements

Supported Operating Systems

3D-Tool Basic / Advanced 3D-Tool Premium
Windows 7 (32/64bit) . .
Windows 8 / 8.1 (32/64bit) Pyingows 70 (64bit)
Windows 10 (32/64bit)
Windows 11

Software Requirements to use the Premium Import

The following software will be installed if necessary, together with 3D-Tool as it is required for the Premium
Import:

e Microsoft Visual C++2015-2022 Redistributable [x86/x64]
64bit Support

3D-Tool is a 32bit and 64bit software. The 64bit version of the program is supported by Windows 7 x64; Windows

8 x64, Windows 10 x64 and Windows 11. The 3D-Tool Premium interfaces and the 3D-Native CAD Converter are
only available in Windows 10 x64 and Windows 11.
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3. Activation and Licensing

Run 3D-Tool and use the 3D-Tool license dialog to activate a 3D-Tool License, request a Trial License, or start 3D-Tool
as Free Viewer.

Run as Free Viewer

Without a valid License Key or Trial Key, 3D-Tool can only be used as Free Viewer with limited features.

@ Note

The Free Viewer can be downloaded separately from our website: www.3D-Tool.de. The Free Viewer can be used
to view the small, easily sent 3D-Tool DDD files.

License Activation

Registration-1D: 01234 - 56789

No license available

Use this button to get a free 14 days Trial Key online. Get Trial Key
Use this button to create a new License Key online. Get License Key
Activate key

If you have received the License Key or Trial Key for this installation, enter it to
activate the instalation.

Activate key

Run as Free Viewer

Request a License Key
For each license you order, you will receive a License Certificate with an Authorization Key on it. After starting
3D-Tool, click Get License Key in the license dialog and enter your Authorization Key. Next, enter the e-mail
address to which you want the License Key to be sent. 3D-Tool will connect to the 3D-Tool website, your license
data will be checked, and within 60 minutes you will receive the License Key by e-mail. Requesting a License Key
this way requires an active Internet connection.

If your computer does not have an Internet connection or the connection fails, you can obtain a License Key by e-
mail to team@3d-tool.de or by fax. To do so, please provide the following:

e The Registration-ID from the 3D-Tool license dialog.

e The Authorization Key from the 3D-Tool License Certificate.

e The e-email address to which you want the License Key to be sent.

The processing of a request by e-mail can take up to two business days

Activation with the 3D-Tool License File
The e-mail with the Licensing Key has a license file (license.dat) attached. Saving this license file in the 3D-Tool
installation directory, will make 3D-Tool available to all user accounts on the computer.

Activation with the License Key
After receiving the License Key, enter it in the license dialog, and click on Activate Key. Now 3D-Tool can be
used. You must enter the License Key separately for each user account on the computer.

@ Note
A 3D-Tool Single User License may only be used on a single computer. A License Key will work only on the
computer for which it was requested. If the computer is replaced or newly setup, you have to request a new
License Key. The previous 3D-Tool installation may not be used any more and has to be deleted or uninstalled.

Reactivation After Changing Computers

If you replace the computer or newly install the operating system, you have to request a new License Key. See
License Activation above for further instructions.

Activating an Upgrade

If you have ordered an upgrade and received the new License Certificate run 3D-Tool, select the Options tab and
click Licensing in the Licensing group. The 3D-Tool license dialog is displayed. See License Activation above for
further instructions.

© 3D-Tool GmbH & Co. KG, 2023



3D-Tool V16 Manual Page 9

Activating an Update

After you have ordered an update and received the new License Certificate, download and install the newest
version of 3D-Tool from our website www.3D-Tool.com. See License Activation above for further instructions.

14 Day Trial License

Registration-ID: 01234 - 56789

E-mail address (used to receive the key)

Confirm e-mail address

Licensee (company or name) Country

Zip-Code City Street + Number

Please complete all fields.

For information on data privacy dick or open
www. 3d-tool.com/fen dataprivacy.htm

Internet proxy Alternative request
Windows settings (Internet Explorer) Click on our e-mail address to
request a key by e-mail.
Proxy server Port
Mo proxy used
Team@3D-Tool.de
Get key Close

Obtaining a Trial Key
To try all features of 3D-Tool, a 14 Day Trial License can be requested once. Run 3D-Tool and click Get Trial Key
in the licensing dialog. Next enter your e-mail address and contact information, and click Get key. 3D-Tool will

connect to the 3D-Tool website, your request will be checked, and within 60 minutes you will receive the Trial Key
by e-mail.

If your computer does not have a connection to the internet or the connection fails, you can obtain a Trial Key by
e-mail or fax. To do so, please, provide the following information:

e The Registration-ID from the license dialog.
e The e-mail address to which you want the Trial Key to be sent.

e Your contact information (company, address, and contact person).

@ Note

The Trial Key will only work on the computer for which it was requested. Only one Trial Key can be requested
online. If you need further Trial Keys, please send us an e-mail.

Activating the Trial Key
After receiving the Trial key, enter it in the license dialog and click on Activate Key to activate 3D-Tool for the 14
day trial period. To start, select a license for the current session: Basic, Advanced, or Premium. Only the

respective features and interfaces will by available during the session. That way you can try the 3D-Tool version
you intend to buy.

& Note

The 3D-Native CAD Converter is a discrete application and will work regardless of the license selected for a 3D-
Tool session.
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4. File Formats and Limitations

This section informs you about the file formats supported by 3D-Tool and about the limitations when viewing and

converting the files.

Supported File Formats

Find out which file formats can be opened and saved in the different 3D-Tool versions.

Load
3D-Formats Free 3D-Tool 3D-Tool 3D-Tool NativeCAD
Viewer Basic Advanced | Premium | Converter*
CATIAV4,419-424
(*.model, *.exp, *.session) ® % % v v
CATIA V5, V5R8 - V5-6R2023
(*.CATPart, *.CATProduct, *.cgr, *.3dxml) & ® ® v v
CATIA V6, V6R2013 - V6R2023, PMI display
(*.3dxml, *.CATPart, *.CATProduct, *.cgr) ® & ® v v
Pro/E, CREO, 16 - Creo 10.0, PMI display
(*.prt, *.prt.*, *.asm, *.asm.*, *.xpr, *.xas) & ® ® v v
Autodesk Inventor, V6 - 2024
(*.ipt off V6, *.iam off 11) ® % % v v
SolidWorks, 98 - 2023, PMI display from SW2014
(*.sldprt, *.sldasm) & ® ® v v
SolidEdge files, 18 - 2023
(*.par, *.psm, *.asm) ® % % v v
UG/Siemens NX, 11 - NX 2306
* ® *R ® v 1
(*.prt)
JT, V8 -V8-10.3, 10.5, 10.6, 10.7
(*.jt) ® *® R v v
Rhino, Version2to 7
(*.3dm) & & R v v
DWG, 2.5 - 2024 % . % v .
(*.dwg)
DXF, 2.5 - 2024
Parasolid files (*.x_t *.x_b) % ] v v v
STEP files (*.stp, *.step, ".stpZ) % % v v w
IGS files (*.igs) % % v v w
VDA files (*.vda) % 2 v v v
SAT files (*.sat, ASIC-Text) % Y] v v v
SAB files (*.sab, ASIC-Binary) % ) % v v
STL files (*.stl) v v v v )
3MF files (*3mf) v v v v 2
VRML1, VRML2 files (*.wrl) ® v v v 2
Render files (*.slp) % v v v 2
PLY files (*.ply) % v v v 2
XGL files (*.xgl *.zgl) ® v v v %
OBJ files (*.obj) 2 W v v 2
3DS files (*.3ds *.prj *.pli) % v v v 2
ASC files (*.asc) ® v v v T
Inventor files (*.iv) % v v v Y
3D-Tool files (*.ddd) W v v v 2
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3D-Tool EXE files (*.exe) v v v v )
2D-Formats Free 3D-Tool 3D-Tool 3D-Tool NativeCAD
Viewer Basic Advanced | Premium | Converter*
CATIA V5/V6 CATDrawings files (*.CATDrawing),
V5RS - V5-6R2023 ® a ® v R
SolidWorks files (*.slddrw), 2013 - 2023 ® ) v 2
DXF files (*.dxf) R v W v 2
DWG files, up to DWG 2018 (*.dwg) 2 v v v )
HPGL files (*.plt *.plo *.hpg *.hp2) ® v v v 2

* The 3D-NativeCAD Converter is part of 3D-Tool Premium.

@ Notes

e Toload a 3D DWG or a 3D DXF file, you have to select CAD - DWG files 3D - load as 3D (*.dwg) or CAD - DXF
files 3D - load as 3D (*.dxf) in the File Open dialog explicitly, otherwise the DWG/DXF file will be opened as 2D file

by default.
e HPGL/HPGL2 files can be created on any computer by printing with a HPGL compatible print driver.
Save
Formats I_=ree 3D-T<_)ol 3D-Tool 3D-T90I NativeCAD
Viewer Basic Advanced | Premium | Converter*

3D-Tool EXE-files (*.exe)
Viewer + 3D-models + 2D-drawing + Annotations +
Dimensions + = v v v =
Custom Views + Animations
3D-Tool files (*.ddd)
3D-models + 2D-drawing +
Annotations + Dimensions + & v v v &
Custom Views + Animations
3D-PDF files (*.pdf)
triangulated 3D-models ® v v v ®
CATIA V5 files, V5R15 - V5-6R2023
(*.catpart, *.catproduct) ® % % % v
3D-Catia V5 models
CATIA V4 files (*.model, *.exp)
3D-Catia V4 models » " * » v
STEP files (*.stp)
3D-STEP models & # # & v
IGS files (*.igs)
3D-IGES models » a * i v
VDA files (*.vda)
3D-VDA models & % # & v
SAT, SAB files, V7, V8, V10 - R2023 (*.sat)
V18 - R2021 (*.sab) % % % % v
3D-SAT models (ASIC-Text, ASIC-Binary)
Parasolid file, V12 — V35(*.x_t)
3D-Parasolid models (Parasolid-Text) ® ® % % v
STL files (*.stl)
triangulated 3D-models & v v v v
VRML 2.0 files (*.wrl)
triangulated 3D-models ® v v v ®
PLY files (*.ply)
triangulated 3D-models & v v v &
OBJ files (*.obj)
triangulated 3D-models ® v v v ®
3DS files (*.3ds)
triangulated 3D-models & v v v &
U3D files (*.u3d)
triangulated 3D-models ® v v v ®

* The 3D-NativeCAD Converter is part of 3D-Tool Premium.
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Limitations

Consider the following limitations when opening files with the 3D-Tool Viewer or converting files with the 3D-Native CAD
Converter.

Common File Limitation

Due to the complexity of CAD files and despite intense testing some files may fail to open/convert completely or
partially.

Limitations of 3D-Tool Viewer Functions

Common

Free Points and curves
Free points (reference points) and curves contained in 3D models are not supported by the Viewer for all formats
and also not for all import settings. Restrictions are described with the respective format.

Tools and Functions

Accuracy of measurement and analysis

3D-CAD files will be triangulated during their import into 3D-Tool, which means they are broken down into
triangles. Depending on the quality of the triangulation some imprecision may appear when measuring and
analyzing the 3D models.

Tooling Analysis

The projected area of a model is calculated using a graphical projection which could cause some imprecision.
Wall Thickness Analysis

The calculation of wall thicknesses is computationally intensive and can take hours for big models and high quality
analysis settings. Open edges and flipped surfaces may distort the results of the analysis.

Model Compare

The 3D-Tool Model Compare is a graphical/visual comparison by dyeing the models in different colors and then
superimposing them. Differences located inside the models can only seen by using cross section or by hiding
parts.

Information Tool

Information on volume and weight is only accurate for closed parts of models. Open edges and flipped surfaces
distort the volume calculation and may lead to wrong results. IGES files are especially susceptible to this.
Repair Tool

The automatic repair cannot always completely close models with open edges or flipped surfaces. To get a
"watertight" model more or less extensive manual repairs are needed.

Report function

Not all characters of the Unicode character set are supported when saving a report as a PDF file. The Indian
scripts Sanskrit, Tamil and Malyalam, among others, are not supported.

Limited Touch-Screen/ Tablet-PC support

Some 3D-Tool functions use mouse-over/hover effects. Not all mouse-over effects are available on a touch-
screen. The usability of these functions may be limited by the inaccuracy of the touch points.

Publish and Save

No downward compatibility of 3D-Tool files

3D-Tool EXE and DDD files published by a particular major version of 3D-Tool can only be opened by 3D-Tool or
the 3D-Tool FreeViewer in this or a newer major version.

Publish 3D-PDF

When publishing 3D-PDF files Custom Views or animations created with 3D-Tool will not be published.

Save STL files

To ease the editing of STL files, the "Save" function will automatically and without warning update open STL files
with the state present in 3D-tool. To avoid the automatic update of existing STL files, the "Save as ..." function
must be used.

Limitations of the 3D-Premium Import

The following limitations apply to CATIA, Pro/E, Creo, UG/Siemens NX, SolidWorks, SolidEdge, Inventor, Rhino,
JT, STEP, IGES, VDA, SAT, and Parasolid files during the Premium-Import into the 3D-Tool Viewer.

Common

32bit Operating System

The 3D-Tool Premium interfaces and the NCC are not supported on 32bit operating systems.

Assembly attributes

Attributes assigned on the assembly level are not read by the viewer or the converter, for example colors assigned
on the assembly level are lost and elements hidden on the assembly level will be loaded.

Assembly features

Features (e.g. cuts, bodies, holes) added on the assembly level are not supported and will be ignored by the
viewer or the converter. The support of patterns added on the assembly level is limited in the viewer or the
converter.

Properties and attributes
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General properties, such as color and name, are supported by the viewer and the converter to a limited extent.
Other properties and custom attributes are not supported by the viewer or converter unless specifically noted.
Material properties (name and density)

The converter does not support material properties. The viewer supports material names and material densities for
native models from CATIA V5/V6, Pro/Engineer, Creo, Siemens/UG NX, Inventor and SolidWorks. Loading the
material properties into the viewer does not work for the import settings "CAD - graphical data" and "NoHeal".
Further restrictions when loading material information can be found in the format-specific restrictions

Product Manufacturing Information

The viewer supports the display of most PMI-data for native models out of CATIA V5/V6, Pro/Engineer, Creo,
Siemens/UG NX, and SolidWorks. Also supported is PMI from STEP AP242 files, JT files from V10.2 as well as
from 3DXML files out of CATIA and SolidWorks. Limitations of PMI display can be found in the file format specific
limitations. The converter does not support the conversion of PMI data, not even to output formats that support
PMI.

2D-data / 2d-sketches

2D-data and 2D-sketches are not supported by the viewer or the converter.

Layers

Layers are not displayed in the viewer. In the converter the translation of layer information is limited.

Free parts, faces, and curves

The converter supports free parts, faces, and curves only on the top assembly level and not within sub-
assemblies.

Axes, planes, and local coordinate systems

The support of axes, planes, and local coordinate systems is limited in the converter.

User-defined views

User-defined views and component views are not supported by the viewer or the converter.

Graphical data (visualization data)

The converter does not support graphical visualization data that is contained in 3D-CAD files in addition to the
CAD/BREP-data. The viewer supports the display of this graphical data when the import settings are set to "CAD -
graphical data". The viewer will always read the highest level of display (LOD) from the part level. Graphical data
from the assembly level is not supported by the viewer. The support of curves in graphical data is limited. In the
Viewer the colors of graphical data may differ from the original.

Embedded triangulated data

Triangulated data embedded in 3D CAD files is not supported by the converter. The viewer will only read
embedded triangulated data when using the import setting "CAD - graphical data".

Suppressed elements

Suppressed element will not be read by the viewer and the converter, not even by activating the "Load hidden
elements" or "Convert hidden elements" option.

Hidden elements

Hidden elements will be read by the viewer and the converter when the "Load hidden elements" or "Convert
hidden elements" option is activated. If these hidden elements are converted to file formats that do not support
hidden elements (e.g. STEP) the hidden elements will be visible.

Native CAD Files

Native CAD files from alpha, beta, PR and training versions of CAD systems are not supported by the viewer and
converter.

3D-XML

The converter does not support 3DXML files.

The viewer will read 3DXML files featuring static tessellation. XML tessellation as well as XML files in Authoring
Mode are not supported by the viewer.

The Viewer does not support 3DXML files out of 3DExperience (CATIA V6) created via “VOC Simplification”.
The viewer does not support free points (reference points)

The viewer does not support the display of PMI-data from 3DXML files.

CATIAV5/V6

When reading CATPart files that contain bodies that share topology, the topology is duplicated for each body. This
may lead to very high memory usage and conversion time and may even cause the system to freeze.

The viewer and the converter will not support files made with CATIA educational licenses.

CGR files can be displayed in the viewer but are not supported by the converter.

All parts and sub-assemblies of an assembly file (*.CATProduct) have to be in the folder of the assembly file or
sub-folders, otherwise they will not be read by the viewer or the converter.

The viewer and the converter will read CATIA files with names that contain non-ASCII characters only from drives
providing 8dot3 file names.

During the conversion to CATIA V5, all non ASCII characters in file and part names will be replaced by an
underscore. Additionally, in part names the characters ! : / \\ will be replaced by an underscore.

During the conversion to CATIA V5, the attributes line-type, and line-thickness will only be translated for free wires
and curves but not for edges.

During the conversion to CATIA V5 multi-color wire bodies are output monochrome.

The viewer does not support the display of PMI-data without geometry references, for hole features in user
defined patterns, and hole features on assembly level. The Median Feature Symbol is not supported by the
viewer.

The viewer does not support free points (reference points) with the "Graphical CAD data" import setting.
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CATPart files created using the geometry scale "Small Scale" or "Big Scale" are not supported by the viewer and
the converter.

The converter supports only English characters in Publication Names. All non-English characters will be replaced
by a underline.

Due to hardware requirements, it may not be possible to view or convert CATIA V5 files using an older computer
(approx. before 2003). If you plan to use 3D-Tool Premium on such a system, request a free Trial Key to test the
import and conversion.

Pro/Engineer, Creo

All parts and sub-assemblies of an assembly file (*.asm) have to be in the same folder otherwise they will not be
read by the viewer or the converter.

The Viewer and the Converter do not support Simplified Representations at part level.

Instances in family tables are read by the viewer or the converter only if the corresponding XPR and XAS files are
present, even though these are only optional in Pro/E. Without the XPR and XAS files always the generic parts are
read.

The converter translates local coordinate systems only to file formats that support assemblies (CATIA V5, STEP,
IGES, ASAT).

The curves "using equation” and "local push" are not supported by the viewer or the converter.

Cosmetic features are not supported by the viewer or the converter.

The viewer supports product manufacturing information (PMI) starting with Pro/Engineer WF3. There is no support
of PMI on assembly level, without geometry reference, PMI text attributes (e.g. font and color), tapered hole
features, PMI set to “Remove from State”, unicode text, custom surface symbols and manually overwritten
dimension values. There is only limited support of PMI based on 3D-dimensions, for hole features and patterns, as
well as for combined geometric tolerances.

Hidden "merge features" may not be read correctly by the viewer or the converter.

Geometries that have been added to a component using SolidGeom filter are loaded by the viewer and the
converter, even if they have been hidden.

The viewer and the converter do not support flexible assemblies. Thus, positioning and/or sizing of these
components might be incorrect.

In certain complex BREP scenarios the viewer and the converter may not show the expected results for bodies
with multiple lumps or for lumps with multiple shells.

The viewer does not support electrical harness data - neither as BREPs nor as graphical visualization.

The viewer and converter do not support monolithic assembly files introduced with Creo 8.0. These are
assemblies that consist of a single file rather than multiple assembly and part files.

The viewer does not support free points (reference points) with the "Graphical CAD data" import setting.

UG / Siemens NX

All parts and sub-assemblies of an assembly file (*.prt) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the viewer or the converter.

2D-drawing included in a 3D-model will not be identified as a 2D-drawing by the viewer and will be partly loaded
as 3D curve elements together with the 3D-model.

For body cuts the viewer and the converter do not distinguish between the cutting tool body and the body to be
cut. Both will be loaded and converted as bodies.

Product manufacturing information (PMI) from Siemens NX10 models is not yet supported by the viewer or the
converter. PMI without geometry reference is not supported as well as PMI text attributes (e.g. font and color).
The viewer does not support Product manufacturing information (PMI) prior to NX6. PMI without geometry
reference is not supported. PMI text attributes (e.g. font and color) are not supported. PMI associated with datum
axis and Annular Region is not supported. Weld Symbols, center marks, tables and font settings are not
supported. PMI in drafting mode is not supported. There is only limited support for composite GD&T.

PMI in graphical CAD data (visualization data) is always loaded, even if they are hidden. Graphical PMI marked as
"Assorted Parts" is not supported.

The viewer does not support free points (reference points) and curves with the "Graphic CAD data" import setting.

SolidWorks

All parts and sub-assemblies of an assembily file (*.sldasm) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the viewer or the converter.

Colors are supported by the viewer or the converter starting with SolidWorks 2004.

The units of a model are read by the viewer or the converter starting with SolidWorks 2001. With earlier versions
the units are always assumed to be meters. This also applies to unsupported units such as feet and inches.
Hidden bodies and features within parts are not supported by the viewer or the converter.

There is only limited support of hole features in the converter and no support in the viewer.

Free points (reference points) are not supported by the viewer and converter.

Pattern features are not supported by the viewer and the converter.

The attributes "Show", "No-show" and "Hidden" will be read by the viewer or the converter starting with
SolidWorks 2004.

Hidden elements are supported by the Viewer and the Converter starting with SolidWorks 2009.

Configurations are supported starting with SolidWorks 98. In order to display and convert a part within an
assembly in its correct configuration, the according configuration must be saved in the part file. This is not
necessarily the case, especially not, if older parts have been opened and saved with a newer version of
SolidWorks. If configurations are missing, open the part in SolidWorks, activate each configuration, and save the
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part. Faulty or missing part configurations within SolidWorks assemblies may cause the viewer and the converter
to read the assembly only partially or not at all. The graphical data within SolidWorks files does not provide
configurations, thus when selecting a configuration for import into the viewer the viewer will always read the
CAD/BREP-data even if the import settings are set to "CAD - graphical data".

The viewer supports PMI starting with SolidWorks 2014 but only for the active configuration. PMI from inactive
configurations cannot be loaded. Not supported are Annotation PMI, Assembly PMI, PMI attached to edges, PMI
display information, and PMI display position.

Parts and Assemblies embedded via ,3D Interconnect*will only be supported by the viewer and the converter from
SolidWorks 2020.

3D sketches and free curves are only partially supported by the viewer and converter, and only when opening and
converting the active configuration. Hidden curves or curves that are only visible in other configurations can not be
loaded and converted. Curves in the graphical data of the active configuration are supported by the Viewer as of
SolidWorks 2014.

The viewer does not support graphical data from SLDPRT files generated from STL file data for SW2017 and
earlier.

External referenced features are not supported by the viewer and converter.

Coordinate systems, work planes, and free points are not supported by the converter.

Only unicode text from the "Basic Multilingual Plane" (Plane 0, BMP) is supported. Filenames from the
"Supplementary Ideographic Plane" (SIP) are not supported by the viewer or the converter.

SolidEdge

All parts and sub-assemblies of an assembly file (*.asm) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the viewer or the converter.

Coordinate systems (WCS) are not supported by the converter.

Simplified views will not be read by the viewer or the converter.

SolidEdge sub-assemblies can have multiple family tables. In the root assembly one can select one of the tables
for each instance of the sub-assembly. The viewer and the converter do not support this, so that the instances
may have unwanted or wrongly transformed parts.

The viewer does not support free points (reference points) and curves with the "Graphic CAD data" import setting.

Inventor

Rhino

Inventor Model States are not supported by the viewer and the converter. The active model state will be loaded.
All parts and sub-assemblies of an assembly file (*.iam) have to be in the same folder otherwise they will not be
read by the viewer or the converter.

Attributes, such as color and layer, are not read by the viewer or the converter.

Some special Inventor features, such as "Lofting" and "Weld Symbols", are not supported by the viewer or the
converter.

Free curves and points (reference points) are not supported by the viewer and the converter.

Flexible assemblies are not supported by the viewer and the converter. Positioning and/or sizing of flexible
components might be incorrect.

Tables are not supported by the viewer and the converter. The position and size of table-driven iParts and
iAssemblies may be incorrect.

The viewer and the converter do not support Inventor files that contain Mesh features, such as STL-data.
Sheet metal bodies are not supported by the viewer and the converter prior to Inventor version 11.

The viewer supports MESH objects only via the CAD graphical data import setting.
Layer information is not supported by the viewer and the converter. Only the current layer will be read.
Kilometer, mile, and higher units are not supported by the viewer and the converter.

JT

e "Big Endian" files are not supported by the viewer or the converter.

e The Name and Layer attributes are not supported by the viewer or the converter.

e Free points (reference points) are not supported by the viewer and the converter.

¢ Free curves within graphical data are not supported by the viewer.

e The viewer supports PMI starting with JT V10.2. PMI on assembly level and PMI display settings are not
supported. Black diamond symbols in geometric tolerances may cause confusion, because the interfaces of the
viewer and the converter use this symbol as field separator.

e The viewer and the converter will not support smart-topology-tables, STEP BREPs, AEC-shape- and ULP-
Segmente.

STEP

e The viewer supports PMI-data only for STEP AP242.

e The viewer does not support free points (reference points) with the "Graphic CAD data" import setting.

e The viewer does not support monolithic STEP assembly files, which contain only native graphical CAD data.

e Faceted data (FACETED_BREP) within STEP files may lead to very high memory usage and conversion time and
even to system freezes.

e Some CAD formats support mirroring and scaling of assembly instances. Converting such transformed instances
to STEP is not supported since the STEP format requires "manufacturable" products.

DWG/DXF
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e The viewer and the converter do not support block properties (Color, Layer, Hidden, Show).

The viewer and the converter only support the original RGB-color of an entity/layer. Insert Layer Mode color
handling is not supported.

The name of BREPs are not supported by the viewer and the converter.

AEC, AECB, and MEP entities are not supported by the viewer and the converter.

External references (XREF) are not supported by the viewer and the converter.

Generally the viewer and the converter will only support object of the basic version of AutoCAD and no industry
specific objects out of AutoCAD Architecture, AutoCAD Civil 3D, AutoCAD Electrical, AutoCAD Map 3D, AutoCAD
Mechanical, AutoCAD MEP, AutoCAD P&ID, AutoCAD Plant 3D and AutoCAD Utility Design.

IGES
e Binary and compressed IGES files are not supported by the viewer or the converter.
¢ IGES files often do not contain information on face normals (inside/outside). This may lead to flipped surfaces
when IGES files are imported into 3D-Tool. That means the inside of surfaces is turned outside which can have a
negative effect especially on volume calculation but also on all other analysis of the model.

VDA
e Errors can occur when reading VDA files with the viewer or the converter, especially if the accuracy of the VDA
data is insufficient. If such errors occur, as much data as possible is read.
Parasolid X_T

e The converter creates an empty Parasolid body for various types of elements such as material properties, axis
systems and user defined attributes. Some applications based on the Parasolid kernel have issues while opening
such files. This is not a limitation and we suggest that you contact the support for that particular Parasolid-based
application.

Limitations of the 2D-Premium Import

The following limitations apply to CATIA and SolidWorks drawings during the Premium import into the 3D-Tool
Viewer.

o Embedded pictures
The display of embedded pictures is not supported by the viewer

SolidWorks SLDDRW
¢ The sketch elements "Parabola" and "Conical" are not supported by the viewer.
e Shaded views are not supported by the viewer.
¢ Line styles are not fully supported by the viewer.

Limitations of the 3D-Advanced Import

The following limitations apply when opening models using the Advance interfaces.

¢ Open Edges
The Advanced-Import does not provide Healing for the generation of "watertight" models.
Due to the triangulation of the models during import generally there will be some open edges, in rare cases there
can be missing surfaces.

e STEP AP242
The Advanced-Import does not support graphical visualization data from STEP files (STEP AP242). Files
containing only visualization data cannot be opened. From files containing both, visualization and CAD data, only
the CAD data will be loaded.

e IGES
IGES files often do not contain information on face normals (inside/outside). This may lead to flipped surfaces
when IGES files are imported into 3D-Tool. That means the inside of surfaces is turned outside which can have a
negative effect especially on volume calculation but also on all other analysis of the model.

Limitations of the 3D-Basic Import

The following limitations apply when opening models using the Basic interfaces.

¢ VRML

The viewer will only load triangulated data (IndexedFaceSets) and has only limited support of transformations.
e Open Inventor 2.0

The viewer will only load triangulated data (IndexedFaceSets) and has only limited support of transformations.
o 3MF

The Viewer does not support the extensions Beamlattice, Securecontent and Slice.

Limitations of the 2D-Basic Import

The following limitations apply to DXF, DWG, and HPGL files when loaded into the 3D-Tool Viewer.

¢ Embedded pictures
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The display of embedded pictures in the viewer is limited.
¢ Filled polylines
Filled polylines (Trace entities) are not supported by the viewer.
e AEC Objects
AEC (Architecture, Engineering, and Construction) objects are not supported by the viewer.
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5. Mouse, Keyboard Controls And Touch Gestures
This chapter explains how to use 3D-Tool using the mouse, the keyboard and touchscreens.

3D Mouse

Use the 3Dconnexion 3D-mouses to move, rotate, and zoom the model in the view.

Supported 3Dconnexion mouses

3D-Tool supports these 3D-mouses made by 3Dconnexion:
SpaceNavigator

SpaceExplorer

SpacePilot

SpaceTraveller

SpaceMouse Wireless

SpaceMouse Pro USB/Wireless

SpaceMouse Plus USB

SpaceBall 5000 USB

The mouse buttons are set to Fit to screen.

You can adjust the speed and the assignment of the axes in the 3Dconnexion control panel.

@ Note
In case a supported mouse is not recognized, try updating the 3Dconnexion driver.

Limitations
The following 3D-mouses are not supported by newer 3Dconnexion drivers and thus are not supported by 3D-

Tool:

SpaceMouse Plus Serial
SpaceMouse Classic USB
SpaceMouse Classic Serial
SpaceBall 5000 Serial
SpaceBall 4000

CadMan

Mouse Actions
How to use the mouse and the mouse buttons during 3D- and 2D-mode.

Mouse Actions
r ry
15b GBP Eﬂ Ej @1 5 16
v v
Rotate Move Zoom Context menul| Select Partsl | Multi-Select
+ Saelection in tools

3D-Mode

Rotate the model
Press the left mouse button, and move the mouse.

Move the model
Press the right mouse button, and move the mouse.

Zoom in and out of the model
e Scroll the mouse wheel.
e Press the scroll wheel / the middle mouse button, and move the mouse.

Find a part of the model in the Model Tree
e Double-click a part of the model.
e Press [Shift] and click a part of the model.

Access frequently needed functions
¢ Right-click a part of the model.
o Right-click parts, assemblies, and models in the Model Tree.

Show hidden parts
Right-click into the background of the model.

Fit assemblies and parts to the display
Double-click assemblies and parts in the Model Tree.
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Select multiple parts on the model
Double-click the first part, press [Shift] and [Ctrl], and click more parts.
« Tip
To highlight the selected parts and assemblies in red, activate % Highlight Selection in 3D-Mode in the Model Tree
group.
Activate a model
Double-click the model in the Model Tree

Measure/Markup tool
¢ Move a dimension/annotation by pressing the left mouse button.
¢ Right-click a dimension/annotation to change its properties.

Explode tool > Manual Explode Functions
Double-click an exploded part to reset it.

Tooling Analysis tool
To pick a custom reference plane, press [Shift], and click on the model.

Painter and Repair tool
To choose triangles, planes and surfaces, press [Shift], and click on the model.

2D Mode

Move the drawing
Press the right mouse button, and move the mouse.

Zoom in and out on the drawing
Scroll the mouse wheel.

Annotate mode
o Move a dimension/markup by pressing the left mouse button.
e Double-click a dimension/markup to change its properties.
¢ Right-click a dimension/markup to call-up frequent functions.
e To scale a markup, press [Ctrl], and scale the markup by pressing the left mouse button.

2D-Tool mode
e To select an element of the drawing or a 3D-Tool dimension/markup, hold down [Shift], and click on the element.
e To select multiple elements, hold down the [Shift] and marquee select the elements while pressing the left-mouse
button.

Touch Gestures

3D-Tool supports touchscreens. Additionally, special controls were added for some features to increase the usability
with touchscreens.

Touch Gestures

T &A™

Rotate Move Zoom Context menu| Select Part

3D-Mode

Rotate the model
Move your finger in the screen in the direction that the model should be rotated.

Move the model
Touch two points of the screen, and then move your fingers in the direction that the model should be moved.

Zoom in and out of the model
Touch two points of the screen, and then move your fingers towards each other, to zoom in. To zoom out, touch

two points of the view, and then move your fingers away from each other.

Find a part of the model in the Model Tree
Double-tap a part of the model.

Access frequently needed functions
e Press your finger on a part of the model for approximately one second, and then release it.

e Press your finger on parts, assemblies, and models in the Model Tree for approximately one second, and then
release it.
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Show hidden parts
Press your finger into the background of the model for approximately one second, and then release it.

Fit assemblies and parts to the screen
Double-tap assemblies and parts in the Model Tree.

Activate a model
Double-tap the model in the Model Tree

Measure/Markup tool
o Select references for dimension/annotation by briefly tapping on the model, and confirm the selection each
time with .
Possible references will be shown in light blue
* Move a dimension/annotation by briefly tapping it, and then dragging it in the screen.
e Press your finger on a dimension/annotation for approximately one second, and then release it to change its
properties.

Explode tool > Manual Explode Functions
To reset exploded parts, double-tap on the exploded part.

2D Mode

Move the drawing
Touch and drag your finger in the view.

Zoom in and out on the drawing
To zoom in, touch two points of the screen, and then move your fingers towards each other. To zoom in. To zoom
out, touch two points of the view, and then move your fingers away from each other.

Annotate mode
o Double-tap a dimension/markup to change its properties.

e Press your finger on a dimension/markup for approximately one second, and then release it to call-up frequent
functions.

Limitations

Some 3D-Tool functions use mouse-over/hover effects. Not all mouse-over effects are available on touchscreen.
The usability of these functions may be more or less limited by the inaccuracy of the touch points.

Context Menu

Use the context menu to quickly access frequently needed functions. In a lot of cases, this eases working with the
different objects.

Open the context menu by right-clicking:

On models, assemblies, or parts in the Model Tree.

On the parts of a model in the display.

In 3D-mode in the background if parts are hidden or you are in full screen mode.

In the 3D-tool Measure and Markup on the textboxes of annotations and dimensions.
In 2D-Mode under Annotate on redline markups and 2D dimensions.

Some features can only be accessed through the context menu.

@ Note

Using touch gestures, the context menu opens by pressing the finger about one second on the object and then
release it.

@ Example

When displaying cross sections, parts of the model can be excluded from the cross section by selecting # Cross
section on/off from the context menu.

¢« Tip
The context menu makes full screen presentations easier because the most important menu items, as well as
default and customs views, can be accessed.

Function Keys
Use the function keys to quickly access certain functions.

[ESC]
Stop an animation or a Custom View Show.
Exit the full screen mode.
Abort the file import (if possible)
Abort the calculation in the Wall Thickness Analysis tool.
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Abort the creation of annotations and dimensions.
[DEL]

Delete the assemblies and parts selected in the Model Tree.

Delete the selected 3D/2D dimension or annotation.

[F1]

Open the Help.
[F2]

Zoom in.
[F3]

Zoom out.
[F4]

Fit to screen.
[F5]

Previous view
[F9]

Load view.

[F10]
Save view.

[Ctrl] + F
Search in the Model Tree.
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6. Open models and drawings
This chapter shows how to open 3D models and 2D drawings with the 3D-Tool Viewer.

Open models and drawings
You can load multiple models and drawings in one session or load each file individually in a separate 3D-Tool window.

Open 3D models

Open within 3D-Tool
Start 3D-Tool, and use the Open function in the File tab or click & Open in the Quick Access Toolbar. Then select
the file(s) with the File open dialog, and click Open.

Open with the Windows Explorer

o Via Double-click: 3D files that are supported by your 3D-Tool version can be opened by double-clicking them in
the Windows Explorer. 3D-Tool starts automatically and opens the file.
o Via Drag'n Drop: Start 3D-Tool, and drag the files from the Windows Explorer into the 3D-Tool window.

Import Settings
3D-CAD files are triangulated during their import into 3D-Tool. For graphical display the 3D-models are divided
into a mesh of numerous little triangles. To do so, the Import Settings dialog is displayed when opening the
following files:
e STEP, IGS, VDA, SAT, PARASOLID and JT files
¢ Native files of CATIA V4/V5, Pro/Engineer, Creo, Autodesk Inventor, SolidWorks, SolidEdge, UG/Siemens NXJT
and Rhino.

For details on the Import Settings see chapter Advanced/Premium Import Settings.

Combining multiple models
You can combine multiple models in one scene. Simply open the desired models via & Open or via Drag'n Drop.

« Tip
The 3D files will be put into the scene according to their coordinate systems. If a model is not positioned correctly,
it can be repositioned with the Placement, Move, or Rotate tool.

@ Notes

e Toload a 3D DWG or a 3D DXF file, you have to select CAD - DWG files 3D - load as 3D (*.dwg) or CAD - DXF
files 3D - load as 3D (*.dxf) in the File Open dialog explicitly, otherwise the DWG/DXF file will be opened as 2D file
by default.

¢ Loading multiple files is not supported by the 3D-Tool Free Viewer.

Load 2D Drawings

Load within 3D-Tool
Start 3D-Tool, and use Open function in the File tab or click &% Open in the Quick Access Toolbar. Then select the
file(s) with the File open dialog, and click Open.

Load with the Windows Explorer
¢ Via Double-click: 3D files that are supported by your 3D-Tool version can be opened by double-clicking them in
the Windows Explorer. 3D-Tool starts automatically and opens the file.
¢ Via Drag'n Drop: Start 3D-Tool, and drag the files from the Windows Explorer into the 3D-Tool window.

Combining multiple drawings

You can combine multiple models in the display. Simply open the desired drawings via & Open or via Drag'n
Drop. After the first drawing is loaded, the Load Position of 2D File dialog will be displayed offering the following
options:

o Replace current data
The new drawing replaces all currently loaded drawings.

e Add at original position
The new drawing will be added at its original position. This may cause the new drawing to be placed over
drawings that are already displayed.

¢ Add right of drawing
The new drawing will be added to the right of the existing drawing.

e Add top of drawing
The new drawing will be added on top of the existing drawing

e Abort
The new drawing will not be loaded.

Load DWG-files with multiple Layouts
DWG-files can contain multiple so called layouts. When opening them, a dialog appears for selecting the layout to
be loaded. The default layout is the one that was active during the generation of the DWG.
e Load all pages: Loads the DWG model and all layouts side by side in the view.
¢ Model: Loads the DWG model without the layout (e.g. the drawing frame).
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e Layout 1, Layout 2, etc: Loads the corresponding layout.

Load HPGL-files with multiple pages
HPGL-files can contain multiple pages. When opening them, a dialog appears for selecting the page to be loaded.
The default page is the one that was active during the generation of the HPGL file.
o Load all pages: Loads all pages side by side in the view.
e Page 1, Page 2 ... : Loads the corresponding page.

Recommended File Formats and Data Volume

Some formats work better than others with certain CAD programs. Here you can find some recommendations and
notes concerning the amount of data.

Recommended File Formats

CATIA V5/V6
CATPart, CATProduct, STEP, IGES, VRML, STL

CATIA V4
MODEL, EXP, STEP, IGES, VRML, STL

Pro/Engineer, Creo
PRT, ASM, STEP, IGES, VRML, SLP, STL

Autodesk Inventor
IPT, IAM, STEP, IGES, VRML, SLP, STL

SolidWorks
SLDPRT, SLDASM, STEP, IGES, XGL, VRML, STL

SolidEdge
PAR, PSM, ASM, STEP, IGES, XGL, VRML, STL

UG/ Siemens NX
PRT, JT, STEP, IGES, VRML, STL

SolidEdge
STEP, IGES, XGL, VRML, STL

IDEAS
STEP, IGES, STL, VRML

All other CAD programs
STEP, IGES, STL, VRML
« Tip
Use the filter settings in the File Open dialog to select the file formats.

Data Volume (Number of Triangles)

3D-Tool uses triangulated data to display 3D models i.e. they are pictured through numerous triangles. Generally,
there is no limit to the number of triangles.

Even though the quality of the display increases analogous with the number of triangles, the number of triangles
should not be set to the largest number possible. Too many triangles will slow down 3D-Tool, and eventually the
model cannot be handled properly. Most computers should be able to display up to one million triangles.

The number of triangles that are produced may be adjusted when importing native CATIA, Pro/Engineer, Creo,
Inventor, SolidWorks, SolidEdge and UG/Siemens NX files and STEP, IGS, VDA, SAT, PARASOLID and JT files
(see Advanced/Premium Import Settings).

For all other formats the number of triangles is affected by the output precision during the export of a model. To
adjust the output precision of triangulated files, see the Help menu or manual of your CAD software.

@ Example
A lot of CAD programs let you control the number of triangles when STL files are exported by setting the chord
height parameter.

Advanced / Premium Import Settings

During the Advanced and Premium import the Import Settings can be used to optimize the quality and speed of the
display.

3D-CAD files are triangulated during their import into 3D-Tool. For graphical display the 3D-models are divided into
a mesh of numerous triangles. To do so, the Import Settings dialog is displayed when opening the following files:
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e STEP, IGS, VDA, SAT, PARASOLID and JT files
o Native files of CATIA V4/V5, Pro/Engineer, Creo, Autodesk Inventor, SolidWorks, SolidEdge and UG/Siemens NX.

Import Settings

Chord height 0.050
] High Quality w

Angle contrel 20.00

Load 3D-BREPs and curves with high resolution settings.
- Use Healing to improve quality
- Optional PMI impert (if supported)

Options
18 Load PMI data
[ Load hidden elements

[[J Load face boundaries

Import Settings

The parameters Chord Height and Angle Control affect the accuracy/fineness of the mesh and thus:

The number of triangles

The quality of the display.

The display speed of the models.
The size of the file when published.
The loading time.

@ Notes

e The default values of the import setting can be adjusted through:
Options tab > Preferences group > Preferences > 3D-Import Advanced/Premium

e Depending on the import settings used some imprecision may appear in measuring and when analyzing the 3D
models.

< High Quality (Default)
The High Quality setting uses a chord height of 0.050 mm (0.002 inch) and an angle control of 20 degrees.

Usually, these values will assure decent results. They are a compromise between quality and speed. However,
large and complex models can make it necessary to increase the values, e.g. if the display speed of the model is
too slow. Also, if complex models are shared, the capacity of the recipient's computer should be kept in mind. Most
computers should be able to display up to one million triangles.

<1 Low Quality

The Low Quality setting uses a chord height of 1.000 mm (0.0394 inch) and an angle control of 30 degrees.

Compared to the High Quality setting these values can reduce the data amount up to 90%. For very big and
complex models this will speed up the display considerably yet will still provide enough accuracy for basic
measurement. But some inaccuracy is possible when measuring and analyzing small details.

& Custom Settings

The Custom Settings allow to enter any values for chord height and angle control.

Chord height (Default: 0,05 mm / 0.002 inch)
For the mesh of triangles used to display the models the chord height specifies the maximum distance the mesh
may differ from the original surface of the model. The smaller the value of the chord height is, the more precise
the display of the models will be, but the number of created triangles will be larger.

Angle control (Default: 20.0)
For the mesh of triangles used to display the models the angle control specifies the maximum angle between two
triangles. Smaller values will produce a more precise display but also more triangles. Valid values are between 0
and 90 degrees.

#= CAD Graphical Data - 3D-Tool Premium

The 3D-data created with professional CAD software may already contain a mesh of triangles to be used for
graphical visualization of the models. The CAD Graphical Data setting will use this mesh to display the models in
the 3D-Tool Viewer. If the model does not contain graphical data 3D-Tool will automatically use the High Quality
setting.
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NoHeal(BREPs only) - 3D-Tool Premium

Offers a faster and resource saving import by skipping all hidden elements and also bypassing the so called
Healing of geometry flaws. The display of PMI data is not supported with this import setting.

Import Options

Load PMI data (Default: active)

Load available product manufacturing information (PMI) when opening native CATIA, UG/Siemens NX (from NX
6), Pro/Engineer, Creo, SolidWorks and JT (from (10.2) - files.

The new STEP AP242 file format may also contain PMI data also. But to load the PMI data the @ CAD Graphical
Data setting must be used.

Read hidden entities (Default: inactive)
Import hidden elements with the imported files.

Load face boundaries as curves (Default: inactive)
Additionally to the faces of the model, load the boundaries of the faces will be loaded as curves. In the display the
curves will be shown as outlines of the faces illustrating the constructional design of the model.

Read Configurations
Pro/Engineer and Creo assemblies can contain Simplified Representations and SolidWorks models so called
Configurations. To set a representation/configuration for conversion, click the Read Configurations button.

@ Note

For native Pro/Engineer and Creo files, the default configuration will provide PMI data only.

© 3D-Tool GmbH & Co. KG, 2023



3D-Tool V16 Manual Page 26

7. Publish and Save (not available with the Free Viewer and in EXE files)
This section informs you about the different strategies to publish and share your CAD models.

Comparison of EXE, DDD and 3D-PDF Files
Consider the following characteristics, pros, and cons when publishing 3D-Tool EXE/DDD files and 3D-PDF files.

% Publish EXE File (not available with the Free Viewer and EXE files)

Publish all loaded 3D models and 2D drawings together with the 3D-Tool Viewer as a directly executable EXE file. 3D-
Tool EXE files run on any windows computer without further installations.

To publish an EXE file open the FILE tab, go to % Publish as ... and select = Publish as Viewer (*.exe); or click
on &% in the Quick Access Toolbar.

Open Publish as ...
Publish as 3D-Tool File (*.ddd)
Close 2D Drawing /3D Model b = Ea'-.'s al present 30 and 20 :orﬁsntas DDD file for the 3D-
ey ToolViewerand 3D-Tool Free Viewer,
Save
n Publish as Viewer (*.exe)
=Y Save all present 30 and 2D content together with the 3D-
SaVe as . ] Tool Viewer as directly executable EXE file,
% Publizh as .. ] Publish as 3D-PDF (*.pdf)
Eo  Save all currently loaded 30-models as 3D-PDF file for the
iEd Adobe Readerand other 3D-PDF readers.
I:' Create Picture b
E Capture to Clipboard
=, Print

Exit

Characteristics of EXE Files

3D-Tool EXE Files contain:

The 3D-Tool Viewer.

The 3D models including PMI, 3D-annotations/dimensions and materials.
The 2D drawings including 2D redline markups and 2D-dimensions.
Custom Views and animations.

The EXE files can be passed on by e-mail or data carrier. The recipient can open the EXE files on any windows
computer without further installations.

@ Note
3D-Tool EXE and DDD files published by a certain major version of 3D-Tool can only be opened by 3D-Tool or the
3D-Tool FreeViewer in this or a newer major version.
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Settings When Publishing an EXE File

Publish 3D-Tool File (3D-Viewer + Data)

Zip
B Indude 3D data e — << Help:  Online w
|| Zip the file Password
B indude 2D data Icon
© 30-Tool icon EE
() Create icon %
ﬂ Indude short message (max 2000 characters) = Load Transparent
Enter a short message to be displayed when the viewer is [ start with:
starting up.| Custom View Show
[CIFor viewing only
(Disable all measurement tools)
3D - Shade mode
© shaded
(_) Shaded with edges
3D - Back faces
() same color
(_)Red color
n Create file Cancel O None
Include 3D data
Publish all currently loaded 3D-models.
Include 2D data
Publish all currently loaded 2D-drawings.
ZIP the file
Create the EXE file and pack it into a ZIP archive (*.zip).
Password

Enter a password to protect a ZIP archive against unauthorized use.

Include short message

Enter a message of up to 2000 characters that will appear at the start-up of the EXE file. Use & Load to load a
text file (*.txt) as a message.

@ Note

Unzipping password protected 3D-Tool ZIP archives requires archive software supporting the AES 256 encryption
standard. The default Windows ZIP feature does not support this encryption, so that third party software is
required.

Creating a ZIP archive will make sending the file easier since the file will not be blocked by firewalls or anti-virus
software.

Options When Publishing an EXE File

Options

Click the [>>] button to make further adjustments.

o Viewer Help: Publish a help file with the viewer. The viewer is published without a help file by default, and starting
the help of the viewer will open the 3D-Tool online help.

e 3D-Tool icon: Use the 3D-Tool icon for the EXE file.

e Create icon: Creates the icon for the EXE file from the current view. The option Transparent will make the
background of the icon transparent.

e Start with: Start the EXE file with a Custom View Show, a certain Custom View, or an animation.

o View only: Hide all measuring tools in the Viewer, and prevent the EXE file from being re-imported into 3D-Tool.
The EXE file can still be loaded with the Free Viewer, but the measurement tools will remain hidden.
3D - Shade mode: Designate the shade mode of the models on startup.

o 3D - Back faces: Designate the display mode of the back faces on startup.
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@& Publish DDD File (not available with the Free Viewer and EXE files)

Publish all loaded 3D models and 2D drawings as a 3D-Tool DDD file. DDD files can be opened and viewed with the
3D-Tool Free Viewer on any computer with a Windows operating system.

To publish an DDD file open the FILE tab, go to % Publish as ... and select @& Publish as 3D-Tool File (*.ddd); or
click on @ in the Quick Access Toolbar and set the file type to *.ddd.

% Open Publish as ...

Publish as 3D-Tool File (*.ddd)

Close 2D Drawing /3D Model N §p Saveall present 3D and 2D content as DDD file for the 3D-
B R ToolViewerand 3D-Tool Free Viewer,

% Save
I Publish as Viewer (*.exe)

‘q Save all present 30 and 2D content together with the 3D-
Save as . ] Tool Viewer as directly executable EXE file.
& Publish as .. ] Publish as 3D-PDF {*.pdf)
Save all currently loaded 3D-models as 3D-PDF file for the

Skl

Adobe Reader and other 3D-PDF readers,

[al
w
B
o
m
=
a
E
m
]
=4

’1_‘[‘"& Capture to Clipboard
Print

Exit

Characteristics of DDD files

3D-Tool DDD files contain:

e The 3D models including PMI, 3D-annotations/dimensions and materials.
e The 2D drawings including 2D redline markups and 2D-dimensions.
e Custom Views and animations.

The DDD files can be passed on by e-mail or data carrier. The recipient can view the DDD files with the 3D-Tool
Free Viewer.

The Free Viewer can be downloaded free of charge from www.3D-Tool.com.

@ Note
3D-Tool EXE and DDD files published by a certain major version of 3D-Tool can only be opened by 3D-Tool or the
3D-Tool FreeViewer in this or a newer major version.

Settings When Publishing a DDD File

Publish File (as *.ddd - Data Only)

B Indude 3D data Zip =
@ indude 20 data [ zip the file Password
Icon
3D-Tool icon Iri_BD
Create icon
B Indude short message (max 2000 characters) B Load Transparent
Enter a short message to be displayed when the viewer is [ start with:
starting up. Custom View Show
For viewing only
3D - Shade mode
O shaded
(_) shaded with edges
3D - Back faces
(") Same color
(C)Red color
[H create fie Cancel © nene

Include 3D data
Publish all currently loaded 3D-models.

Include 2D data
Publish all currently loaded 2D-drawings.

ZIP the file
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Create the DDD file and pack it into a ZIP archive (*.zip).

Password
Enter a password to protect a ZIP archive against unauthorized use.

Include short message
Enter a message of up to 2000 characters that will appear at the start-up of the DDD file. Use & Load to load a
text file (*.txt) as a message.
@ Note
Unzipping password protected 3D-Tool ZIP archives requires archive software supporting the AES 256 encryption
standard. The default Windows ZIP feature does not support this encryption, so that third party software is
required.

Options When Publishing a DDD File

Options
Click the [>>] button to make further adjustments.
o Start with: Start the DDD file with a Custom View Show, a certain Custom View or animation.
¢ 3D - Shade mode: Designate the shade mode of the models on start-up.
o 3D - Back faces: Designate the display mode of the back faces on start-up.

i Publish 3D-PDF (not available with the Free Viewer and EXE files)
Publish all loaded 3D models as 3D-PDF file. 3D-PDF files can be sent easily by e-mail and viewed with the Adobe
Acrobat Reader.

To publish a PDF file open the FILE tab, go to % Publish as ... and select @ Publish as 3D-PDF (*.pdf); or click
on i3 in the Quick Access Toolbar.

Open Publish as ...
Publish as 3D-Tool File (*.ddd)
Close 2D Drawing /3D Maodel b ':b Ea'-.'s e" present 3D and 2D :::urfsr.tas DDD file for the 3D-
ey ToolViewerand 3D-Tool Free Viewer,
H Save
Publish as Viewer (*.exe)
= Save all present 3D and 2D content together with the 3D-
Save as . r Tool Viewer as directly executable EXE file.
% Publizh as .. ] Publish as 3D-PDF (*.pdf)
Gl Save all currently loaded 3D-models as 3D-PDF file for the
i8d Adobe Readerand other 3D-PDF readers.
I:' Create Picture ¥
E Capture to Clipboard
=, Print

Exit

Characteristics of 3D-PDF Files

3D-PDF files contain:

e The 3D models including PMI and 3D-annotations
3D models can be published as a 3D-PDF file. The recipient needs the Adobe Acrobat Reader (Version 7.0.7 or
higher) to view the file.

When publishing 3D-PDF files only the geometry and structure of the 3D models including PMI will be published
with notices and dimensions but not the Custom Views and animations created with 3D-Tool. Additionally, no
measurement and analysis operations will be available.

@ Note
3D-PDF files contain 3D-annotations, but no background images or text.

© 3D-Tool GmbH & Co. KG, 2023



3D-Tool V16 Manual Page 30

Settings When Publishing a 3D-PDF File

Publish 3D-PDF

- 3D projection 3D - Shade mode
Language:  English - () Perspective © shaded
Orthogonal () shaded with edges
B show Navigation Panel o g = g
8 Open FOF "I Password protected Background color l:l
Password
B 30-Tool controls and info text
Load logo Clear logo

no logo

Create PDF Cancel

Language
Select the language of the 3D-Tool controls in the PDF file (German or English).

3D projection
Designate whether the model will be displayed orthogonal or in perspective, when the 3D-PDF file is opened.

3D - Shade mode
Designate whether the model will be displayed shaded or shaded with edges, when the 3D-PDF file is opened.

Show Navigation Panel
Activate the Navigation Panel in the PDF document, which shows the model tree (the part structure of a model),
as well as some default views.

Open PDF
Open the PDF document right after it was created.

Password protected
Protect the 3D-PDF file with a password against unauthorized use.

Password
Enter a password to protect the 3D-PDF file.

Background color
Designate the background color of the 3D-PDF.

3D-Tool controls and info text

Activate additional 3D-Tool controls and info text in the PDF document that make it possible to:
Save and load views.

Change the color of parts and assemblies.

Explode assemblies.

Display an info text, if one has been added.

Display a company logo, if it has been loaded.

Load logo
Add a company logo, that will be displayed in the 3D-PDF file.

Clear logo
Clear the loaded logo.

@ Note
Unzipping password protected 3D-Tool ZIP archives requires archive software supporting the AES 256 encryption
standard. The default Windows ZIP feature does not support this encryption, so that third party software is
required.
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w Save as ... STL, VRML, 3DS, PLY, OBJ, U3D (not available with the Free Viewer and EXE files)

Save a 3D model or 2D drawing under a new name and in one of the available file formats.

Save a model or drawing by clicking Save as ... in the File tab, and then select a model or drawing from the list.

Open Save as ...

Save "Sample Fan_3D-2D" as

Close 20 Drawing /3D Madel ' Save 30 model under a new name or file format.

Save Save drawing as
H @ Save 20 drawing under a new name.

Save as . ]

% Fublish as .. ]
I:' Create Picture ¥
E Capture to Clipboard

=, Print

Exit

Batch Mode (not available with the Free Viewer and in EXE files)

Convert files to executable 3D-Tool files (viewer and data) via command line or create your own batch files.

Automatically Publish 3D-Tool EXE Files

Required parameters
Start 3D-Tool, open a file, and publish it in the same directory as 3D-Tool EXE file by using the following
command line:

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -exe

The -s parameter starts the automatic output.
If a file path contains spaces, the complete file path and file name must be enclosed in quotation marks.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -exe

Optional parameters
Optional parameters can be combined in any order.

-q:[high/low/cad/noheal/custom] (Default: custom)

Specify the import settings to be used for opening CAD models.

-q:custom = Use Chord Height and Angle Control as set in 3D-Tool Preferences

-g:high = High quality

-q:low = Low quality

-q:cad = CAD graphical data

-g:noheal = NoHeal (visible BREPs only without Healing)

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -exe -q:cad

-0: FilePath\FileName.exe

Specify the path and filename of the EXE file. If a file path contains spaces, the complete parameter must be
enclosed in quotation marks.

Folders that do not exist will be created.

By specifying the file extension *.exe the parameter -exe can be omitted.

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s "-0:D:\new
data\output\published_model.exe"

-zip

Automatically zip the EXE file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -exe -zip

-zippw:Password

Automatically zip the EXE file and protect the zip-archive with a password.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -exe -zippw:XyZ321
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-helpen

Publish the EXE file, including the offline help in English.
Example: "C:\program files\3D-Tool V16 13\3D-Tool.exe" "D:\new data\model.stp" - s -exe -helpen

-helpde

Publish the EXE file, including the offline help in German.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -exe -helpde

-m:ShortMessage

Publish the EXE file including a short message to be displayed when the file is opened.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -exe "-m:Request of 06. July
2015"

-png, -jpg or -bmp

Creates a PNG, JPG or BMP picture with four default views of the model in addition to the EXE file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -exe -jpg

@ Note

¢ Within Windows batch files (*.bat) special and international characters can only be used in file names and
parameters if a corresponding code page is specified via CHCP command.

¢ Unzipping password protected 3D-Tool ZIP archives requires archive software supporting the AES 256 encryption
standard. The default Windows ZIP feature does not support this encryption, so that third party software is
required.

Automatically Publish 3D-Tool DDD Files

Required parameters
Start 3D-Tool, open a file, and publish the file in the same directory as 3D-Tool DDD file by using the following
command line:

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -ddd

If a file path contains spaces, the complete file path and file name must be enclosed in quotation marks.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ddd

Optional parameters
Optional parameters can be combined in any order.

-q:[high/low/cad/noheal/custom] (Default: custom)

Specify the import settings to be used for opening CAD models.

-q:custom = Use Chord Height and Angle Control as set in 3D-Tool Preferences.

-g:high = High quality

-q:low = Low quality

-g:cad = CAD graphical data

-q:noheal = NoHeal (visible BREPs only without Healing)

Example: "C:\program files\3D-Tool V1613\3D-Tool.exe" "D:\new data\model.stp" -s -ddd -q:cad

-0: FilePath\FileName.ddd

Specify the path and filename of the DDD file. If a file path contain spaces, the complete parameter must be
enclosed in quotation marks.

Folders that do not exist will be created.

By specifying the file extension *.ddd the parameter -exe can be omitted.

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ddd "-0:D:\new
data\output\published _model.ddd"

-zip

Automatically zip the DDD file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ddd -zip

-zippw:Password

Automatically zip the DDD file and protect the zip-archive with a password.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ddd -zippw:XyZ321
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-m:ShortMessage

Publish the DDD file including a short message to be displayed when loading the DDD into 3D-Tool.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ddd "-m:Request of 06. July
2015"

-png, -jpg or -bmp

Creates a PNG, JPG or BMP picture with four default views of the model in addition to the DDD file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -ddd jpg

@ Note

e Within Windows batch files (*.bat) special and international characters can only be used in file names and
parameters if a corresponding code page is specified via CHCP command.

¢ Unzipping password protected 3D-Tool ZIP archives requires archive software supporting the AES 256 encryption
standard. The default Windows ZIP feature does not support this encryption, so that third party software is
required.

Automatically Publish 3D-PDF Files

Required parameters
Start 3D-Tool, open a model, and publish the model in the same directory as 3D-PDF file by using the following
command line:

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -pdf

If a file path contains spaces the complete file path and file name must be enclosed in quotation marks.
Example: "C:\program files\3D-Tool V13\3D-Tool.exe" "D:\new data\model.stp" - s -pdf

Optional parameters
Optional parameters can be combined in any order.

-q:[high/low/cad/noheal/custom] (Default: custom)

Specify the import settings to be used for opening CAD models.
-q:custom = Use Chord Height and Angle Control as set in 3D-Tool Preferences.
-q:high = High quality
-q:low = Low quality
-q:cad = CAD graphical data
-q:noheal = NoHeal (visible BREPs only without Healing)
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -pdf -q:cad

-o: FilePath\FileName.pdf

Specify the path and filename of the 3D-PDF file. If a file path contain spaces, the complete parameter must be
enclosed in quotation marks.

Folders that do not exist will be created.

By specifying the file extension *.pdf the parameter -pdf can be omitted.

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp” - s -pdf "-0:D:\new
data\output\published_model.pdf'

-en or -en

Activate the additional 3D-Tool controls in the 3D-PDF (cross section, explode, color)

/en activates the controls in English language.

/de activates the controls in German language.

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -pdf -en

-png, -jpg or -bmp
Creates a PNG, JPG or BMP picture with four default views of the model in addition to the PDF file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -pdf -jpg

@ Note
Within Windows batch files (*.bat) special and international characters can only be used in file names and
parameters if a corresponding code page is specified via CHCP command.

Automatically Save as STL, VRML, 3DS, PLY, OBJ or U3D File

Required parameters
Start 3D-Tool, open a model and publish the model in the same directory as STL, VRML, 3DS, PLY, OBJ or
U3D file by using the following command line:
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InstallationPath\3D-Tool.exe FilePath\CAD-file -s -OutputFormat

If a file path contains spaces, the complete file path and file name must be enclosed in quotation marks.
Supported output formats are:

-stl
Saves the model as binary STL file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -stl

-wrl
Saves the model as VRML file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -wrl

-3ds
Saves the model as binary 3DS file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp” - s -3ds

-ply
Saves the model as binary PLY file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -ply

-obj
Saves the model as OBJ file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -obj

-u3d
Saves the model as U3D file.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" - s -u3d

Optional parameters
Optional parameters can be combined in any order.

-q:[high/low/cadnoheal/custom] (Default: custom)

Specify the import settings to be used for opening CAD models.

-q:custom = Use Chord Height and Angle Control as set in 3D-Tool Preferences.

-q:high = High quality

-q:low = Low quality

-q:cad = CAD graphical data

-q:noheal = NoHeal (visible BREPs only without Healing)

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -stl -q:cad

-o: FilePath\FileName.OutputFormat

Specify the path and filename of the output file. If a file path contain spaces, the complete parameter must be
enclosed in quotation marks.

Folders that do not exist will be created.

By specifying the file extension OutputFormat the parameter -OutputFormat can be omitted.

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp” - s "-0:D:\new
data\output\converted_model.stl"

-png, -jpg or -bmp
Creates a PNG, JPG or BMP picture with four default views of the model in addition to the 3Dfile.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -stl jpg

@ Note
Within Windows batch files (*.bat) special and international characters can only be used in file names and
parameters if a corresponding code page is specified via CHCP command.

Automatically Create PNG, JPG or BMP Files

Required parameters
Start 3D-Tool, open a file, and create a PNG, JPG or BMP file in the same directory by using the following
command line:

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -png
resp.

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -jpg
resp.

InstallationPath\3D-Tool.exe FilePath\CAD-file -s -bmp

© 3D-Tool GmbH & Co. KG, 2023



3D-Tool V16 Manual Page 35

If a file path contains spaces the complete file path and file name must be enclosed in quotation marks.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -jpg
-o:FilePath\Filename.jpg

Optional parameters
Optional parameters can be combined in any order.

-q:[high/low/cad/noheal/custom] (Default: custom)

Specify the import settings to be used for opening CAD models.

-q:custom = Use Chord Height and Angle Control as set in 3D-Tool Preferences.

-g:high = High quality

-q:low = Low quality

-q:cad = CAD graphical data

-q:noheal = NoHeal (visible BREPs only without Healing)

Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new data\model.stp" -s -jpg -q.cad

-o: FilePath\FileName.jpg

Specify the path and file name of the PNG/JPG/BMP file.

If a file path contain spaces, the complete parameter must be enclosed in quotation marks.
Folders that do not exist will be created.

By specifying the file extension *png, *.jpg or *.bmp the parameter -jpg and bmp can be omitted.
Example: "C:\program files\3D-Tool V16\3D-Tool.exe" "D:\new\model.stp" -s "-0:D:\new data
\output\model_picture.jpg"

@ Notes

e The -png, -jpg and -bmp parameters can be used as optional parameters combined with the export formats as
described above.

¢ Within Windows batch files (*.bat) special and international characters can only be used in file names and
parameters if a corresponding code page is specified via CHCP command.
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8. Print and Create Pictures
Create print-outs and pictures of the current view or your Custom Views.

The functions to create print-outs and pictures are located in the File tab and in the Quick Access Toolbar.

E Print

Print the current view or any available Custom View. To do so, a number of options, including a preview, are available.

To print views, click Print in the File tab or the E icon in the Quick Access Toolbar.

Template Template Pen assignment

20: Black lines B 20: Black lines
Land: : 1 view Land: : 1view 8 Use pen table
e = B tmprove quality (Antialias) e - Improve quality (Antialias)
8 Incude file info 8 white background White background
Zoom Zoom oz 0.15 mm
HP LaserJet M1530 MFP Series PCL & w HP LaserJet M1530 MFP Series PCL & “ ) zoom al o 3 0.15mm
i o -+ B 4 0.15mm
a4 ~ Printer setup 9 =D .| a4 v| [ Printer setup 9 View )
(_)By scale () By scale
* e bau
Freioy

L

Color Pen width

0,150

Print Cancel Print Cancel

Template
Select a pre-defined template for printing. You can select the orientation of the paper (horizontal or vertical) and
the number and type of views to be used.

Include file info (in 3D-models only)

Add the file path and name of a 3D-model in the lower right corner of the print-out. The file information option is
available when only one model is loaded or when the Model-Info tool is activated and only one model or its parts

are selected in the Model Tree.
Printer and paper size
Select a printer and paper size from the two drop down lists.
Printer setup
Open the printer settings of the selected printer to make further adjustments.
@ Note
Selecting the horizontal or vertical paper orientation will not affect the format because the format of the Template
selected in 3D-Tool will be used.

2D - Print black lines (for 2D-drawings only)
Print all lines and text of 2D-drawings in black.

Improve quality (Antialias) (in 3D-models only)
Use Antialias when printing to smooth the edges.

Transparent background
Do not print the (colored) background of 3D-models. When printing 2D-drawings, the background will not be
printed unless the drawing is printed as Custom View within an accordant Template.

Zoom

e Zoom all: (in 2D-drawings only) Fit a drawing to the selected paper size.
e View: Print the current view.
o Scale: Define a scale for the print-out.

Depending on the Template and Zoom, further controls are available near the preview picture to adjust the position and
zoom of the models and drawings.

@ Note

The Scale option is not available for views of models in & Perspective View or for templates containing Custom
Views.

Pen assignment (in 2D mode only)
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Assign different line thicknesses to the colors of the drawing for the print-out.

Use pen table (Default: Active)

Use the line weights given in the table. If the pen table is not used, the original line thicknesses stored in the file

will be used for printing.

@ Note

If the option Use pen table is inactive, the line widths may cause poor readability when printing large format

drawings on small paper sizes.

1 Create Picture

Create a BMP or JPG image of the current view or any available Custom View. To do so, a number of options,

including a preview, are available.

To create pictures, click Create Picture in the File tab or the . icon in the Quick Access Toolbar

Create Picture

Create Picture

Template
20: Bladk lines

1 view

[ include file info B white background

c Custom resolution

e

[

) Custom

) 640 x 430
() 1024 x 768
© 1920 x 1080

PMG graphic *.png

1920 2 x 1440

Maintain aspect ratio

B Improve quality (Antialias)

Mas: 10000 x 10000 pixel

Template

1 view

PNG graphic *.png

[

e

() Custom
) 640 x 480
(11024 x 768

© 1920 x 1080

(

8 20: Black lines
Improve quality (Antialias)
B white backaround
Custom resolution
Max: 10000 x 10000 pixel

1920 2 x 1440

Maintain aspect ratio

d z
=

B

:.” T

- | +

Create Pic Cancel 3 D

Create Pic Cancel

[2D]

Zoom

Template
Select a pre-defined template for the picture. You can select the number and type of views to be used.

Depending on the Template, further controls are available near the preview picture to adjust the position and
zoom of the models and drawings.

Include file info (in 3D mode only)
Add the file path and name of a 3D-model in the lower right corner of the picture. The file information option is
available only when one model is loaded or when the Model-Info tool is activated and only one model or its parts
are selected in the Model Tree.

2D - Print black lines (for 2D-drawings only)
Print all lines and text of 2D-drawings in black.

Improve quality (Antialias) (for 3D-models only)
Use Antialias when printing to smooth the edges. Antialias is only works with 3D-models.

White background
Do not show the (colored) background of 3D-models and 2D-drawings.

File type

From the drop down list, select the file format:

PNG *.png

Creates a lossless PNG picture file

o JPEG *“.jpg

Creates a compressed JPEG picture file. The quality of the JPEG compression can be set in the Preferences:
Options tab > Preferences > Print/Picture/Snapshot

Bitmap *.bmp

Creates a lossless BMP picture file

Resolution
Select one of the pre-defined output sizes or activate Custom for a custom resolution. Unselect the Maintain
aspect ratio option to set the picture width and height independently.

@ Notes
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e The maximum resolution depends on the graphics card and the operating system; therefore it could be less than
10000 pixels.
e Pictures of 10000x10000 pixels will use a lot of working memory.
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9. Common Functions

This section informs you about common functions which are available in the 3D and the 2D mode. An important feature
is the Custom Views because it is used by other functions.

3D Mode and 2D Mode
Use the 3D Mode to view 3D-models and the 2D Mode to view 2D-drawings.
To alternate between 3D and 2D click the 3D-Mode and 2D-Mode tab in the Mode group.

3D
Turn on the 3D Mode to view 3D-models. Clicking the 3D-Mode tab will do the same.

&2 2D
Turn on the 2D Mode to view 2D-drawings. Clicking the 2D-Mode tab will do the same.

The File Tab

Use the File tab to load, save, publish files, and create print-outs or picture files. Additionally, a list of recently used files
is shown.

File

Recent Documents
Open

C:\..\3D-Tool V16\samples\Sample Fan_3D-2D.ddd
Close 20 Drawing /30 Madel ¥

H Save
Save as.. ’

=4 Publish as .. ]
|:| Create Picture ]
E Capture to Clipboard
=, Print
Exit

“ Open
Open 3D-models and 2D-drawings. You can open multiple files by selecting them in the file open dialog.
[Detailed description]

Close 2D Drawing / 3D Model
Delete the 3D and/or 2D content that is currently loaded.

(= save
Save a 3D model or 2D drawing. If the original file format is available, the file will be saved under its original name
and format. Otherwise, you will be asked to choose a file name and format.

' Save as ...
Save a 3D model or 2D drawing under a new name or file format. Choose the model or drawing you want to save
from the list.

@ Publish as ...

Publish all currently loaded 3D models and/or 2D drawings.
Choose the desired type of publishing:

e Publish 3D-Tool File (*.ddd)
Save all 3D and 2D content to a DDD file for the 3D-Tool Viewer or the 3D-Tool Free Viewer.

e Publish Viewer
Save all 3D and 2D content together with the 3D-Tool Viewer as a executable EXE file.

e Publish 3D-PDF (*.pdf)
Publish all currently loaded 3D models as 3D-PDF file for the Adobe Reader or other 3D-PDF capable readers.

Further information can be found in the chapter Publish and Save.

I Create Picture
Create an image of the current view or any available Custom View. Choose the desired picture format:
¢ Create PNG [Detailed description]
Create an image in the PNG file format.
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e Create JPG [Detailed description]
Create an image in the JPG file format.

e Create BMP [Detailed description]
Create an image in the BMP file format.

5 Capture to Clipboard
Select and copy a section of the screen to the Clipboard.
Click the screen, hold the mouse button, and marquee select the desired section.
To copy the complete screen just click the screen.
Afterwards the picture can be pasted from the Clipboard into other applications.

You can adjust settings for the capture function in the Preferences:
Options tab > Preferences group > Preferences > Print/Picture/Capture

£ Print
Print the current view or any available Custom View.
Further information can be found in the chapter Print and Create Pictures.
Exit
Close 3D-Tool.
@ Notes
e The functions to save and publish files are not available with the Free Viewer and 3D-Tool EXE files.
e The functions to open and close files are not available with 3D-Tool EXE files.
e To ease the editing of STL files, the "Save" function will automatically and without warning update open STL files
with the state present in 3D-tool. To avoid the automatic update of existing STL files, the "Save as ..." function
must be used.

Custom Views

Save any 3D- and 2D-view as Custom View. Custom Views contain the state and orientation of 3D-models, the position
and zoom of 2D-drawings, as well as all display settings.

| % sssgm29 0 x|
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o S - =X ] .| & kAl ',i R ~~,i

r d T Mare !
D Tooman - EEr s~ o w Mt Modelirle wy  Embde PPt

Custom Views
| 30 Standard

1 Sample Fan_i0-I0

Save and Select Custom Views

The functions to save and select Custom Views are located in the right info panel beneath the Model Tree.

A Master View
Show all parts, fit the parts to the display, and apply the default display settings.

[<] Previous Custom View
Load the previous Custom View from the Custom View List.

[>] Next Custom View
Load the next Custom View from the Custom View List.

& Save Custom View
Save the current view as Custom View. Enter a name in the succeeding window or overwrite an already existing
view.

5 Undo View
Return to the previously displayed view.

Select a View from the list
Click the drop down list of Custom Views to open it. Move the cursor over the views in the list. A preview of the
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views will be displayed to the left of the list. Click the view you want to be displayed.

@ Notes
e Custom Views will be added to the end of the list.

¢ You may delete, arrange and rename Custom Views by using the & Custom View Editor:
3D-Mode tab > Tools group > More tools

Why Use Custom Views?

3D-Tool offers many possibilities to show important aspects of a construction:

Rotate the models into the desired position and zoom in on important sections.
Hide distracting parts.

Hide individual 3D dimensions and markups.

Assign transparencies, or display parts graphically distinct.

Use cross sections to show the inside of the model.

Explode assemblies to show their structure.

Save these setting in Custom Views. If you publish 3D-Tool DDD or EXE files, your Custom Views are included
and can be recalled by you or the recipient of your data whenever needed.

@ Note

Animations are also based on Custom Views. Custom Views can be used with the templates when printing or
creating pictures.

What Is Stored in Custom Views

Custom Views store:

The orientation, position, and zoom of the model or the drawing.

The render mode of parts (transparent, shaded, shaded with edges, etc).
The shown and hidden parts.

The shown and hidden 3D dimensions and markups.

The exploded position of parts.

All cross section settings.

All display settings

The lighting position.

@ Note
The color and coordinates of 3D parts and elements of 2D drawings are global values. When you change the color
or coordinates of an element (move, turn, scale, mirror, delete), the change will affect all Custom Views. This may

cause Custom Views not to be displayed as they were previously saved. Create Custom Views only if the color
and coordinates of elements are final.

Presentation
Use the following features to present your models, Custom Views and animations.

The presentation functions are located in the Presentation group of the 3D-Mode and 2D-Mode tab.
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H Animation
The Animation tool creates animations from Custom Views.
Further information can be found in the chapter 3D-Mode > 3D-Tools > Animation.
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EJ Full Screen
Switch the display to full screen mode. The 3D-Tool user interface will be hidden so that only the 3D-model or the

2D-drawing is displayed.
In full screen mode, right-click into the display to access often needed functions.

To exit the full screen mode press [Esc] or via right-click into the display > Exit full screen.

@ Note
During the full screen mode, the Hardware acceleration is not available and the display will respond slower than

usual.

& Custom View Show
Start a slide show of all available Custom Views. All Custom Views will be displayed in order. Stop the Custom
View Show by pressing Esc or by clicking into the display.

H Start Animation
Start an animation, e.g. Rotate right, and animations created with the Animation tool. Stop the animation by

pressing Esc or by clicking the display.

Change the Width of the Side Panel

Adjust the width of the right side panel to your personal needs.
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Bl [ sample Fan 3D-2D

oﬁl 410_Housing

"y 611_Motor_ASM
mﬁ:l 611_Spacer
mﬁ:l 6511 _Bearing:1
mﬁl 611_Bearing:2

5y 812_Blade_ASM
" 812_Label
“& 812_Decal
mﬁ:l Case Draft

Custom Views

D

& < | =

Lighting / Background
0 Default
ArER.
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R
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Show and hide the side panel
To hide and show the side panel, click on the button on the left side of the list.

Adjust the size
The size of the side panel can be changed. Place the cursor on the left border of the bar and, after the cursor has
changed into the <||> icon, hold down the left mouse button and drag the border.
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10. 3D Mode

This section informs you about the 3D mode of 3D-Tool. The 3D mode offers a large number of functions and tools to

analyze models, assemblies and parts.

To display 3D-models, click the 3D Mode tab or the £ 3D Mode button in the Mode group.

Zoom Models

Besides the scroll wheel or the middle mouse button, you can use the following functions to zoom in on and out of the

models in the display.

The functions to zoom and fit the models are located in the Zoom group of the 3D-Mode tab.

iDiede  Mbdode  Optises

~ @
[ =) 4 i 123 = ) o B 3 Drasa
0 P, 2| ¥ Eeec- & S92 £ g 3 g ¥ B =
o ’ Cons [ % & g T T Meae g Hagort " Curitomn View Show [
30 |zooman o | O (Bl 5 - Maiuo  Moddindo gy Explod PO AN [ aion "
= - R = }
T J3 Previous View = = 8D=Took
b4 B Zoomin -, T
2
Zoom All 410 Moy
H S B0 Mobor ASHM
& ZoomOut ; Sl
-y 6L Bearing: |
chm 9 611_Boaring 2
11 Bl

]
Trimghts: 10260 ..

#.Zoom all
Fit everything visible in the display.

This function is also assigned to the function key [F4].

/4 Previous View
Undo the last zoom, move, or rotation of the view.

This function is also assigned to the function key [F5].

Zoom into an area. Click into the display, hold down the mouse button, and move the marquee across the area to

be zoomed.

This function is also assigned to the function key [F2].

# Zoom Out
Zoom out of the view. You may also zoom in and out using the scroll wheel.

This function is also assigned to the function key [F3].
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7 Cross Section

Use the Cross Section tool to view the inner structure of a model as well as selecting and measuring parts that are
difficult to access.

To create cross sections in 3D-Mode, click 7 Cross Section in the Display group.
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After activating the tool, the model will be displayed sectioned. The section settings are shown in the top of the
display. The cross section controls are shown in the display in front of the model.

Position and Align the Cross Section

Choose cross section plane
To choose one of the three standard planes as cross section plane, do one of the following:
¢ In the section settings choose one of the 3 standard planes:
J¥XY-Plane
A XZ-Plane
/2YZ-Plane
o Click one of the transparent planes of the cross section controls.

Pick cross section position on the model

To position and align the cross section by mouse click on the model the cross section settings offer the following:

e Set cross section position
Select ¥ Set cross section position and move the mouse pointer over the model. Points to set the cross section
plane will be highlighted in blue. Click to move the cross section plane to the point.

o Set cross section position perpendicular to curve/edge
Select t- Set cross section position perpendicular to curve/edge and move the mouse pointer over the model.
Curves/edges to set the cross section plane will be highlighted in blue. Click to move the cross section plane to
the middle of the curve/edge and align it perpendicular to the curve/edge.

e Set cross section position parallel to plane
Select ' Set cross section position parallel to plane and move the mouse pointer over the model.
Model planes to set the cross section plane will be highlighted in blue. Click to align the cross section plane
parallel to the model plane.

e Set cross section position to center of a circle
Select ©* Set cross section position to center of a circle and move the mouse pointer over the model. Centers of
circles to set the cross section plane will be highlighted in blue. Click to move the cross section plane to the
center of the circle.

Move the section plane

To move the section plane, do one of the following:

e Move the slider in the section settings.

o Enter a value in box above the slider.

o Click the small buttons left and right of the slider.
The << and >> buttons move the section plane in big steps.
The < and > buttons move the section plane in small steps.

e In the cross section controls click the shaft of the red arrow, hold down the mouse button and drag the section
plane to the wanted position.

Rotate the section plane
To rotate the section plane around the X, y, or z-axis, do one of the following:
o Drag the sliders in the section settings.
e Enter values into the boxes behind the sliders.

Switch the displayed side of the model
To display a different side of the sectioned model, do one of the following:
¢ In the section settings, choose one of the options Side 1, Side 2, or Cross section. Cross section will show only
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the cross section and hide both sides of the model.
¢ In the cross section controls, click the head of the red arrow to switch between Side 1 and Side 2.

¢ Tips

e Use cross sections with the Measure/Markup tool to measure inaccessible parts. Also, the points and edges of the
section line can be measured.

e Cross sections can be saved as a Custom Views. All cross section settings will be saved, including parts excluded
from the cross section.

Using the Cross Section Controls

To activate the cross section controls, select Show cross section controls from the = Cross section options.

Move the section plane
To move the section plane, click the shaft of the red arrow, hold down the mouse button and drag the section

plane to the wanted position.

Switch the displayed side of the model
To display a different side of the sectioned model, click the head of the red arrow to switch between Side 1 and

Side 2.

Choose cross section plane
To choose one of the three standard planes as cross section plane, click one of the transparent planes of the
cross section controls

Display Parts Uncut

To display a part uncut, right-click the part on the model or in the model tree and choose # Cross section on/off .
To display a part cut again, use # Cross section on/off once more.

To display all parts cut again, select ¥ Show all parts sectioned from the £ Cross section options.

Z Cross Section Options

¢ Show all parts sectioned
Use the cross section on all parts. Uncut parts will be sectioned again.

= Export cross section as DXF
Save the current section line as a 2D DXF file.
The Transform to xy-plane option transforms the section line to the standard XY-plane, so the cross section will
be shown accurately in 2D-CAD programs. Deselect this option to keep the 3D orientation of the section plane for
a 3D-CAD program.

Show cross section controls
Show the 3D cross section controls. The cross section controls let you move the section plane, switch the
displayed side of the model, and change the section plane.

Fill section
Fill the cross section using the colors of the cut parts.

Section line
Show/hide the section line. Change the color of the line in the 3D-Tool preferences:
Options tab > Preferences group > Preferences > 3D section
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Change the Display of Models

Use different render modes, such as shaded display and the display as wire frame. Also, you may adjust the display,
e.g. show the not connected edges of a model.

Change the Render Mode of Models

The functions to change the render mode of models are located in the Display group of the 3D-Mode tab.
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(7 Shaded Display
Display all parts shaded.

7 Shaded with Edges
Display all parts shaded with black edges.

£7 Shaded Mesh
Display all parts as shaded mesh.

& Wire Frame Display
Display all parts as wire frame.

0 Hidden Line Colored Display
Display all parts as hidden line graphics with lines in the color of the parts.

O Hidden Line Black/White Display
Display all parts as hidden line graphics with black lines on a white background.

£7 Mesh
Display all parts as mesh.

7 Vertices
Display all parts as vertices.
Right-click on parts to display them in an individual shade mode.
@ Notes
e To change the number of edges displayed with the render modes Shaded with Edges, Wire Frame, and Hidden
Line, use Change Wire Frame Angle in the Options tab.

o When opening CAD files (STEP, IGES, CATIA, Pro/E, etc.), the face boundaries of models can be loaded and
displayed as curves. To do so, activate the Load face boundaries as curves option in the Import Settings.
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Adjust the Display

The functions to adjust the display are located in the Display group of the 3D-Mode tab.
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7~ Show Curves

Show the 3D curves of the models.

@ Note
When opening CAD files (STEP, IGES, CATIA, Pro/E, etc.), the face boundaries of models can be loaded and
displayed as curves. To do so, activate the Load face boundaries as curves option in the Import Settings.

% Show Reference Points
Show the reference points that are present in the models.

¥ Show Dimensions and Markups
Show the 3D dimensions and markups created with the Measure and Markup tool.

% Show Exploded
Show the models exploded. Use the Explode tool to create explosion data for your models.

& Perspective View
Use perspective view instead of orthogonal view.

L~ Display Back Faces Like Front Faces
Display shaded faces with same colored back faces.

». Display Red Back Faces
Display shaded faces with red back faces.

. Display No Back Faces
Display shaded faces without back faces. This speeds up the display.

@ Note
Especially with STL files, it is possible that front faces are inverted. In this case, the faces cannot be seen with the
default setting Display No Back Faces. Change the display of the back faces to Display Back Faces Like Front
Faces to solve the problem.

&, Show PMI
Show the Product Manufacturing Information present in the models.

“’ Show Open Edges
Show the edges of planes that are not connected in yellow.

&’ Show Coordinate System
Show the absolute coordinate system as x-, y- and z-axis starting at (0,0,0).

i 3D-Compass
Show the x-, y- and z-axis as orientation in the lower left corner of the display.

2 Shiny Colors
Display surfaces with bright light reflections that give the model a shiny look and increase the 3D-effect. Switch off
the shiny colors, e.g. for a more technical viewing. The intensity of the reflection can be set in the Preferences:
Options tab > Preferences button > 3D-color

Smooth Display
Display shaded faces smoothed based on their smooth vectors. If smoothing is not satisfactory, use Adjust
Smoothing in the Options tab to calculate new smooth vectors.
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Rotate and Align Models

Use the following functions to rotate, fit and align the models in the display.

The functions to rotate and align the view are located in the Orientation group of the 3D-Mode tab.
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& Align View
Align the view to the X, Y and Z-axis of the coordinate system.

#Align plane parallel to view
Select Align plane parallel to view and move the mouse pointer over the model. Planes to align them will be
highlighted in blue. Click to align the selected plane parallel to view.

ZAlign curveledge perpendicular to view
SelectAlign curve/edge perpendicular to view and move the mouse pointer over the model. Curves/edges to
align will be highlighted in blue. Click to align the selected curve/edge perpendicular to view.

“I Align curveledge horizontal in view
Select™ Align curve/edge horizontal in view and move the mouse pointer over the model. Curves/edges to align
will be highlighted in blue. Click to align the selected curve/edge hoizontal in the view.

T:Align curve/edge vertical in view
SelectT Align curve/edge vertical in view and move the mouse pointer over the model. Curves/edges to align will
be highlighted in blue. Click to align the selected curve/edge vertical in theview.

£ Align cross section parallel to view
With activated Cross Section tool, click to align the selected cross section plane parallel to the view.

i Enter View Angle
[More information]

7 Front View
Rotate the view to front view, and fit all visible parts in the display.

@ Back View
Rotate the view to back view, and fit all visible parts in the display.

O Left View
Rotate the view to left view, and fit all visible parts in the display.

O Right View
Rotate the view to right view, and fit all visible parts in the display.

@ Top View
Rotate the view to top view, and fit all visible parts in the display.

(& Bottom View
Rotate the view to bottom view, and fit all visible parts in the display.

@ 3D View
Rotate the view to the standard 3D view, and fit all visible parts in the display.

iz0

= Rotate Horizontal 180°
Rotate the view horizontally by 180 degrees.

I’ Rotate Vertical 180°
Rotate the view vertically by 180 degrees.

% Rotate Normal 90°
Rotate the view by 90 degrees around the screen center.
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s Save Orientation
Save the current zoom and orientation of the view. To restore the view, use Load Orientation.

s Load Orientation
Restore a previously saved zoom and orientation of the view. To save views, use Save Orientation.

Set Manual Viewing Angle

Use the function to read out the current viewing angle and set a new viewing angle.

The functions to change and read the viewing angle is located in the Orientation group of the 3D-Mode tab.

Get the View Angle from the View
Click "Get View", to get the view angle with the values Roll (X), Pitch (Y) and Yaw (Z) from the current view.

To change the view angle
Enter values for the Roll (X), Pitch (Y) and Yaw (Z) to assign a new view angle.

Change Lighting, White Background

Change the lighting position to improve the contrast and show details more vividly. Use a white background for
screenshots.

The functions to change the Lighting Position and to switch to a White background are located in the right info
panel below the Model Tree.
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Change the Lighting Position

Adjust the lighting position by dragging the yellow light point to any position or choose Default.

Switch to White Background

Left of the lighting, you can switch between Normal and White background. This is useful:

e To take screenshots of the current view.

o If a model is displayed as wire frame or hidden line and the lines are difficult to see with the normal background.

@ Note
The color and the gradient of the normal background can be adjusted in the 3D-Display Options group of the

Options tab.
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The Model Tree

This section informs you about using the Model Tree in the right Side Panel.

& Note:
The Model Tree is not available with the 3D tools Tooling Analysis, Placement, Wall Thickness Analysis, Repair,

and RP-Layout.

Use the Model Tree

Use the Model Tree to show and hide models, assemblies, and parts and to select them for further steps.
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Elements of the Model Tree

The Model Tree can contain the following elements:
=l Active model / =l Inactive model

% Assembly shown / : Assembly hidden

"5 Part shown / " Part hidden

Click the icons of assemblies and parts to hide and show them.
Click the ®or the Zicon in front of assemblies to expand or collapse them.

o Double-click the names of models, assemblies, and parts to fit them in the display. Additionally, models will be
activated for the Placement, Wall Thickness Analysis and Repair tool.

Move the cursor over the models, assemblies, and parts in the Model Tree to highlight them for a short time in the
display. This can be deactivated in the preferences of 3D-Tool: Options tab > Preferences group > Preferences >
Model Tree

Selection on the Model Tree

Single selection
Click the names of models, assemblies, and parts to select them.

Range selection
To select a range of parts in the Model Tree, click a part and then press [Shift] while clicking another part. This
will select the clicked parts and all the parts in between.

Multiple selection
To select multiple parts in the Model Tree, click a part then press [Ctrl] while clicking additional parts.

Selection on the Model

Single selection
To select a part on the model, double-click the desired part or press the Shift key while clicking the part.

Multiple selection
To select multiple parts on the model, double-click a part on the model and then press [Shift] and [Ctrl] while

clicking additional parts.

Marquee select
To marquee, select parts by a selection rectangle click on % Pick Part from the Model Tree group. In the display,

press and hold the left mouse button and drag the selection rectangle over all wanted parts. Release the mouse
button and all parts that are completely within the rectangle will be selected.
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Part Display

Hide and show the models, assemblies and parts selected on the Model Tree or change their graphical display.

The functions to show and hide parts and to change their graphical display are located in the right side panel
above the Model Tree.
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= Show Parts
Show the parts and assembilies selected in the Model Tree.

X Hide Parts
Hide the parts and assemblies selected in the Model Tree.

Zi Show Selection Only
Show the parts and assemblies selected in the Model Tree and hide all others.

5 Undo Show/Hide
Undo the last show or hide action.

£ Change Color of Parts
Change the color of the parts and assemblies selected in the Model Tree.

7 Shaded Parts
Display the parts and assemblies selected in the Model Tree as shaded.

7 Shaded Parts with Edges
Display the parts and assemblies selected in the Model Tree as shaded with black edges.

& Wire Frame Parts
Display the parts and assemblies selected in the Model Tree as wire frame.

2 Reset Part Display
Reset the parts and assemblies selected in the Model Tree to the global shade mode as set in the Display group.

Parts Transparency On
Display the parts and assemblies selected in the Model Tree transparent.
Adjust the transparency in the 3D-Tool preferences:
Options tab > Preferences group > Preferences > 3D-Color

Parts Transparency Off
Display the parts and assemblies selected in the Model Tree solid.
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Search, Filter, Select

For models having a lot of parts and assemblies 3D-Tool offers helpful features to search parts in the Model Tree, to
filter the parts in the Model Tree and to select parts by a search term.

The functions to search, filter and select parts are located in the right side panel above the Model Tree.
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%= Search in Model Tree

Search in Model Tree

[ v
Indude assemblies

[Imatch case

D Regular expression

| Previous || Mext || Close |

Search for parts or assemblies in the Model Tree.

Enter a search string and click the Next button to search in the Model Tree downwards for the next part which
contains the search string in the name.

The Previous button reverses the search and searches upwards in the Model Tree.

¢ Include assemblies: Searches also in the names of assembilies.

March case: Considers the case-sensitivity during the search.
Regular expression: Use search string as regular expressions.

© Filter Model Tree
Filter Model Tree b4
[ >
[Jindude assemblies Non-matching parts
[Imatch case (®)Don't change
[IReqular expression 8 E::d‘;w
o | e |

Filter the parts and assemblies in the Model Tree.

Enter a search string and click OK.

Only parts which contain the search string in the name are displayed in the Model Tree.

In order to return to the unfiltered view of the Model Tree, click on ¥ Model Tree Filter off in in the right info panel
above the Model Tree. Or, open the ¥ Filter Model Tree tool again and click on the Filter off button.

Include assemblies: Searches also in the names of assemblies.
March case: Considers the case-sensitivity during the search.
Regular expression: Use search string as regular expressions.
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Non-matching parts
Here you specify how the filtered Model Tree affects the view of the model.

* Don't change: Don't change the visibility of parts not matching the filer criteria.
Show: Show all parts not matching the filter criteria.
Hide: Hide all parts not matching the filter criteria.

' Select in Model Tree

Select in Model Tree *

[ v

[incude assemblies
[Imatch case

|:| Regular expression
[Jadd to selection

K Close

Use a search string to select parts or assembilies in the Model Tree.

Enter a search string and click OK.

Only parts which contain the search string in the name are displayed in the Model Tree.

Now you can apply more Model Tree functions to the selection, such as: Show, Hide, Show Selection Only,
Transparency.

Include assemblies: Searches also in the names of assemblies.

March case: Considers the case-sensitivity during the search.

Regular expression: Use search string as regular expressions.

Add to section: Add findings to the current selection. If parts are already selected in the Model Tree, the selection
remains and the new findings are added to the current selection.

Arrange and Delete Parts
Delete, combine, move, and sort the parts in the Model Tree.

The functions to arrange and delete parts are located in the Model Tree Group of the 3D-Mode tab.
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£ Show All

Show all models, assemblies and parts.
% Hide All

Hide all models, assemblies and parts.
T Pick Part

To select one single part, just click on the part on the model. To select multiple parts, press and hold the mouse
button, then marquee select the parts by selection rectangle.

E Expand All
Expand all models and assemblies in the Model Tree. To expand a single model or assembly, click on the plus
symbols in the Model Tree.

E Collapse All
Collapse all models and assemblies in the Model Tree. To collapse a single model or assembly, click on the
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minus symbols in the Model Tree.

%: Highlight Selection
Highlight the parts and assemblies selected in the Model Tree in red.

& Model Tree on/off
Show or hide the Model Tree and the side panel.

Delete Parts
Delete all parts and assemblies selected in the Model Tree.

=

ug

Combine Parts
Combine all parts selected in the Model Tree to one part. The original names of the parts and their sectioning will
be lost. If a model or assembly is selected, all of its parts will be combined.

I:IuI:I

Rearrange Parts
Move the parts selected in the Model Tree to an existing or new assembly or model that can be specified in the
following dialog:

¢ Move to existing assembly or model
Select the assembly or model in the list, and click OK.

e Move to new assembly
Select the position of the new assembly in the list, and click on New assembly. The new assembly will be created.
The name of the assembly can be changed through a slow double-click on the name or with the Rename button.
Click OK to move the selection to the new assembly.

¢ Move to new model
Click on New model and the new model will be created. The name of the new model can be changed through a
slow double-click on the name or with the Rename button. Click OK to move the selection to the new model.

0go

Move Up
Moves the selected model, assembly, or part one position up in the Model Tree.

ogo

Move Down
Move the selected model, assembly, or part one position down in the Model Tree.

Sort Model Tree
Sort the parts in the Model Tree. Only the parts of the active model will be sorted by default.
Select For all parts and models to extend the sorting to all models in the Model Tree.

You can sort by:

Number of triangles
Volume

Volume of boundary box
Number of open edges,
Part name.

Selecting Direction will let you decide if the parts will be sorted upward or downward.
Rename parts creates new continuing element names after sorting. Caution: Old names will be lost.

& Note
To consistently sort the parts in the model tree, the assemblies of the models must be flattened.

w

Analyzing - Tools

This section informs you about using the Analyzing-Tools.

< Measure and Markup

Use the Measure/Markup tool to add 3D dimensions and markups to the models, and images and text to the
background.

The <” Measure/Markup tool is located in the Analysis group of the 3D-Mode tab.
To show and hide 3D dimensions and markups customized, click = which is located below the < Measure and
Markup tool.

Measure Distance, Angle, Edge, Boundary Box, Wall Thickness and Clearance
Measure distances, angles, edges, boundary boxes, wall thickness, and clearances.

I+

Click the <" Measure/Markup tool in the Tools group. Click the 2t Distance/Angle button to measure distances and
angles or click the little black arrow in the button to select another measure function.
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Picking References For Dimensions

Auto-selection

Move the cursor across the model and possible references will be shown in light blue. Click to select a reference.

After the references required for a measurement have been selected, the 3D dimension will be created.
Selection filter

For dimensions with two references, the automatic selection of the references can be adjusted with the Reference

selection filter:

“Plane

~Edge

= Vertex

ZCenter (Center of circle)

All four filters are active by default. If references are close together, the selection may be difficult. Deactivate all

filters that are not needed.

Manual selection of references

References for measuring distances can also be points and centers of circles that are not supported by the

automatic selection. Or points on edges or intersections.

# Reference point

Select an available reference point as measuring reference.

° Point

Select a free point on the model.

#Point on edge

Select an edge and use its center as a measuring reference.

Center (Center of circle)

Select three points to determine a circle and use its center as a reference.
ZIntersection of two edges or edge and plane

Select two edges or one edge and a plane and use their intersection as a measurement reference.

Undo a selection

Remove an erroneously selected reference by clicking the button of the measure function again or by pressing

[Esc].

i Distance/Angle

Measure the distance or the angle between two references based on the type and location of the references.

Combination Measure

Measures distance when the
planes are parallel.

Measures angle when the planes
are not parallel.

Measures distance when they are

“Plane “Plane

g y parallel.
Plane Edge Measures angle when they are not
parallel.
“Plane “Vertex Distance of the vertex
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perpendicular to the plane.

“Plane

= Circle

Distance of the center of the circle
perpendicular to the plane.

+Edge

#Edge

Measures distance when the edges
are parallel.

Measures angle when the edges
are not parallel but on one plane.
No measure when the edges are
not parallel and not on one plane.

/Edge

= Vertex

Distance of the vertex
perpendicular to the edge.

/Edge

@Circle

Distance of the center of the circle
perpendicular to the edge.

= \Vertex

= Vertex

Distance of the vertices

= \Vertex

=Circle

Distance of the vertex to the center
of the circle.

= Circle

@Circle

Distance of one center to the other
center of a circle.

I*I Distance

Measure the distance between two references. Only references that can be used for distance measurement can
be selected.

K1 Distance in X-, I Y- and <$: Z-Direction

Measure the distance between two references along the axes of the coordinate system. Only references that can
be used for distance measurement can be selected.

i Distance/Angel to XY, i XZ- and "i YZ-Plane

Measure the distance or the angle between a reference and one of the standard planes based on the type and
location of the reference.

Combination Measure
Measures distance when they are
Standard parallel.
“Plane
plane Measures angle when they are not
parallel.
Measures distance when they are
Standard ~Edge parallel.
plane 9 Measures angle when they are not
parallel.
Standard oy Distance of the vertex
ertex :
plane perpendicular to the plane.
Standard . Distance of the center of the circle
=Circle .
plane perpendicular to the plane.

1 Edge Length

Measure the length of an edge.

&3 Boundary Box

Measure the extension of the model in the X, Y and Z direction within the coordinate system.

Activate Boundary box of a part to measure the extension of parts in the X, Y and Z direction within the coordinate

system.

The model or part under the cursor will be shown in light blue.

&2 Minimal Box

Measure the length, width, and height of a model despite its position in the coordinate system.

Activate Boundary box of a part to measure the length, width, and height of parts despite their position in the

coordinate system.
The model or part under the cursor will be shown in light blue.
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- Wall Thickness

Measure the wall thickness at any point on the model. The wall thickness is calculated perpendicularly to the
surface at the measuring point and independent of the viewing angle. Measuring points under the cursor will be
shown in light blue.

k1 Clearance

Measure the clearance between any point on the model and the surface that is across from it. The clearance is
calculated perpendicularly to the surface at the measuring point and independent of the viewing angle. Measuring
points under the cursor will be shown in light blue.

Measure Radius And Diameter
Measure radii and diameters.

Click the <” Measure/Markup tool in the Tools group. Click the 4 Radius button to measure radii or click the little
black arrow in the button to select another measure function.

Measure and Markup

X
S

O automatically
() By 3 points

= Decimal 0.XX
edma A v
BlO
u Text size

<< Select Annotation  >>

=

-

A Measure Radius

Measure the radius of a circle.

Move the cursor across the model, and the automatic selection highlights possible circles in light blue.
Click to select a circle.

If the automatic selection does not find the wanted circle, activate the option By 3 points and select three points on
the circle to be measured.

To make the selection easier, the points are displayed.

4 Measure Diameter

Measure the diameter of a circle.

Move the cursor across the model, and the automatic selection highlights possible circles in light blue.
Click to select a circle.

If the automatic selection does not find the wanted circle, activate the option By 3 points and select three points on
the circle to be measured.

To make selection easier the points are displayed.
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Measure Points

Display the coordinates of points, free points on a surface, and centers of circles.

Click the <" Measure/Markup tool in the Tools group. Click the *= Point button to measure edge points or click the
little black arrow in the button to select another measure function.

Measure and Markup

B
a1

-

<|M
1|+)==

\'7— Point
[ Free point

\G) Center of a circle

Dedmal  0.XX

-38.83, -38.83, 25.00

i

| Text size 14

<< Select Annotation  >>

*= Measure Point

Display the X, Y, and Z-coordinate of point.

To make the selection easier, the points are shown. Points under the cursor will be highlighted in light blue.
Click to select a point.

= Measure Free Point On A Plane

Display the X, Y, and Z-coordinate of a free point on a plane (not an vertex).

Measuring points under the cursor will be highlighted in light blue.
Click to select a point.

% Measure Centers Of Circles

Display the X, Y, and Z-coordinate of the center of a circle.

Circles under the cursor will be highlighted in light blue.
Click to select a circle.

3D-Annotations (Notes)

Attach notes, model info notes, part info notes. cross section info note, or surface info notes on the model.

Click the <" Measure/Markup tool in the Tools group. Click the & Create Note button or click the little black arrow
in the button to select another note function.

Measure and Markup IZ‘
o &)=
“w |7 || || =]
Create Not @’ Note
%i Model info note
© Fre= point @ Cross section note
() Paint ‘%" Center of mass note
S I% Surface area note
Sample Fan_3D-2D () Cirde center
\ 410_Housing ®  Contourlength note
New Material: PAG .
Housing Density[g/cm=]: 1.140 & Decmal  0.XX
: X[mm]: 80.008 D TR |l
Y[mm]: 80.008
b __Z[_mrn]__2_5130_0 ______ << Select Annotation >
Weight[g]: 24.725

Volume[mmz]: 21688.6
Surface area[mmz]: 22912.2

% Create Note

Select a reference where the note should be attached
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Free point

Select a free point on a surface as a reference.

Point

Select a vertex or reference point as a reference.
Point on edge

Select a point on an edge as a reference.

Circle center

Select a circle and use its center point as a reference.

Move the cursor to the point on the model where you want to attach the note.
Points under the cursor will be highlighted in light blue.
Click to add the note and enter the text of the note in the Create Note dialog.

¢ Tip
3D notes can be created without the Measure/Markup tool. Right click anywhere on the model and select Quick
note.

%' Create Model Info Note

Select the info units in which the info note is to be created. The info units will be changed and the values will be
converted, if the units differ from the model units (mm or inch) specified in the 3D-Tool Preferences.

Select whether you want to generate an info note for a model or a part.

Move the cursor to the point on the model or part where you want to attach the note.
Models or parts under the cursor will be highlighted in light blue. Click to add the note.

A note for models with the following information will be created:

Name or the model

Dimensions of the model in X, Y, and Z.

Weight of the model: Only if all parts of the model have a material assigned with the s Information tool.
Volume and surface area of the model.

A note for parts with the following information will be created:

Name or the model and name of the part

Dimensions of the partin X, Y, and Z.

Weight of the model: Only if the part has a material assigned with the s* Information tool.
Volume and surface area of the part.

If a model contains parts with open edges the weight, volume, and surface area are marked with the information
that these values might be incorrect. Volume information and therefore weight information is only reliable for
closed parts and models. Open edges and twisted planes will distort the volume calculation and could lead to
incorrect results. This is most likely to happen when importing IGES files.

% Create Cross Section Note

Activate the Cross section tool.
Move the cursor on the section of the part where you want to attach the note.
The section under the cursor will be highlighted in light blue. Click to add the note.

A permanent red section line is created on the part. A note with the following information will be created on the
section line:

Name or the model and name of the part
Number of segments

Length of the section line

Surface area of the sectioned part

2 Create Center of Mass Note

Select whether you want to create a center of mass note for a model or a part.
Move the cursor to the point on the model or part where you want to attach the note.
Models or parts under the cursor will be highlighted in light blue. Click to add the note.

A note is created at the center of mass with the coordinates of the center of mass of the model or part. A center of
mass can only be created for models and parts if a material has been assigned to each associated part.

For more information on assigning materials, see the 3D Mode > 3D Tools > Model-Info > Assign Materials
chapter.
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2. Create Surface Area Note

Move the cursor on the surface where you want to attach the note.

The surface under the cursor will be highlighted in light blue and the surface area will be shown.
If necessary, adjust the size of the surface by changing the Surface tolerance angle.

To add a permanent Surface area note, click on the surface.

The surface gets a red outline and a note with the surface area is created.

% Create Contour Length Note

Automatically

Move the cursor on the surface where you want to attach the note.

The surface under the cursor will be highlighted in light blue and the total length and number of contours belonging
to the surface are shown. The detected contours depend on the position of the mouse pointer on the highlighted
surface.

If necessary, adjust the size of the surface by changing the Surface tolerance angle.

To add a permanent contour length note, click on the area highlighted in light blue.
The contour gets a red outline and a note is created with the contour length and the number of contours.

Manual edges
Move the cursor on the edge for which you want to get the contour length.
Edges under the cursor are highlighted in light blue.
By clicking on the highlighted edge, the edge is added with its length and changes its color to green. Additional
edges can be added for the contour length note by clicking on them.
Complete the manual contour selection by Create Note.
The edges get a red line on it and a note is created with the contour length and the number of contours.

@ Note
Press [Esc] to cancel the selection.

Background Images And Text
Add background pictures in the PNG, JPG and BMP format, and add background texts.

Click the <" Measure/Markup tool in the Tools group.
Then click the % Add Background Images or Text button.

Measure and Markup =S

The Fan C1ENERIEE
Factory e

I Fan Project Revision 2 I

Annotate background

[] Add picture

Az Add text

e u Change text
O

" e

<< Select Annotation  »»
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Adjust And Delete Dimensions/Markups

Change the position, color, and size of dimensions and markups. Delete dimensions and markups that are no longer
required

To adjust dimensions and markups, activate the <~ Measure/Markup tool in the Tools group.

Measure and Markup

X
E!“r@;;l,
~ ===

Measure radius

(-35.75, 35.75, 4.00) O Automatically

O By 3 points
R 2.15
MNew Radius
u Change text
BlO
¥  mm Textsize 14
Edit info text

v Show extended info
Always on top
Delete

Delete all

Move Dimensions/Markups

Movable elements of a dimension/markup will be highlighted in light blue under the cursor. Move the following
elements by dragging them while pressing the left mouse button:

Text box of any dimension/markup
The points of reference of distance dimensions if on an edge or a plane
e The points of reference of notes

Change Of Dimensions/Markups

Select a dimension/markup. To do so, click on the text box or use the << and >> button near Select Annotation.

Change the decimals of dimensions by choosing a value from the drop down list.
Change the text size of dimensions/markups by choosing a value from the drop down list.
Change the text of notes by clicking on the Change text button.

Text color is the color of the text.

Background color is the color of the text box.

Line color is the color of the carrying lines.

Use the & Change dimensions/markup button to change further attributes of a dimension/markup:

Edit info text allows adding additional text to dimensions/markups.

o Stay on top displays a dimension/markup always in front of the model. This prevents the dimension/markup to be
hidden by the model.

o Free move (distance dimensions between planes only)
Allows to move the text box and carrying lines of a distance dimensions to any position in the 3D space, as long
as the measuring references are planes.

o Show extended info (for distance dimensions, radius, and diameter)
Shows additionally the distances along the X, Y, and Z-axis for distance dimensions. Shows additionally the X, Y,
and Z-coordinate of the center of the circle for radii and diameters.

¥ Tlp
Change the attributes of dimensions/markups through the context menu by just right-clicking the text box of a
dimension/markup.

@ Notes

e Color changes will not be visible until the dimension/markup has been deselected.

e The default settings of all new dimensions/markups can be designated through:
Options tab > Preferences group > Preferences > 3D-Annotations.
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Delete Dimensions/Markups

To select a dimension/markup to be deleted, do one of the following:.

e Click on the text box of the wanted Dimension/Markup.
e Use the << and >> buttons near Select Annotation.

To delete the selected dimension/markup, do one of the following:

Press [Del] on the keyboard.
Or click on the & Change dimension/markup button and select Delete.
o Delete all deletes all dimensions/markups and all background pictures and texts.

Adjust And Delete Background Images And Texts

Background pictures and texts can be moved. The text box color and text size of background texts can be changed.

To adjust background images and text, activate the <~ Measure/Markup tool in the Tools group.

Measure and Markup B

The Fan SlA = %
Factory e

I Fan Project Revision 2 I

Annotate background

[] Add picture

Az Add text

% u Chanige text
O

¥ wm Text size 14

Edit text

Edit info text >
Always on top
Text alignment  *

Delete

Delete all

Move Background Images And Texts

Click the % Add background image or text button.
Move background images and texts by dragging them while pressing the left mouse button.
@ Note

The position of background pictures and texts, measured in pixels, is in reference to the upper left corner of the

display. The position of background pictures and text changes with different display resolutions, hence positioning
them on the top left is favorable.

Change Attributes Of Background Texts

Click the % Add background image or text button.
Click a background text to select it and then do one of the following:

Change text, text color and text height by clicking Change text.

Change only the Text height by choosing a value from the drop down list.

Change the color of the text and the text box by clicking on the button for color selection.
Add additional text for background texts by clicking & and selecting Edit info text.

@ Notes

e Color changes will not be visible until the background text has been deselected.
o The default settings of all new dimensions/markups can be designated through:
Options tab > Preferences group > Preferences > 3D-Annotations.
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Delete Background Images And Texts

Click the & Add background image or text button.
Click a background image or text to select it.

To delete the selection, do one of the following:

e Press [Del] on the keyboard.
e Or click on the := Change dimension/markup button and select Delete.
o Delete all deletes all dimensions/markups and all background pictures and texts.

Hide and Show Measures and Markups
Hide and show Measures and Markups individually and copy them to Clipboard.

To show and hide 3D dimensions and markups, click ~ below the Measure and Markup tool <”.

Frozen annotations: 0
* Are hidden in exploded display.

z| B 1]
Status Type Content
I+ on Distance  80.000
[=] on Distance  25.000
l%g- On MNote Mew Housing
Az On Text Fan Project Revision 2
R "
A, on Radius R 2.150
1 on Picture

To hide and show Measures and Markups individually, click the checkbox.

£ Show all annotations
Show all 3D dimensions and markups.

ZHide all annotations
Hide all 3D dimensions and markups.

il Delete marked annotations
Delete selected 3D dimensions and annotations marked in the list

@ Note
To select multiple annotation in the list, click one and then press [Ctrl] while clicking additional parts. To select a
range of parts in the Model Tree, click a part and then press [Shift] while clicking another part. This will select the
clicked annotations and all in between.

Status
The status indicated the state of the annotation in the current display:
On The annotation is shown in the display.
Off The annotation is hidden in the display.
Frozen The dimension is not shown in the exploded view because it is between parts that are exploded in the
current display.
Clipped The annotation is not visible in the display, because it lies in the clipped area.

Type
Specifies the type of the dimension or annotation.

Content
Specifies the value of the dimension or annotation.
¢ Tip
Save the state of the dimensions and markups in the Custom Views.
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=i Model-Info

Use the Model-Info tool to display the volume, surface area, and dimensions of models and parts. Use the material
database to calculate the weight of parts. Copy all information to other applications.

The =t Model-Info tool is located in the Analysis group of the 3D-Mode tab.

Display and Copy Information

Model Info >

<< » << gi >>

Model units are mm

] Info Units: mm-g
Parts: 16

Material:

Mixed material ~

Density: -,——- gfom?

Open edges: 1]

Parts: 16

Model: Sample Fan_3D-2D

Mixed material

Center of mass

(0.099, 0.042, 12.476)

Weight [a]:
Volume [mm=]:
Surface area [mmz]:

Selection

To display information select models, assemblies, or parts from the Model Tree.

Alternatively browse through the Model Tree by clicking:

<< 2 >> Next/previous model
<<=t >> Next/previous element

Info Units

The following info units can be selected to be displayed:

mm - g (Millimeter and Gram)

mm - kg (Millimeter and Kilogram)
cm - g (Centimeter and Gram)

cm - kg (Centimeter and Kilogram)
m - g (Meter and Gram)

m - kg (Meter and Kilogram)

in - g (Inch and Gram)

in - kg (Inch and Kilogram)

in - Ibm (Inch and Pound)

ft - Ibm (Inch and Pound)

The info units will be changed and the values will be converted, if the units differ from the model units (mm or inch)

specified in the 3D-Tool Preferences.

Please note that the values are only reliably if the models loaded, are:

* in a file format that provides information on the units used,

or its info units suit the modell units set in the 3D-Tool Preferences.

More information can be found in section Preferences > Common > Model Units.

Information

The following information is displayed within the tool and the information display.for models and parts:

The number of open edges
The assigned material
The dimensions in X, Y and Z

The weight (requires an assigned material)

The number of parts of models and assemblies

The center of mass (requires an assigned material)
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e The volume
e The surface area
e The number of triangles

If a part contains open edges, the information for this part as well as the assembly, in which the part is located, are
marked with the information that these values might be incorrect. The volume and thus the weight information is
only accurate for closed parts and assemblies. Open edges and flipped surfaces may distort the results of the
analysis. This problem can mainly occur when importing IGES files.

If a model contains parts with open edges the weight, volume, and surface area are marked with the information
that these values might be incorrect. Mass, volume and area information is only reliable for closed parts and
models. Open edges and twisted planes will distort the volume calculation and could lead to incorrect results. This
is most likely to happen when importing IGES files.

O Copy Info
Copy the information of the current selection to the Clipboard. For models and assemblies information on all
contained parts will be copied. This information can be pasted to a spreadsheet or text document.

Assign Materials / Weight Calculation

Assign material
To assign a material, first select a part or assembly in the Model Tree and then choose a material from the drop
down list. For faster selection, you will find the 5 most recently selected list entries at the top of the list. If you
assign a material to an assembly, the material will be assigned to all its parts. The green check mark ¥ indicates
that all parts of an assembly have a material assigned and the weight is calculated and displayed for all such
parts and assemblies.

Remove material assignment
To remove an assigned material, select "---Remove material --" from the drop down list. With "--- No density---"
you set the density of the selected part or assembly to 0.

Create a new material
To create a new material open the material list, scroll down to its end and select ...New material ... In the following
dialog enter the name and the density of the material and click OK. The material will be added to the list and will
be assigned to currently selected parts and assemblies.

Edit the material database
To comfortably edit the material database, use the Material Database Editor. Start the editor by clicking the small
[...] button top of the material list.
[More information]

@ Note
The density values of the database delivered with 3D-Tool have been specified to the best of knowledge.
However, because the values underlie a certain manufacturing variability we will take no responsibility for their
accuracy.

Material Properties of Native Models

If materials are saved for a native model, they will be imported into 3D-Tool and displayed in the Model Info tool.
This requires that the model is imported with the import settings: "High Quality", "Low Quality" or "Custom".
Loading material properties into the viewer does not work with the import settings "CAD - Graphical Data" and
"NoHeal".

@ Note
Material names and densities are supported for native models from CATIA V5/V6, Pro/Engineer, Creo,
Siemens/UG NX, Inventor and SolidWorks.
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s Material Database Editor

Within the Model-Info tool, use the Material Database Editor to edit, delete or create materials that can be assigned to
the parts of a model to calculate its weight.

The Materials Database Editor is part of the Model-Info tool located in the Toolbox group of the 3D-Mode tab. Here
you start the editor by clicking on the small button [...] located above the material selection list.

Material Database Editor x

Add materials from model S = ﬁ
Material Density
o.000 |
ABS 1.060
AlMa3 2.660
Aluminium 2.700
Aluminium AVW-2014 2.790
Aluminium AW-8016 2710
Aluminium AW-6060 2,700
Aluminium AV/-6082 2,700
Aluminium AW-7075 2,810
Aluminiumaosid 3.940
Blei 11.340
Bronze 8,150
Chrom 7.120
Edelstahl 1.4301 7.900
Edelstahl 1.4401 8.000
Eisen 7.870
Glas 2.500
Gold 19,300
Graphit 2,200
Grauguss 7.200
Kupfer 8.930
Ok Cancel
Edit Materials

Edit the material list
e To change an entry, click on the name or density of the material, and enter the new name or density.
e To add a new entry, simply enter its name and density at the end of the list.
e To delete an entry, just delete the name of the material.

Add model materials
If you open a 3D-Tool model (EXE/DDD), the model may contain materials not present in your material database.
To transfer these materials to your database, click on Add model materials.

“ Load materials from file
To load materials from a materials file (*.txt), click & Load. After selecting a material file, you will be asked if you
want to clear all default materials:
Yes: All materials present will be cleared before loading the new materials.
No: The new materials will be added to the current material list.

‘i#i Add default 3D-Tool standard materials
To add the 3D-Tool default materials to the material database, click -#. This may be necessary if the default
materials have been overwritten by loading of model materials.

[ Save materials to file
To save materials to a material file (*.txt), click H Save.

@ Note
The density values of the database delivered with 3D-Tool have been specified to the best of our knowledge.
However, because the values underlie a certain manufacturing variability we will take no responsibility for their
accuracy.

Structure of a Material File (*.txt)

Material files are simple text files that can be easily edited with an editor.
3D-Tool material files are structured as follows:

e The materials are separated by a line break (return).
o A material is specified as material name directly followed by its density in brackets:
Material name(density), for example Alloy(2.70)

= Tooling Analysis
Use the Tooling Analysis to display mold cavities and draft angles, check for undercuts, and calculate the projected
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area of the model.

The &= Tooling Analysis is located in the Analysis group of the 3D-Mode tab.

Mold Cavities
Tooling Analysis i)
Mold Cavities
Mold Cavities Angle
Top Undercuts | Proj area |
Reference plane
Meutral XY-plane | Ty
8 show plane
Bottom
Top side Bottom side

Tolerance 0.2

Surfaces without draft

Red color ~

& Assign

To set the Reference plane, do one of the following:

From the drop down list select one of the standard planes XY, YZ, YZ

o Click the & Pick a reference plane or curve button and move the cursor across the model. Planes, edges and
lines will be shown in light blue. Click to align the reference plane parallel to a plane or perpendicular to an
edge/line.

When the reference plane is selected, the faces of the model are displayed in different colors according to the
mold cavities:
By default: green - top, red - neutral, blue - bottom.

Show plane (Default: Active)
Show the reference plane as a transparent plane in the view.

Tolerance (Default 0.2)
Enter a tolerance angle for surface allocation. The tolerance angle is necessary because triangulated models are
not 100% exact. Increasing the angle can harmonize the results of the analysis if the inaccuracy produces too
many artifacts.

Surfaces without draft (Default: Red color)

Select the display of surfaces without draft from the drop down list:

Red color: Surfaces without draft angle are red.

Prefer top side: Surfaces without draft angle will be assigned to the top/green section.

Prefer none: Surfaces without draft angles are gray.

Prefer bottom side: Surfaces without draft angles will be assigned to the bottom/blue section.

& Assign
Assign the current colors to the model and close the Tooling Analysis.
o All colors of the model will be replaced with the colors of the Tooling Analysis. This cannot be undone and
because the colors are a global property this change will affect all existing Custom Views.
o If the Show plane option is active, the reference plane will be added as ReferencePlane_Tooling to the model tree.
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Angle
Tooling Analysis IZ‘
Draft Angle
g Mold Cavities Angle
o
3.00 Undercuts | Proj area |
1.50° Reference plane
0.00° WY¥-plane e lk
1.50° B show plane
.

0.00%

Direction -1,50%
-3.00°

3.00°
Angle
3.00 1.50°

& Assign

To choose the Reference plane. do one of the following:

e From the drop down list select one of the standard planes XY, YZ, YZ

o Click the & Pick a reference plane or curve button and move the cursor across the model. Planes, edges and
lines will be shown in light blue. Click to align the reference plane parallel to a plane or perpendicular to an
edgelline.

When the reference plane is selected, the draft angles are displayed in different colors.

Show plane (Default: Active)
Show the reference plane as a transparent plane in the view.

Angle (Default: 3.0)
Enter the maximum angle for the display of draft angles.

Direction (Default: Up)
Click the Direction button to designate whether draft angles opened up, down, or in both directions are shown.

& Assign
o All colors of the model will be replaced with the colors of the Tooling Analysis. This cannot be undone and
because the colors are a global property this change will also affect all existing Custom Views.
o |f the Show plane option is active the reference plane will be added as ReferencePlane_Tooling to the model tree.

Undercuts

Tooling Analysis X
Undercuts
Mold Cavities | Angle |
I Top Undercuts Proj area
Undercut Reference plane
Meutral WY-plane v i
Undercut B show plane
i e
Top side Bottom side
Mo draft Undercut
Tolerance 1o °
& Assign

To choose the Reference plane, do one of the following:

From the drop down list, select one of the standard planes XY, XZ, YZ

o Click the & Pick a reference plane or curve button and move the cursor across the model. Planes, edges and
lines will be shown in light blue. Click to align the reference plane parallel to a plane or perpendicular to an
edgelline.

When the reference plane is specified, the model is checked for undercuts. After the required calculations, the
drafts and undercuts will be displayed in different colors.
Default: green - top, blue - bottom, white - no draft, red - undercut.
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Show plane (Default: Active)
Show the reference plane as a transparent plane in the view.

Tolerance (Default: 1.0)
Enter a tolerance angle for surface allocation. The tolerance angle is necessary because triangulated models are
not 100% exact. Increasing the angle can harmonize the results of the analysis if the inaccuracy produces too
many artifacts.

& Assign
o All colors of the model will be replaced with the colors of the Tooling Analysis. This cannot be undone and
because the colors are a global property this change will also affect all existing Custom Views.
o If the Show plane option is active, the reference plane will be added as ReferencePlane_Tooling to the model tree.
The check for undercuts requires extensive calculations and will be always performed for all parts. An estimation

of the time needed to perform the calculation will be displayed after starting the analysis.To cancel a running
calculation, press [Esc], for example to delete not needed parts in the model tree.

Projected Area

Tooling Analysis i)

Mold Cavities | Angle |

Undercuts ,W

Reference plane

XY-plane ~ R

Projected area of parts
3153 mm2

This function calculates the surface area of all models that is projected onto one of the three standard planes.
This, for example, is needed to calculate locking forces when making molds.

To choose the Reference plane, do one of the following:

From the drop down list, select one of the standard planes XY, XZ, YZ

Click the & Pick a reference plane or curve button and move the cursor across the model. Planes, edges and
lines will be shown in light blue. Click to align the reference plane parallel to a plane or perpendicular to an
edge/line.

When the reference plane is selected, the projected area is displayed in square units. For example, if the units of a
model are millimeters in square millimeters.
Use the Placement tool to align the model in the coordinate system.

@ Note
The projected area of a model is calculated by graphical projection which could cause some imprecision.
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2 Wall Thickness Analysis
Use the Wall Thickness Analysis to show the wall thicknesses of a model in different colors.

The *& Wall Thickness Analysis is located in the Analysis group of the 3D-Mode tab.

Wall Thickness Analysis i)

Sample Fan_3D-2D

Select model: << ==
Calculation Method
Ooneray  ()Fitted ball

Re-mesh iterations 5 B

Edge length 2.50

Display
(2) 3 colors 1© spectrum

Min 0.00 Max 5.00
& [ Atpoint
Assign 4 Caleulate

Run a calculation

Calculating the wall thickness requires extensive calculations. An estimation of the time needed to perform the
calculation will be displayed after starting the analysis. To cancel a running calculation, press [Esc], for example to
adjust the calculation settings for a shorter calculation time.

Select model
The Wall Thickness Analysis can only display and analyze one model at a time. If there are multiple models, click
<< or >> until the wanted model is displayed.

k: At point
See the wall thickness at certain points on the model. This function is available without calculating the wall

thicknesses.
Click k At point and move the cursor across the model. The wall thickness at the position of the cursor will be

displayed.

% Calculate
Click Calculation to start a calculation based on the center of the generated triangles.

@ Notes

e Open edges and flipped surfaces may distort the results of the analysis.

o The wall thickness analysis is calculated for all shells/parts individually. If this is not desired, the shells/parts can
be combined using the Combine parts [More information] function.

Customize the Calculation

Choosing the Calculation method (Default: Ray)
For graphical display, the 3D models are divided into a mesh of many triangles during import.

One ray

The one ray calculation method places a perpendicular ray through the center of the triangles in the mesh to
determine the wall thickness of the model. This method is useful for identifying thin areas in models. The single
ray method is faster than the fitted ball method.

Fitted ball

The fitted ball method calculates the wall thickness using multiple rays placed in a spherical shape from the center
of the triangles. This method is useful for identifying thick areas in models, but is slower than the ray method.

To get a preferably good result, the triangles that make up the model will be subdivided into smaller ones. The
values in the Calculation section define the strength of subdivision.

o A finer subdivision will increase the quality but also the calculation time.
o A coarser subdivision will decrease calculation time but also the quality.

Remesh iterations (Default: 5)
Enter how many times the creation of the mesh will be repeated. A larger value will enhance the result but
increase the time needed for the calculation. If "0" is entered, the edges of triangles will not be broken down
further.

Edge length (Default: 2.5 mm / 0.098 inch)
Enter the maximum edge length a triangle may have until it is broken down into smaller triangles. A smaller value
will enhance the result but increase the time needed for the calculation.
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Customize the Color Display

Adjusting the color display does not require a new calculation. So you try different settings after a calculation is
done.

3 Colors
Choose the 3 colors option to display different wall thicknesses in the three colors blue, green, and red. In green

areas the wall thickness lies within the specified Min and Max values, in blue areas below the Min value, and in
red areas above the Max value.

Spectrum
Choose the Spectrum option to display the different wall thicknesses as a color spectrum between the specified

Min and Max values.

Min. / Max.
Enter the minimum and maximum wall thickness for the color display.

& Assign
Assign the current colors to the model and close the Tooling Analysis. By this all colors of the model will be

replaced with the colors of the Tooling Analysis. This cannot be undone and because the colors are a global
property this change will also affect all existing Custom Views.

7: Model Compare (not available with the Free Viewer and in EXE files)
Use the Model Compare tool to graphically highlight the differences between two models.

The %% Model Compare tool is located in the Analysis group of the 3D Mode tab.

Load and Select Models

Load two or more models that you want to compare. If the file names are identical, the models are renamed
automatically.

After the import, the models are listed in the model tree and overlap in the display.

Now activate the 5 Model compare tool.

Select the two model you want to compare from the two drop down list, located at the top of the tool. If only two
models are loaded, they are selected automatically.

@ Note
The 3D-Tool Model Compare is a graphical/visual comparison by dyeing the models in different colors and then

laying one model on top of the other. Differences located inside the models can only by using cross section or by
hiding parts.

5 Compare Models in Solid Mode

Model Compare >
" 1 Model_1 i
2 Model_2 v

Solid

“» »
() Overlay
(_) Reversed overlay
(C) Removed volume
© Added volume
[ Transparency
‘\—'/

Wire frame

a9 a9 1

In this mode the models to be compared are put on top of each other in solid render mode.

Consecutively use multiple or all of the following options to find all differences. Especially useful is switching
between Overlay and Reversed overlay as well as between Removed material and Added material.

Overlay
Display the two models in different colors and superimpose model 1 over model 2. The two models differ in all

places where you can see the color of model 2.

Reversed overlay
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Display the two models in different color and superimpose model 2 over model 1. The two models differ in all
places where you can see the color of model 1.

Removed material
Highlight material that does NOT exist in model 2.

Added Material
Highlight material that does ONLY exist in model 2.

Transparency
Display the top model color transparent so differences inside of parts can be seen more easily.

¢ Tip:
Activate the 7 Cross Section tool and move the section through the models to find the difference inside of models
and parts. The section plane is always filled with the color of the cut material and letting you see differences by

the inconsistency of the section plane color.

Wire Frame

Model Compare )
. Model_1 e
@ Model_2 -

Solid
e

Overlay
Reversed overlay
Removed volume
Added volume

Transparency

Wire frame
Angle [}

“3 Compare model 1 with model 2 as wire frame
Display model 1 solid and superimpose model 2 as wire frame over model 1. The two models differ in all places

where you can only see the wires of model 2 or only the solid faces of model 1.

% Reverse compare - Compare model 2 with model 1 as wire frame
Display model 2 solid and superimpose model 1 as wire frame over model 2. The two models differ in all places

where you can only see the wires of model 1 or only the solid faces of model 2.

5 Compare both models as wire frame
Display both models as wire frame and superimpose model 2 over model 1. The two models differ in all places
where you can see wires in the color of model 1.

Wire frame angle

Change the resolution of the wire frame. Move the slider left to lower the wire frame angle and to get a denser
wire frame. Move the slider right to increase the wire frame angle and to get a lighter wire frame.

@ Note
The wire frame is based on the edges of the triangles that make up the model in the viewer. If you open models

using different import settings (Chord height, Angle tolerance) the models may show deviations that do not exist.
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3D - Tools

This section informs you about using the 3D-Tools.

= Explode

Use the Explode tool to manually or automatically create an exploded view of your models.

The & Explode tool is located in the Tools group of the 3D-Mode tab.

‘n Manual Explode

Assembly Explode i)

B
@ 0 ﬁ

Moving direction

@x @y 8:

0.00 0.00 0.00
X L z

Move

Select a part by clicking on the model. Move the cursor onto a part of the model in the display and move the part
while pressing the left mouse button. In this mode only single parts can be moved.

Pick models, assemblies, and parts in the Model Tree. All parts selected in the Model Tree will be displayed in red.
Move the cursor onto one of the selected parts of the model in the display and move the parts while pressing the
left mouse button.

% Move parts

Move the selection by dragging it while pressing the left mouse button. For an easier positioning, deselect one or
two of the axes x, y, z under Move direction or enter values in the x, y, and z fields, and then click the Move
button.

& Rotate parts

Rotate the selection by dragging it while pressing the left mouse button. Choose the axis of rotation in Rotation
axis.

e Axis: Rotation around one of the center axes (ax, ay, az) of the selection.

e Screen: Rotation around one of the screen axes (sX, sy, sz). These axes depend on the viewing angle. The sz-
axis points to the viewer, the sx-axis points right, and the sy-axis points up.

The angle of rotation is displayed in the Angle field. For an exact rotation, enter a value and click the Rotate
button.

&% Copy position from another part
Copy the movement and rotation of a part to other parts. Click the part on the model whose movement and
rotation is to be copied (target). The part will appear in green. Then click on all parts that you want to move and
rotate according to the target. To select a new target, click the Pick target button.

&) Reset position
Click an exploded part on the model, and it will be returned to its original position. Click the Reset all button to
return all parts to their original positions.
) Undo
Undo the last action.
Double-click on parts of the model in the display to return them to their original position.
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& Automatic Explode
Assembly Explode i)
-t
©h@ 3%

ﬁ Auto explode all
Explode assembly
»
=% x|[v]lz
[CJindude subassemblies
Move/Reset selection
2[4 | Y[+ |2 )|+

% To center ﬁ To arigin

& Auto explode all
Explode all parts of the models automatically.
If there are parts that are already exploded, these parts will be reset and newly exploded. Automatic explosions
can be adjusted further manually.

Assembly only
Explode only the parts of the assembly currently selected in the model tree. Sub-assemblies within this assembly
will be exploded as a whole and not split up. To simultaneously explode the parts in X, Y, and Z direction, click
the B Auto explode this assembly level button. To explode only in X, Y, or Z direction, click the accordingly
labeled buttons.

Include sub-assemblies
Explode the parts of the assembly currently selected in the model tree and all parts of its sub-assemblies. To
simultaneously explode the parts in X, Y, and Z direction, click the B Auto explode this assembly level button. To
explode only in X, Y, or Z direction, click the accordingly labeled buttons.

X, +X, =Y, +Y, -Z, +Z
Move the parts selected in the model tree in the selected direction out of their superior assembly. If parts of
multiple assemblies are selected, all selected parts will be moved jointly outside the superior assembly.

& To center
Reset the parts selected in the model tree to their common explosion center. For example: You exploded the
parts of an assembly and then moved the exploded assembly out of the model. Now, if you select this assembly
in the model tree and then click & To center the parts of the assembly will be reassembled on the spot.

& To origin
Reset the parts selected in the model tree to their origin, which means their original position in the model.

¥) Undo
Undo the last action.

Measure and Markup in Exploded View

Use the < Measure/Markup tool to add 3D dimensions and markups in the exploded view of your models.

To do so, click the <” Measure/Markup tool and then either activate % Show Exploded in the Dislay group or load
a Custom View that contains exploded data.

You can measure on single parts or between non-exploded parts. Move the cursor across the model and possible
references will be shown in light blue.

To attach a note, move the cursor across the model. Possible references will be shown in light blue.

@ Note
Activating the <” Measure/Markup tool sets the model back into the assembled state first.
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Save Exploded View as Custom View

Save the exploded views of the model as Custom Views. This way you can restore them as needed and use them
in Animations and in the Print and Create Picture settings. You can save Custom Views while working with the
Explode tool. Also, there is a corresponding prompt when you exit the tool.

@ Note
If a view contains explosion data, you can switch between exploded and assembled view through the % Show
exploded button in the Display group. The explosion data of a view are retained until a new Custom View is
selected.

2 Painter
Use the Painter tool to change the color of models, parts, surfaces, curves and PMI.

The  Painter tool is located in the Tools group of the 3D-Mode tab.

Pairiter B
Auto color
Models
Parts Surfaces
© One model () All models
Manual color
o W[

Direct paint

(& ) alloa=

Marguee select

iy Color selected g

Automatic Color

Models
Automatically assign different colors to all models.

Parts
Automatically assign different colors to all parts. Select the One model option to color the parts of a specific
model. Select the All models option to color the parts of all models.

Surfaces
Automatically assign different colors to all faces. Select the One model option to color the faces of a specific
model. Select the All models option to color the faces of all models.

Manual Color

Color
To set the paint color:
o Click the Current paint color button and pick a color from the color palette.
e Orclick & Pick a color from model and then click on a color on the model.

Single object select
The following selection modes are available:

& Change color of surfaces, curves, reference points, or PMI.
£, Change color of a single triangle

I Change color of a plane surface

& Change color of connected triangles

E Change color of connected triangles in the same color.

Move the mouse pointer over the model. Details to the selection mode details of the model will be highlighted in
bright blue according to the selection mode. Click to change the color of the highlighted elements.

Marquee select
The following marquee selection modes are available:
i Marquee select curves.
Marquee select triangles.
Marquee select reference points.
=i Marquee select PMI.
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Click into the display, hold the mouse button and drag the selection rectangle over the wanted elements. All
elements that are completely within the selection rectangle will be selected and highlighted in bright blue. To

color click < Reset selection.

@ Note
The marquee selection modes will not only select the visible elements but also all hidden elements behind them.

22 Placement (not available with the Free Viewer and in EXE files)
Use the Placement tool to place and align your models.

The &% Placement tool is located in Tools group of the 3D-Mode tab.

5* Place Active Model

Placement )

Sample Fan_30-2D

Selectmodel:  [3 << »»

£ g
C

Place active model

- X Auto reference

To X Auto reference

0 same B Al axis

() Opposite x@y@z
i @G> P

Select model
Only the active, red colored model will be positioned.
To select a model, do one of the following:
e Click << or >> until the wanted model is selected.
e Click [+, and click a model in the display.

From
Use the From drop down list to choose the start reference to be used with the active model.
¢ Auto reference: Move the cursor across the active model, and possible references are highlighted in blue. Click
to select a reference. You can choose from points, centers of circles, planes, edges and lines.
¢ Model center: Use the center of the active model as start reference.
¢ Model min: Use the minimal X,Y,Z - coordinate of the active model as start reference.
¢ Model max: Use the maximal X,Y,Z - coordinate of the active model as start reference.

To
Use the To drop down list to choose the target reference for the active model.

¢ Auto reference: Move the cursor across the models, and possible references are highlighted in blue. Click to
select a reference. You can choose from points, centers of circles, and planes.
Model center: Use the center of a model as target reference.
Model min: Use the minimal X,Y,Z - coordinate of a model as target reference.
Model max: Use the maximal X,Y,Z - coordinate of a model as target reference.
XY-plane: Use the XY-plane of the coordinate system as target reference.
XZ-plane: Use the XZ-plane of the coordinate system as target reference.
YZ-plane: Use the YZ-plane of the coordinate system as target reference.
X-axis: Use the X-axis of the coordinate system as target references.
Y-axis: Use the Y-axis of the coordinate system as target references.
Z-axis: Use the Z-axis of the coordinate system as target references.
Origin: Use the origin (0,0,0) of the coordinate system will be set as target reference.

When From and To are defined, you may align and/or translate the active model.

Align
Click on Align to position the active model. The Align button is only activated if the alignment is possible with the
target references that are selected. Use the options Same and Opposite to set whether the alignment of the
references will be in the same or the opposite direction. Axes, edges, and lines will be aligned perpendicular to a
plane by default. The Parallel option activates parallel alignment.
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Move
Click on Move to reposition the active model. The move button is only activated if the move is possible with the
target references that are selected. Use the All Axis, x, y, z option to determine which coordinates of the active
model are affected.

Transform
To freely place the model, click ‘in Show Drag'n Trans Tool. Within the Drag'n Trans tool click > Move or G
Rotate to move or rotate the active model simply by dragging it while pressing the left mouse button.
Further information can be found in the chapter 3D-Mode > 3D-Tools > Drag'n Trans.

To use exact values when repositioning or rotating the active model, use ¥* Move or G Rotate. To Scale or Mirror
the model, use *» Scale or 4 Mirror.
Further information can be found in the chapter 3D-Mode > 3D-Tools > Move, Rotate, Scale, Mirror.

@ Note
To Auto reference and pick centers of circles, it can be necessary to zoom close onto the wanted arc.

¢ Tip
First align models, and then move them.

<7 Auto Arrange Models

Placement B

Sample Fan_30-2D

Select model: [} << >

£ =
5

Auto arrange models

Arrange in line

X ¥ Z

Arrange in square

Xy XZ YZ

Arrange in line
Click X, Y, or Z to arrange all models in a row along the corresponding axis.

Arrange in square
Click XY, XZ, or YZ arrange all models according to the corresponding plane. The goal is to arrange the models
in the smallest square possible; however this depends on the number of models, as well as their size and form.
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H Animation (not available with the Free Viewer and in EXE files)

Use the Animation tool to create an animation of your Custom Views.

The H Animation tool is located in the Presentation group of the 3D-Mode tab.

¥ Animation X

O M B i

All views v Animation Assembly Animation ~
Standard - Keyframel
Cross Section 2.00s Keyframel
Motor View 2.00s Keyframe2
Keyframel

Keyframe2 2.00s Keyframe2
Keyframe3 2.00s Keyframe3
Keyframe4 2.00s Keyframe3
Keyframe5 2.00s Keyframe4
Keyframe6 2.00s Keyframe4
Keyframe?7

Keyframes 2.00s Keyframe5
Keyframe9 2.00s Keyframe5
Keyframe10 2.00s Keyframe6
Keyframe11 2.00s Keyframe6

=

L

»

Export AVI
640x480

Close

Total time: 32.00 sec

i=l| Export AVI

Basic Approach

An animation consists of multiple Custom Views that are used as key frames.

To do so, take the following steps:

Activate the E Animation tool.
Create a '@ New Animation.

@ Example 1

Generate different Custom Views of the model.

Add Custom Views as key frames to the animation.
Put the key frames in the wanted order and adjust their time of transition.

Key frame 1 shows the front of the model.
Key frame 2 shows the left side of the model.
When the animation is run, the model will turn from the front to the left.

@ Example 2

Key frame 1 shows a regular view of the model.
Key frame 2 shows an exploded view of the model.
When the animation is run, parts of the model will move from their original position to their positions after the

model has been exploded.

Create Animation

Animation

Choose an animation from the drop down list. If no animations were created, the list is empty.

New animation
Create a new animation.
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2 Copy selected animation to new animation
Copy the current animation and create a new animation.

Rename animation
Change the name of the current animation.

il Delete animation
Delete the current animation.

Animation key frames
The lists of the key frames in the current animation and their transition times in seconds.
The list will be empty when a new animation has been created.

To change the transition time of a key frame, double-click the transition time and enter the new time.

Custom Views
List of the available Custom Views.

Use the Filter if there are orthogonal and perspective Custom Views. The transition between the two cannot be
animated and, thus, would be discontinues. So combining the two modes of display is useless. Choose a display
mode from the drop down list.

Preview thumbnail
The thumbnail on the upper left side is a preview of currently selected Custom View or key frame. This makes it
easier to select key frames or Custom Views.

+ Add selected Custom View to key frames

Add the views selected in the list of Custom Views as key frames to the animation. New key frames will be added
to the end of the animation.

= Remove selected key frame
Remove the selected key frame from the animation.

Move selected key frame up
Move the selected key frame up by one position on the list.

Move selected key frame down
Move the selected key frame down by one position on the list.

Change transition times
Change the transition time of a key frame by double-clicking the time and entering a new time (in seconds).

F Start preview
Show a preview of the current animation in the preview thumbnail. To abort the preview, press Esc.

Play Animation

Click OK to exit the Animation tool. Now the animation can be played using the & Play Animation button in the
Presentation group.

Animations will also appear at the end of the Custom Views list and can be started from there.

Export AVI

An animation can be exported as AVI video.
To do so, take the following steps:

Click the Resolution button until the wanted resolution is displayed..

Click on El Export AVI.

Select where you want to save the video, and enter the name of the video.

Select the Compressor (video codec) to be used. Depending on the compressor, it may be possible to make
further adjustments through the Key Frame and Data Rate option and through the Configure button.

e Click OK to start generating the video.

Depending on the compressor, the length of the animation, the resolution, and the capacity of the computer this
process may take some time.

@ Note

A resolution lower than 800x600 pixels will not show fine lines, small details, and smaller text of, for example,
annotations and dimensions.

Videocodecs
The AVI format is a container for various video codecs. All AVI files will have a *avi ending no matter what
compressor was used. The codec has to be available so the video can be played.

The following codecs have been tried; however, this is not an exhaustive list and only a short overview.
¢ Full frames (uncompressed)
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(Limited Suitability) Offers the best quality without lost data but creates a large file. It can be useful, if the video will
be edited with a video editing software or further converted. Caution: Only files of up to 2 GB are supported.
e Cinepak by Radius
(Suitable) Delivers good results and small files. The display is sharp and the color gradients will be displayed
accurately.
¢ Intel Indeo R3.2
(Not Suitable) Creates small files but an unfocused display with jagged color gradients.
¢ Microsoft Video 1
(Limited Suitability) Very sharp display but poor color gradients and relatively large files.
¢ Microsoft Video 9
(Suitable) Small files and decent quality; however, color gradients may be inaccurate.
e DivX
(Very Suitable) The display is focused and color gradients are smooth. Even with high resolutions, small files are
created. But, depending on the DivX version, there may be problems when exporting videos with high resolution.
o MPEG-4
(Very Suitable) The display is focused and the transitions are smooth. Even with high resolutions, small files are
created. Best results.

¥ Custom View Editor (not available with the Free Viewer and in EXE files)
Use the Custom View Editor to change the order and names of Custom Views.

The & Custom View Editor is located in ~~ More in the Tools group of the 3D-Mode tab.

¥ Custom View Editor

Filter: All views | B

Standard
Cross Section
Motor View
Keyframe 1
Keyframe2
Keyframe3 3D - Orthogonal view
Keyframe4
Keyframes
Keyframed
Keyframe7
Keyframed Assembly Animation
Keyframe3
Keyframe 10
Keyframe 11
Main View
Detail C

View is used in animation:

Ok Cancel

Filter
From the drop down list, choose the type of Custom Views to be displayed in the list of Custom Views:
o All views
e 3D views
e Orthogonal views
e Perspective views
e 2D views
e Views used in certain animations

List of Custom Views
Click a Custom view in the list to select it. The thumbnail, on the upper right side, shows a preview of the selected
Custom View.

View is used in animation
If the selected Custom View is used in an animation, the name of the animation will be shown here. Deletion of
the view will also delete the animation. Changing the names and order of Custom Views has no effect on
animations.

Rename Custom View
Enter a new name (op to 50 characters) for the selected Custom View.

i Delete Custom View
Delete the selected Custom View. If the Custom View is included in an animation, a warning will appear. Deleting
the Custom View will also delete the animation.
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Move selected Custom View up
Move the selected Custom View up by one spot on the list.

Move selected Custom View down
Move the selected Custom View down by one spot on the list.

OK
Apply all changes and exit the Editor.

Cancel
Discard all changes and exit the Editor.

% Property Editor (not available with the Free Viewer and in EXE files)

Use the Property Editor to change the name, color, and transparency of parts. Save your changes for models with the
same parts.

The & Property Editoris located in -~ More in the Tools group of the 3D-Mode tab.

Property Editor x

7 Copy Name =15

Original name New name Color  Transp.

CEmEEREEr I
410_Housing
£ 611_Motor_ASM
611_Pwh
1 611_Core_ASM
611_Stator
611_Winding:1
611_Winding:2
611_Winding:3
611_Winding:4
611_Spacer
611_Bearing:1
611_Bearing:2
31 812_Blade_ASM
812_Mag
812_Adhasive
812 Rotor
Blank fields will not be changed, the current names will be kept.

0

50

S|

50

0

S|

50

=
-

S|

50

S|

50

OCmMEOOOOOCOOOOE EE)
0

0

Apply changes Close

Edit Properties

The property table

The property table has 4 columns:

e Original name
The original names of assemblies and parts. Click an element to select it.

e New name
Enter a new name for the selected element.

e Color
Click the square to change the color of the selected element. Assemblies and multicolored parts (multicolored
square) will be completely dyed in the new color.

e Transp.
Click on the little blue square to turn '& / & the transparency of the selected element. This function is only
available with parts.

= Copy original name to new name
Copy the name of the selected element to the New name column.

Apply changes
Click on Apply changes to apply the changes you have made.

Close
Leave the Property Editor.

@ Notes
e Changes will not be applied until you click Apply changes.
¢ Elements without new names keep their original names.

Save And Load Properties

Save your changes for new versions of the model or models with the same part names. That way, you can load
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the changes to reapply them.

(= save
Save the property table to a property file (*.pf).
“ Load
Load a property file (*.pf). Choose the properties (New name, Color, Transparency) to be transferred. Every
element of the table whose original name matches a name in the property file will receive the properties stored in
the file. You can continue to work on the table. Click on Apply changes to apply the changes you have made.

@ Notes
¢ If the property file contains more than one entry of the same original name, all elements with this name will be

assigned the properties of the first entry, and all other entries will be ignored.
e For assemblies only the names will be transferred. However, all properties will be transferred for the parts of an
assembly.
Characteristics of the property file (for experienced users)
The property file is a TAB separated text file that can be opened and edited with a text editor. Each entry starts
with the original name of the element of which the properties are to be changed. The original name is followed,
separated by a Tab, by the new name, color, transparency in the following syntax:

OriginalName $N:NewName $C:$Color $T:- or +
e Color stands for hexadecimal BGR color information in the form BBGGRR with a maximum of 6 characters.

e $T: Minus - means transparency off, Plus + means transparency on.
@ Examples

611_Stator $N:Stator $C:$0000FF $T:+
Changes the name of the element 6171_Stator to Stator, colors the element red and shows it transparent.

Properties that are not to be changed can be omitted:
611_Stator $C:30099FF
Changes only the color for element 611_Stator.

2 Repair (not available with the Free Viewer and in EXE files)
Use the Repair tool to delete faces, fix inverted faces and open edges, create triangles, and move edge points.

The & Repair toolis located in -~ More in the Tools group of the 3D-Mode tab.

Basics

Select model
The Repair tool can only display and repair one model at a time. If there are multiple models, click << or >> until

the wanted model is displayed.

Display
The Repair tool will show open edges in yellow and backs of triangles in red. This makes it easier to locate

irregularities.

¢ Tip
In the Display group activate the shade mode £/ Shaded with Triangles. This makes the selection easier.

Delete

To delete faces, curves, or PMI click the Delete tab.

Repair IZ‘
Sample Fan_3D-2D

Select model: << 3>

Delete Mormals

MNew | Move pt | Auto |

Single object select

IERRNEIEIE

Margquee select

iy Delete selected Lo/

Single object select
The following selection modes are available:
&' Select surfaces, curves, reference points, and PMI
4, Select a single triangle
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[ Select a plane surface
& Select connected triangles
E Select connected triangles in the same color

Move the cursor over the model. Details of the model will be highlighted in bright blue according to the selection
mode. Click to select the highlighted elements. Selected elements will be highlighted in green color.

Marquee select
The following marquee selection modes are available:

i Marquee select curves

Marquee select triangles
Marquee select reference points
=i Marquee select PMI

Click into the display, hold the mouse button and drag the selection rectangle over the desired elements. All
elements that are within the selection rectangle completely will be selected and highlighted in green color.

on % Reset selection.

@ Note
The marquee selection modes will select the visible elements and all elements behind them.

Normals

To invert surfaces click the Normals tab.

Repair i)
Sample Fan_3D-2D

Select model: << =»

Delete Mormals

New | Movept| Auto |

Single object select

ERNEIGEIE

Marquee select

W Invert selected b 4

Single object select
The following selection modes are available:
9 Select a surface
2, Select a single triangle
I Select a plane surface
£ Select connected triangles
E Select connected triangles in the same color

Move the cursor over the model. Details of the model will be highlighted in bright blue according to the selection
mode. Click to select the highlighted elements. Selected elements will be highlighted in green color.

Marquee select
The following marquee selection modes are available:

Click into the display, hold the mouse button and drag the selection rectangle over the desired elements. All
elements that are within the selection rectangle completely will be selected and highlighted in green color.

To delete selected elements click ¥ Invert selection. To remove the selection without inverting the elements click
on X Reset selection.

@ Note
The marquee selection modes will select the visible elements and all elements behind them.
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New (create new triangles)

Repair IZ‘
Sample Fan_3D-2D
Select model: << 3>
Delete | Mormals |

MNew Mave pt Auto

Choose 3 vertices to create a
new triangle.

Deselect

Pick point: 1

Click the New tab to create new triangles.

Create a new triangle by picking three edge points. To make the selection easier, the edge points of the triangles

are displayed.

Click three edges points to select them.
Click the Deselect button to reset an erroneous selection.

When the three points are selected, the new triangle will be created. Its orientation is calculated based on the

adjacent triangles.

Move pt (Move points)

Repair X
Sample Fan_3D-2D

Select model: << 3>

Delete | Mormals |

MNew Move pt Auto

Connect near edges

Tolerance 0.05

Connect edges

Auto orientation

Click the Move pt tab to move edge points.

Move two edge points on top of each other, e.g. to close open edges. To make the selection easier, the edge

points of the triangles are displayed.

Click the edge point to be moved. Then click the edge point in target position.
Click the Deselect button to reset a false selection.

Click the Confirm button to move the point.

@ Note

Moving points will delete triangles if two point of a triangle are on top of each other or all points are on one line.
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Auto (automatic repair)

Repair IZ‘
Sample Fan_3D-2D
Select model: << 3>
Delete | Mormals |

Mew Mave pt Auto

Connect near edges

Tolerance 0.05

Connect edges

Auto orientation

Click the Auto tab to automatically repair inverted faces and open edges.

The automatic repair tries to close open edges and turn inverted triangles.

Tolerance (Default 0.05mm / 0.002 inch)
Enter the distance value to be used for the automatic connection of open edges in the Tolerance field. The
automatic repair tries to close all open edges based on the tolerance distance. Increasing the tolerance may close
more open edges.
Connect edges
Click Connect edges to automatically close open edges.
Decide if you want to keep the part relations for the current model.
e Yes: The repair will keep the current part assignments and names.
e No: Based on newly connected edges, the repair may put the parts into a new arrangement. This may be useful if
the parts consist of multiple shells, but the names of the parts may be lost.

Auto orientation
Click Auto orientation to automatically turn inverted triangles. The automatic orientation tries to assign the same
orientation to all connected triangles.
@ Note

The automatic repair will not always completely close models with open edges or flipped surfaces. To get a

"watertight" model more or less extensive manual repairs are needed

Execute Auto orientation and Connect edges multiple times in rotation to correctly orient as many faces as

possible.

= RP-Layout (not available with the Free Viewer and in EXE files)
Use the RP-Layout tool to place models on a platform for Rapid Prototyping Systems.

The ¥ RP-Layout toolis located in - More in the Tools group of the 3D-Mode tab.

RP Layout Iz‘

Sample Fan_3D-20
Selectmodel: [z << »»

RP System

Default ~

350.000 350.000 350.000

AR AN RN YRR 3

Auto position
Align plane
To: -2 ~ I3 Plane
Snap z min to
Model | All 10,50

Select model
Except for Auto-Position always the active, red colored model will be positioned.
To select a model, do one of the following:
e Click << or >> until the wanted model is selected.
e Click &, and click a model in the display.
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RP-System
Select the RP-system from the drop down list. Only the Standard system is available first, but you can create a

new systems by using the Setup button.
Setup
Create a new RP-system by specifying its size and important parameters such as the distance between the

models.
[Detailed description]

m Drag'n Trans
Move and rotate the model with the mouse.
[Detailed description]

% Move
Move the model by entering x,y, and z-values.
To move a copy of the model, activate the Create copy option.
[Detailed description]

& Rotate
Rotate the model or a copy of it by choosing a rotation axis and entering an angle.
To rotate a copy of the model, activate the Create copy option.
[Detailed description]

*b Scale
Scale the model.
[Detailed description]

4» Mirror
Mirror the model or a copy by choosing a mirror plane.
To mirror a copy of the model, activate the Create copy option.
[Detailed dexription]

Auto position
Position the models according to the specifications of the RP-system automatically.

Align plane
From the drop down list To: choose the direction of the alignment.
Then click & Plane, and click a plane on the model.
Snap Z-min to
To move models to the minimal Z-position as specified in the according input field, do one of the following:
e To move the active (red) model, click the Model button.
o Click the All button to move all models to Z-min.

¥) Undo
Undo the last action.

Setu P RP-System (not available with the Free Viewer and in EXE files)
Use this assistant in the RP-Layout tool to create new RP-systems.

In the ¥ RP-Layout tool, click the Setup button to start Setup RP-System.

Setup RP System

RP System Mew RP System
Default - Mame  RP_system
X ¥ Zz
Delete Mew
350 350 350
X ¥ Fd
Model Z min 10.5
350,000 350,000 350.000
Space betw. models 5
Model Z min 10.5000
Space to border 5
Space betw. models  2.0000
Fields in platform
Space to border 5.0000
X 10 ¥ 10
Fields in platform — E—
X0 Y10 Create RP System Cancel
oK Cancel
Select RP-System

Select a RP-system from the dropdown list. The properties of the selected RP-system will be displayed. If there
are no customized systems, the list will only contain the Default system.
Click OK to apply the selected system.
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Delete
Delete the currently selected RP-System. The last remaining system cannot be deleted.

New
Opens the New RP-system input mask to specify the properties of the new RP-system.

New RP-System

Name

Enter a name for the new RP-System
X, Y,2

Enter the values for the dimensions of the new RP-System. Values between 1 and 1000 are accepted .
Model Z min

To auto-position models, enter the minimum distance of the models above the RP-platform. Values between
0.001 and 100 are accepted.

Space betw. models
To auto-position models, enter the distance between models. Values between 0.001 and 100 are accepted.

Space to border

To auto-position models, enter the distance of the models to the borders of the RP-system. Values are accepted
between 0.001 and 100.

Fields displayed in platform

For the guide grid of the RP-platform enter the number of fields in X and Y direction. Values between 1 and 100
are accepted .

Click the Create RP System button to create the new RP-System.

-+ Create Reference Point
Use the Create Reference Point to to create a point in the coordinate system, e.g. as reference for dimensions.

The == Create Reference Point tool is located in —~ More in the Tools group of the 3D-Mode tab.

Create Reference Point X

Reference selection

B v | @
Free Edge Point Center

AlE|| X s &

Create point in model:

Color

. |

Create Reference Point

Click the = Create Reference Point tool in More tools in the Toolbox group of the 3D-Mode tab.

Select a reference to get X, Y, and Z coordinates of model or enter the coordinates for the reference point directly
in the X, Y and Z field.

* Free point on surface
# Point on edge
# Vertex
= Center (Center of circles)
# Edge center
@ Center (Center of circle)
Select three points to determine a circle and use its center as a reference.
ZIntersection of two edges or edge and plane
Select two edges or one edge and a plane and use their intersection as a reference.
% Center of mass
Use the center of mass of a model as a reference.
“Load
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To load coordinates of one or more reference points from a file (*.txt or *.xyz) click & Load.

Move the cursor across the model and possible reference points will be shown in light blue.
Click to select a point.
The applicable coordinates of the point are applied to accordant input field.

Color
To select a color for the reference point, click the Point color button and pick a color from the color palette.

Create
Create the reference point.

) Undo
Undo the last action.

Structure of a Point file (*.txt or *.xyz)

Point files are simple text files that can be easily edited with an editor.
3D-Tool point files are structured as follows:

Individual points are separated by a line break.
A point is specified with 3 values for the coordinates, each separated by spaces.
e # signals a comment line

Example:

# Example for a point
1.02.03.0

< Move
Use the Move tool to move models, assemblies, and parts.

The € Move tool is located in ~~ More in the Tools group of the 3D-Mode tab.

Move Iz‘
X ¥ Fa

[u] [u] [u]

[ create copy

Move

Model Tree Selection
Select a model, an assembly, or a part in the Model Tree.

x! y! z
Enter the value of the movement in the x, y, and z input field.

Create copy
Create a copy of the selection, and move it.

Move
Execute the movement.

¥) Undo
Undo the last movement.

@ Note
The transformation of parts (move, rotate, scale, mirror) can lead to major changes in Custom Views that have
already been created.

@ Rotate
Use the Rotate tool to rotate models, assemblies, and parts.

The G Rotate tool is located in ~~ More in the Tools group of the 3D-Mode tab.

Rotate X
Rotation axis  Rotation center
X-axis ~  Center ~
Angle S0
[ Create copy
) Rotate
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Model Tree Selection
Select a model, an assembly, or a part in the Model Tree.

Rotation axis
From the drop down list, choose the rotation axis.
o X-Axis
e Y-Axis
o Z-Axis

After the Rotation axis is selected, it will be shown in the display.

Center
From the drop down list, choose the position of the rotation axis.
e Center: The common center of the selected elements.
e Origin: The origin (0,0,0) of the coordinate system.
¢ Minimum: The common minimum (MinX,MinY,MinZ) of the selected elements.
¢ Maximum: The common maximum (MaxX,MaxY, MaxZ) of the selected elements.

Angle
Enter the number of degrees by which you want to rotate the element.

Create copy
Create a copy of the selection, and rotate it.

Rotate
Execute the rotation.

) Undo
Undo the last rotation.

@ Note
The transformation of parts (move, rotate, scale, mirror) can lead to major changes in Custom Views that have
already been created.

» Scale
Use the Scale tool to change the size of models, assemblies, and parts.

The ' Scale tool is located in - More in the Tools group of the 3D-Mode tab.

Scale ]
Scale Scale center
inch =>mm ~ Center ~

Uniform in all directions
25.40

Scale

Model Tree Selection
Select a model, an assembly, or a part in the Model Tree.

Scale
From the drop down, list choose the scale:
e mm => inch: Millimeter to Inch.
¢ inch => mm: Inch to Millimeter.
e Custom: Enter a custom scale factor.

Scale center
From the drop down list, choose the center of the scale:
e Center: The common center of the selected elements.
e Origin: The origin (0,0,0) of the coordinate system.
¢ Minimum: The common minimum (MinX,MinY,MinZ) of the selected elements.
e Maximum: The common maximum (MaxX,MaxY, MaxZ) of the selected elements.

Uniform in all directions
Scale uniform in x, y and z. Deactivate this option during the Custom scale to enter different values for x, y, and z

Scale
Execute the scaling.

) Undo
Undo the last scaling.

@ Note
The transformation of parts (move, rotate, scale, mirror) can lead to major changes in Custom Views that have
already been created.
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< Mirror
Use the Mirror tool to mirror models, assemblies, and parts.

The 4 Mirror tool is located in - More in the Tools group of the 3D-Mode tab.
Mirror X

Mirror plane Mirror center

¥ -plane ~  Center ~

[T Create copy

Mirror

Model Tree Selection
Select a model, an assembly, or a part in the Model Tree.

Mirror plane
From the drop down list choose the plane of reflection.
e XY-plane
e XZ-plane
e YZ-plane

After the mirror plane is selected, it will be shown in the display.

Mirror center

From the drop down list, choose the position of the mirror plane.

Center: The common center of the selected elements.

Origin: The origin (0,0,0) of the coordinate system.

Minimum: The common minimum (MinX,MinY,MinZ) of the selected elements.
Maximum: The common maximum (MaxX,MaxY, MaxZ) of the selected elements.

Create copy
Create a copy of the selection, and reflect it.

Mirror
Execute the reflection.

) Undo
Undo the last reflection.

@ Note
The transformation of parts (move, rotate, scale, mirror) can lead to major changes in Custom Views that have
already been created..

&= Create Copy

Use the Create Copy tool to copy models, assemblies, and parts.

The &2 Create Copy is located in - More in the Tools group of the 3D-Mode tab.

Model Tree Selection
Select a model, an assembly, or a part in the Model Tree.

Create copy
Select & Create Copy to copy the models, assemblies, or parts currently selected in the Model Tree:
o Models: Selected models will be copied, and the copy will be added to the end of the Model Tree.
o Assemblies: Selected assemblies will be copied, and the copy will be added at the end of the model.
o Parts: Selected parts will be copied, and the copy will be added at the end of the model or the assembly

Tn Drag'n Trans (not available with the Free Viewer and in EXE files)
Use this tool within the RP Layout and the Placement tool to easily move and rotate models with the mouse.

Draghn Trans X

(¢] ¢/

Moving direction

[ ] By a:

%[ 000 |¥[ o000 |Z[ 000 |

4 Move parts
Left-click on the selected model and hold down the mouse button to move the model.
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The x, y, and z-values of the translation and the position of the model center are shown while the model is moved.

To make moving the model easier, deselect one or two directions for the moving (x, y, z) under Move direction.

& Rotate part
Choose the x, y, z, or the virtual axis of the screen as rotation axis.
Left-click on the model and hold down the mouse button to rotate the model.

The angle of rotation is displayed while the model is rotated.

D Don't move/rotate parts
Prevent the parts from being accidentally moved or rotated if you move or rotate the model in the view.

¥ Undo
Undo the last movement/rotation.

@ Note
The transformation of parts (move, rotate, scale, mirror) can lead to major changes in Custom Views that have

already been created.

@ Report (not available with the Free Viewer and in EXE files)

Use Report to generate details reports with details such as model information, Bill of Materials, and an overview of
Custom Views as PDF, RTF, HTML and JPG/BMP.

The @ Report is located in the Report group of the 3D-Mode tab.

Create Report
MNew report ™ H 1}
File format  Choose in Preview ~

Title Summary Report

Language English B Section files
ﬂ Section overview

Lo ™ -9 > @ section model information

Paper size I:I Section Model Tree
02r4 18 section part table
() Letter [ section part list

o [ section BOM table
Fzs=i OF'E.nmmn 18 section BOM list
9 Portrait [ section Custom Views
(_) Landscape

[ show options dialog [CINew page for each section

Create Report Cancel

L A

+ Load, Save and Delete Customized Report

File format

From the drop down list, select the file format in which the Report will be output:
e Choose in Previews: save as PDF, RTF, HTML, JPG/BMP
o PDF
¢ RTF
[ ]
Title

Specify a name for the Report.

Language
Select a language for the Report.

Paper size
Choose between DIN A4 and US Letter as paper size.

Paper orientation
Select the paper orientation (portrait or landscape) in which the report should be created.

Select sections included in the report
Check the topic sections to be included in the report for the loaded models:
Section files: Shows the file path along with the file name.
o Section overview: Displays the main view and the default views of the model.
o Section model information: Provides a summary of the main properties of the model, including dimensions,
volume, surface, together with an image of the model.
o Section Model Tree: Displays the model tree with the parts and assemblies structure.
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e Section part table: Displays all parts in a tabular overview.
Section part list: Displays the part information along with images.

o Section BOM table: Displays the Bill of Materials in a tabular overview with information on quantity, dimensions,
volume, and surface area.

o Section BOM list: Displays the Bill of Material along with images.
¢ Section Custom Views: Displays all Custom Views along with a preview image.

Show options dialog
The options dialog is displayed before creating the report for PDF, RTF and HTML file format. [More Information]

New page for each section
Inserts a page break after each topic section.

Load, Save and Delete Customized Report

All settings can be saved as a customized report to be able to create further reports with these settings.

Load

Select the customized report from the dropdown list to access its settings. To create a report using the settings
you last selected, choose Last created report.
Click ~ below the @ Report tool to create a report directly without displaying the Create Report dialog window.

(= save
Save the settings as a customized report.

il Delete
Delete the selected customized report.

Copy Infomation to the Clipboard

Model information, annotations, and BOM can be copied to the clipboard.

The functions for copying & Model Info, the = BOM and the & Annotation list to the clipboard are located in the
Report group of the 3D-Mode tab.

& Copy Model Info
Copies the model tree with details such as dimensions, volume, and surface area to the clipboard.

Copy BOM

Copies the Bill of Materials (BOM) with details such as number of parts, dimensions, volume and surface area to
the clipboard.

¥ Copy Annotation List
Copy the annotation list with details such as type, value, and info text to the clipboard.

@ Note

The units used when copying the model info and the BOM to the clipboard correspond to the info units defined in
Options > Preferences > Common.

Options Dlalog Report (not available with the Free Viewer and in EXE files)
The reports can be customized for the output formats via the options.

The options dialog is displayed before creating report for PDF, RTF, HTML and JPG/BMP file formats.

Export Options for PDF-Report

PDF is a platform-independent format for electronic documents.
When exporting to PDF, a window appears for setting the file to be exported.

Compressed

Compress the output file to reduce file size but increase export time.

Embedded fonts

All fonts used in the report are included in the PDF output file, allowing accurate display on computers that do not
have the fonts, but increasing the size of the output file.

Background

The graphic associated with the page background is exported to a PDF file.

Print optimized

Output graphics at high resolution. This option is only needed if the document contains graphics and will be
printed.

Transparency

JPG quality
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Specifies the compression rate for JPEG.
Interactive Form

If you want to password-protect the PDF file, you can assign a password and set permissions on the Security tab.
Other document information and viewer settings can be set on the Information and Viewer tabs.

Export Options for RTF-Report

RTF was developed as a standard for exchanging text documents and is supported by many modern text editors
and operating systems.

When exporting to RTF, a window is displayed for setting up the file to be exported.

Pictures
Enable the display of images for the RTF report.
WYSIWYG
The exact representation of the report displayed in the preview. If unchecked, an optimization is performed to
reduce the number of columns and rows in the resulting file.
Page breaks
Enables page breaks in the RTF document.
Continuous
The document is exported as a continuous document with no page breaks and no headers or footers. This option
is useful for large documents that are intended for further processing.
Page Header/Footer
o Text: Headers/footers are treated like normal text.
e Header/Footer: Creates headers and footers in the RTF document.
e None: No headers or footers are created in the report.
Open after export
After exporting, open the file using the default RTF viewer associated with your computer.

Export Options for HTML-Report

When exporting HTML, a window appears for setting the file to be exported.

Styles

Use design styles for exported text objects. Disabling them will speed up the export process, but the appearance
will be worse.

All in one folder

All additional files will be saved in the same folder as the main file, not in a separate subfolder.
Page navigator

A special page navigator is created for faster navigation through the pages.

Fixed width

Maintain a fixed table width when resizing the window..

Multipage

Maintain a fixed table width when resizing the window.

Background

Export graphic attributes present on the page.

Pictures

Select the format for the displayed images.

Open after export

After exporting, open the file using the default program.

Export options for JPG und BMP

When saving as JPG or BMP via selection in Preview, a window for setting the file to be exported is displayed.

Separate files

Each page is exported as a separate file with the page number appended to the file name.
Monochrome

The report is saved in black and white.

Crop pages

The blank areas of the pages are cropped.

JPG quality

Specifies the compression rate for JPEG.

Resolution (dpi)

Sets the graphic resolution of the image at which it will be saved.
Open after export

After exporting, open the file using the default program.
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11. 2D Mode

This section informs you about the 2D mode of 3D-Tool. The 2D mode features dimensions, markups, and tools to edit
the elements of a drawing

To view 2D drawings, click the 2D-Mode tab or 2D Mode in the Mode group.

Zoom and Fit Drawings

Besides the scroll wheel or the middle mouse button, you can use the following functions to zoom in on and out of, and
fit 2D-drawings.

The functions to zoom and fit the drawings are located in the Zoom group of the 2D-Mode tab.

]

o4 Zoom In g
Zoom All ﬁ) Zoom Out L.;.I:mmw-w
Zoom ::: periar 3
® < = g
o
— - -
#. Zoom All
Fit all visible drawings to the display.
This function is also assigned to the function key [F4].
# Previous View
Undo the last zoom, move, or rotation of the view.
This function is also assigned to the function key [F5].
2 Zoom In
Zoom into an area. Click into the display, hold down the mouse button, and move the marquee across the area to
be zoomed.

This function is also assigned to the function key [F2].

# Zoom Out
Zoom out of the view. Zoom in and out using the scroll wheel.

This function is also assigned to the function key [F3].
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Change the Background Color (2D)

Use a black, white, or colored background for your drawings.

In 2D Mode change the color of the background in the right info panel.
| = as:¢a2m2, o x|

“ A0-Mode 0-Mode Optiore. -~ o
o ';)‘ A Peeviows Wiew [ Black/White Lieers , @ 3 Full Screen

= © * B Zomin " Thin Lines g% Contom View Show

A2 Zeem AN g poom oun ik Drwies | [l Py Andmation =

M Foom Dhiplay Took Prisistation

R

% -50.900 LRt Reschation: 12 Selected: 0 F»

Black
Select the Black option to use a black background.

White
Select the White option to use a white background.

Custom color
Select the Custom color option to choose any color for the background.
To choose a color, click the square button behind the option.

Change the Display of Lines (2D)

Display all lines of the drawing in black/white or as thin lines.

In 2D Mode, change the display of the lines in the Display group
~| % as:ze¢men8 0 x|

n WM | WMok Optis ~ 0
o ';)‘ 4 Pervows Wiew | I Black/Whie Lises , 3] 3 Full Seroen

=~ 4 B Zemin < Thin Lines Memure Gy Cintemn View Show

CA3) ZoomAl s poom cun Mukp  Domving | Pl

Mode Zoom Droiplay Took P

Black/White Lines = 8D*Tool
B = Li

# Thin Lines = Camerions

Displa b -DLoEFMAT_L

e :
) ik e
Wit ok
Ooastomcoir [
: L]
-390 Yo-lRH2 Resohgtion: 1 Sebected 0 "Y_ s
I Black/White Lines
Display all lines of the drawing in black or white, depending on the background color.
“ Thin Lines
Display all lines of the drawing with a width of 1pt. This may make it easier to see details in drawings with thick
lines.
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== View: The Layer List (2D)

Use the View mode to view only a 2D drawing and to show/hide the layers of the drawing.

Click [ View in the right info panel to display the layer list.

4
4 —
@ w3 Dimerwsions
® [ Ructine meriusp
=
% E E oo
= DL-DEFALT |
] FALLT_3
C LEVE
=2 | = ! Dimensions o
2] 5:3 Redline markup
Cushinm Visws.
F < = g
Background
Back color
Wh cokor
© Cotorn cokr

¥: 52900 PN Reschation: 12 Sebectedt 0

! Dimensions
This layer contains the dimensions added with 3D-Tool. To hide the layer, click ® . To show the layer, click * .

£3 Redlining
This layer contains the redline markups, annotations, and pictures added with 3D-Tool. To hide the layer, click the

= jcon. To show the layer, click % .

Layers of the drawing
Depending on the loaded drawing, the layer list contains one or multiple layers.
To hide a layer, click 2 . To show a layer, click & .

% Show/Hide
Show/Hide the layer currently selected in the layer list.

£ Show all layers
Show all layers of the drawing. This will not show the layers Dimensions and Redlining if they are hidden.

Z Hide all layers
Hide all layers of the drawing. This will not hide the layers Dimensions and Redlining.
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< Measure and Markups (2D)

Use the Annotate mode to add dimensions, redline-markups, annotations, and pictures.

The < Measure/Markup tool is located in the Tools group of the 2D-Mode tab

Add Dimensions (2D)

Measure distances, angle, radii and the length of lines.

To add dimensions, click the <~ Measure/Markup tool in the Tools group.
I+

In the <* Measure and Markup tool, click =: Distance/Angle to measure distances and angles, or click the little
black arrow in the button to select another measure function.

Measure and Markup X
Delete Delete all
|
s [
hd -

1 Distance/Angle

I+ Distance only

191 Distance in x-direction

ﬁ Distance in y-direction

Line length

Radius

Diameter

Radius by 3 points

£0 Angle between 2 lines
Angle by 3 points

‘i:l Angle by 4 points

“ Distance / Angle

Automatically measure the distance or the angle between two references.

Move the cursor over the drawing. Elements of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any arbitrary points.

Select two references by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

The type and position of the references determines whether the angle or position is measured.

Between two non-parallel lines the angle is measured.
Between two parallel lines the distance is measured.
Between two points the distance is measured.
Between a point and a line the distance is measured.

@ Note
Press [Esc] to cancel the operation.

I+l Distance

Measure the distance between two references.

Move the cursor over the drawing. Elements of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any arbitrary points.

Select two references by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

The distance can be measured:

o Between two points.
o Between a point and a line.
o Between two parallel lines.

@ Note
Press [Esc] to cancel the operation.
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1 Distance In X- And © Y-Direction

Measure the distances between two references in the direction of x or y.

Move the cursor over the drawing. Elements of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any arbitrary points.

Select two references by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

The distance can be measured:

Between two points.
Between a point and a line.
Between two parallel lines.

& Note

Press [Esc] to cancel the operation.

#1 Line Length

Measure the length of a line.

Move the cursor over the drawing. Lines that can be used as references for measuring will be highlighted in blue.
Select a line by clicking on it.

Move the new dimension into the wanted position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

& Note

Press [Esc] to cancel the operation.

4 Radius

Measure the radius of a circle.

Move the cursor over the drawing. Circles that can be used as references for measuring will be highlighted in blue.
Select a circle by clicking on it.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

@ Notes

Press [Esc] to cancel the operation.

e If a circle cannot be selected, use & Radius by 3 points.

4 Diameter

Measure the diameter of a circles.

Move the cursor over the drawing. Circles that can be used as references for measuring will be highlighted in blue.
Select a circle by clicking on it.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

@ Notes

Press [Esc] to cancel the operation.

o If a circle cannot be selected, use < Radius by 3 points.

4 Radius by 3 Points

Measure the radius of a circle defined by three points.

Move the cursor over the drawing. Points of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any points.

Select three points by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension and click OK.

& Note

Press [Esc] to cancel the operation.
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£ Angle Between Two Lines

Measure the angle between two lines.

Move the cursor over the drawing. Lines that can be used as references for measuring will be highlighted in blue.
Select two lines by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

@ Notes

Press [Esc] to cancel the operation.

21 Angle By 3 Points

Measure an angle defined by three points.

Move the cursor over the drawing. Points of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any arbitrary points.

Select three points, of which the second point defines the angular point, by clicking on them.

Move the new dimension into the desired position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

@ Note

Press [Esc] to cancel the operation.

<3 Angle By 4 Points

Measure an angle defined by four points.

Move the cursor over the drawing. Points of the drawing that can be used as references for measuring will be
highlighted in blue, but you can also choose any arbitrary points.

Select four points, of which point 1 and 2 define the first arm and point 3 and 4 the second arm of the angle, by
mouse click.

Move the new dimension into the wanted position, and click to fix it.

In the following dialog, adjust the properties of the dimension, and click OK.

@ Note

Press [Esc] to cancel the operation.

Adjust And Delete Dimensions

Move dimensions

Click the text of a dimension, hold down the mouse button, and move the dimension into the wanted position.
Angle dimensions can be placed in any quadrant of the angle.

Change the properties of dimensions

Double-click the text of a dimension.

Scale: Choose the scale of the drawing to adjust the measured value.

Text field: Shows the text/value of the dimension. You can enter a custom text, but this will prevent the value from
being scaled.

Text: Change the text height and color.

Line: Change the thickness and color of the lines.

Arrow: Select an arrow head and change its length.

Tolerance: Enter tolerance values for the dimension.

@ Note

If common text heights appear extremely small or large, the units of the drawing do not correspond to the 3D-Tool

default units.
Options tab > Preferences group > Preferences > Common.

Delete dimensions

To delete a dimension, do one of the following:

Right-click the text of a dimension, and select Delete.

Click the Delete button in the right info panel, and then click the text of a dimension.

Move the cursor onto the text of a dimension, and press [Del] on the keyboard.

To delete all 2D dimensions and/or all 2D markups (redline markups, texts, pictures), click the Delete all button in
the right info panel.
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Add Markups, Text and Pictures (2D)

Activate Annotate to create 2D markups. Use the second button to create various redline markups and insert pictures
and texts.

To add markups, text, and pictures, click the <” Measure/Markup tool in the Tools group.
In the <* Measure and Markup tool, click ¥ Arrow to add an arrow markup, or click the little black arrow in the
button to select another function.

Measure and Markup X

Delete Delete all

w w
Arr o Arrow
Sketch
Circle

Rectangle

Oval

000«

Cloud

S

iz Add Text

0

Add picture

v Arrow

Add an arrow. Click to select the starting point, hold down the mouse button, and move the arrow to the end point.

% Sketch

Add a sketch. Click on the drawing, hold down the mouse button, and draw with the cursor.

O Circle

Add a circle. Click into the drawing, hold down the mouse button, and drag the circle to the wanted size.

@ Note
Actually, an ellipse is created and the circle only constitutes the ideal case of uniformly dragging the ellipse in the
x- and y-direction.

O Rectangle

Add a rectangle. Click into the drawing, hold down the mouse button, and drag the rectangle to the wanted size.

O Oval

Add an oval. Click into the drawing, hold down the mouse button, and drag the oval to the wanted size.

@ Cloud

Add a cloud. Click into the drawing, hold down the mouse button, and drag the cloud to the wanted size.

42 Add Text

Add a text. Click into the drawing. Choose the text height and color, enter the text, and click OK.

= Add Picture

Add a PNG, JPG or BMP picture. Click into the drawing, hold down the mouse button, and drag the rectangle to
the wanted size. Release the mouse button, and load an image.

Adjust and Delete Markups, Text and Pictures

Move markups, text and pictures.
Click a markup, text, or edge of a picture, hold down the mouse button, and move the object into the wanted
position. For arrow markups, you can also move the starting and end point.

Scale markups and pictures
Move the cursor onto the line of a markup or the edge of a picture. Press and hold [Ctrl]] and the left mouse
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button. Move the mouse to scale the object.

Change the lines of markups
Double-click a markup. Change the thickness and color of the line. For arrow markups, you can also change the
length of the arrow head.

Change text
Double-click a text. Change text height and color or enter new text.

Replace pictures
Double-click the edge of a picture, and select a new picture to be loaded.

Delete markups, text and pictures
¢ Right click a markup, a text or the edge of a picture. Select Delete.
o Move the cursor on a markup, text or edge of a picture. Press [Del] on the keyboard.
¢ Click the Delete button in the right info panel, and then click a markup, text or the edge of a picture.
e To delete all 2D dimensions and/or all 2D markups (redline markups, texts, pictures), click the Delete All button in
the right info panel.

@ Note
If common text heights appear extremely small or large, the units of the drawing do not correspond to the 3D-Tool
default units.
Options tab > Preferences group > Preferences > Common.

Edit Drawing
Use the 2D-Tools mode to edit the elements of the drawing and the markups, texts and pictures added with 3D-Tool.

The B Edit drawing tool is located in the Tools group of the 2D-Mode.

Edit Drawing X
i Select Deselect
ii|| & & 4
u Select

Click "= Select or press and hold the [Shift] key on your keyboard. The cursor changes to a cross hair. Now you
can select any element in the display. This can be elements of the drawing as well as 3D-Tool dimensions and
markups.

Click on an element and the element will be highlighted and added to the selection.

o Click on the drawing, hold down the mouse button, and move the marquee select across the wanted elements.
Release the mouse button. All elements that are totally or partially covered by the marquee rectangle are
highlighted and added to the selection.

To remove a selection, click Deselect.

ii Delete Selection

Delete the selected elements.

2 Change Color Of Selection

Choose a new color for the selected elements.

If nothing is selected, but there is a layer of the drawing selected in the layer list, you will be asked if you want to
change the color of the complete layer.

< Move Selection

Move the selected elements.
Click on the drawing, hold down the mouse button, and move the selection to the wanted position.

If nothing is selected, you will be asked if you want to move the origin of the drawing to the coordinates (0,0).

r» Scale Selection

Scale the selected elements.
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Select the scale to be used:

e inch =>mm.
mm => inch.
e Custom: Enter a scale.

If nothing is selected, you will be asked whether or not you want to scale the whole drawing.

4= Change Text Element

Edit a text element of the drawing.

If there is no text element selected yet (see above = Select) click on a text element of the drawing.

If a text element is selected a small input box will be displayed in the right info panel to edit the text.

e Click ¥ OK to apply your changes.
e Click X Cancel to leave the text as it is.
@ Notes

e Text markups/annotations added using 3D-Tool cannot be edited with this function.
e Text made up of curves or text imported as curves cannot be edited.
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12. Options

This section informs you about the 3D-Tool settings that let you adjust 3D-Tool to your personal needs.

The Options Tab

Use the Options tab to adjust 3D-Tool to your needs, activate 3D-Tool licenses, and get information on the program
version and available updates.

Options
£ Data Privacy [ Background About 3D-Tool Help
O - o
£ License Terms @V Change Wire Frame Angle - o Tip ofthe Day e Manual
ardware
Li Prefe
&3 Licensimg .c.? Adjust Smoothing ang:.lage references Agceleration & Check for Updates 9 Quick Reference Card
Licensing 3D-Display Options Preferences Info Help

Licensing

‘4 Data Privacy
Show the 3D-Tool data privacy statement.

/4 License Terms
Show the 3D-Tool End User License Agreement..

# Licensing (not available in the Free Viewer)
Show the licensing dialog to request and enter 3D-Tool License and Demo Keys.
[Detailed description].

3D-Display Options

& Change Background
Change the color and the gradient of the 3D-background.
e Gradient background
Display the background in a gradient that begins with the selected base color.
e Top color intensity
The slider adjusts the color intensity of the top color. Move it up for a brighter and down for a darker color.
e Set as default
Designate the current background as default.
e Change color
Set a base color for the background.
o Update screen
Apply all changes to the background. This way you can preview your settings without exiting the background
dialog.
& Change Wire Frame Angle (Default: 20)
Change the wire frame angle used for the display modes: Shaded/Edges, Wire Frame and Hidden Line. A line will
be displayed at the edge between two triangles if their angle is greater than the wire frame angle. A small angle

will create more lines than a large angle. The Set as default button designates the current wire frame angle as
default.

=} Adjust Smoothing
Recalculate the smoothing for all models. To do so, enter an angle larger than "0". In shaded display, the edges
of the visualization mesh are smoothed if the angle between the facts is smaller than the smooth angel. The

larger an angle, the more the models will be smoothed. To prevent the models from being smoothed, reduce the
angle to 0°.

@ Note:
The recalculation of the smooth vector overwrites the current smooth vectors and cannot be undone.

Preferences

The functions to change the language, to activate hardware acceleration, and to change the 3D-Tool preferences
are located in the Preferences group of the Options tab.

£ Change Language

Change the language of 3D-Tool. Choose one of the available languages from the drop down list. The language
will change immediately.

£ Preferences
Change the 3D-Tool preferences to your needs. A detailed description on all preferences can be found in the
Preferences section of this manual.
[Detailed description]

E? Hardware Acceleration
Activate hardware acceleration for the current session. This will speed up the display.
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All changes in 3D-Tool and other open programs should be saved before activating the hardware acceleration for
the first time.

If there are strange effects after activating the hardware acceleration, it cannot be used.
Parts of the user interface are not shown or not shown correctly.

The model is not or is only partly shown.

The program crashes.

The program cannot be started.

In this case switch off the hardware acceleration or restart 3D-Tool. This is not a software bug but the result of an
incompatible implementation of the OpenGL interface in the driver of the graphics card.

If there are no problems, the hardware acceleration can be set permanently through:
Options tab > Preferences group > Preferences button > Hardware.

If there are unexpected problems after this permanent activation and if you cannot switch off the acceleration, e.g.
because 3D-Tool refuses to start then turn off the Hardware acceleration through:
Windows Start > Programs > 3D-Tool V 16 > Tools > OpenGl-Accelaration_Off.

@ Note
With 3D-Tool EXE-files, the hardware acceleration can be activated in the starting dialog of the EXE file or after

start-up in the Options tab by clicking & Hardware acceleration.

¢ Tip
Updating the driver of the graphics card will often eliminate problems during the hardware acceleration.

Info

S About 3D-Tool
See information about 3D-Tool, such as the program version, the serial number, and license type.

« Tip of the Day
Show the Tip of the Day.

@ Check for Updates
Check online for a newer program version. This requires an internet connection.
Help

© Help ( F1)
Open the 3D-Tool Help. The Help can always be opened by pressing the F1 Key.

¢ Manual
Open the 3D-Tool manual. The manual contains the complete 3D-Tool Help. To view the manual, the Adobe

Reader is required.

© Quick Reference
Open the 3D-Tool Quick Reference Card. The Quick Reference gives a brief overview of the 3D-Tool user

interface. To view the Quick Reference, the Adobe Reader is required.
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Preferences
This section informs you about the default settings of the 3D-Tool tools and functions.

The €= Preferences are located in the Preferences group of the Options tab.

% Common
Common default settings such as the program language and the default units.

Options tab > Preferences group > & Preferences > % Common.

¥, Preferences

g Common Common =Y
&
: 30 - Display Program language Deutsch w
[ 3D - Model Tree
5] 3D - Color Program style Windows ~
. 3D - Cross Section
g 30 - Annotations B8 save window size at end of program
=3 - Import Basic [ Allow start on each monitor
2 3D - Import Adv,Prem Units
H 30 - Publish/Expart Model units Info units
ﬁ mm ~ mm-g
IE 20 - Display

& 2D - Annotations
El Print/Picture /Capture
E# Hardware [ Custom Views: show undefined parts

8% File Associations

Program animation time (sac) 100

B cCheck automatically for updates

Reset hidden dialogs

oK Cancel

Program language (Default: System language)
Select one of the available languages for program start-up. Choosing System language will start 3D-Tool in the
system language of Windows, if available, otherwise in English.

Program style (Default: Windows 10)

Specifies the color style of the 3D-Tool program interface.
Windows

3D-Tool Dark

3D-Tool Slate

3D-Tool Gray

3D-Tool Light

@ Note
For the Free Viewer and 3D-Tool EXE files only the Windows10 Style is available.

Save window size at end of program (Default: Active)
When closing 3D-Tool, save the window size and position for the next program start-up.

Allow start on each monitor (Default: Inactive)
By default a 3D-Tool window will start up on the primary display of the computer. Set this option if you want 3D-
Tool to start up on the display on which the last 3D-Tool window had been closed.

Units
Model units (Default depends on Windows settings at time of installation: mm for metric, inch for US system
units)
Set the modell units of measurement (mm or inch).

Models of the following files will be scaled to the 3D-Tool default units during import:

STEP, IGES, VDA, SAT, JT and PARASOLID.

Native files from CATIA, Pro/Engineer, Creo, Inventor, SolidWorks, SolidEdge and UG.

Triangulated 3D models (STL, SLP, VRML, etc.), 3D-Tool models (DDD, EXE) and 2D drawings, do not contain
information on the units used and will be imported without scaling.

If the units of the model or the drawing deviate from the standard 3D-Tool units, this may lead to unexpected result
for the following functions:

Incorrect assignment and conversion of the units in the Model-Info tool.

Inappropriate specification of the Edge length for the Wall Thickness Analysis.

Too small or large Text height of 2D dimensions and 2D texts.

In this case, change the 3D-Tool modell units to the units of the file.

Info units
Are the defined units for reports, notes, copy to clipboard and for the Model Info tool.

© 3D-Tool GmbH & Co. KG, 2023



3D-Tool V16 Manual Page 106

Programm animation time (Default: 1.00)
Set the time in seconds for:

e The animation of the 3D-view, e.g. when Custom Views or standard views are selected.
If a 0 is entered, there will be no animation.

e The transition time of new key frames in the Animation tool.
Custom Views: Show undefined parts (Default: Inactive)
Instead of hiding them, show newly loaded parts in existing Custom Views.
Automatically check for updates (Default: Active)

During the program start-up, check if there is a new program version. You will receive an according message.
Download and install new versions from www.3D-Tool.com.

Reset hidden dialogs
Reset all dialogs that are hidden, by selecting Don't show this message again.

3D - Display

Default settings of the 3D Display such as the display of back faces and open edges.

Options tab > Preferences group > & Preferences > 3D - Display.

¥ Preferences

S Common 3D - Display
»
i~[]! 3D - Display Display O shaded () Shaded with edges

- Model Tree
- Color Fast move Con (Doff
- Cross Section S
- Annotations 0 tuto FPS threshold: 1 =
- Import Basic
- Import Adv /Prem Back faces () Same (_JRed O None

- Publish/Export

[ 5how open edges

- Display )

- Annotations |_|Show coordinate system
L Print/Picture/Capture @ show 3D compass
E& Hardware

n Rotate around screen center
= iati — . X
“ii File Assodations [_] Perspective view

B Global shade mode resets local part settings

OK Cancel

Shade mode (Default: Shaded)

Select the shade mode of the models at program start-up
e Shaded

Display the models shaded.
o Shaded with edges
Display the models shaded with black edges
Fast move (Default: Auto)

Select the display of parts being moved with the mouse.
e On

Display parts being moved as wire frame to speed up the display.
o Off

Display parts being moved in the current render mode during movement. When slow computers are used, large
and complex models may not move smoothly.
e Auto

Display parts being moved automatically as wire frame if the number of frames displayed per second drops below
the FPS threshold.

Back faces (Default: None)

Select the display of back faces at program start-up
e Same

Display shaded faces with same colored back faces.
e Red

Display shaded faces with red back faces.
e None

Display shaded faces without back faces. This speeds up the display.
Display open edges (Default: Inactive)

Display open edges at program start-up.
Display coordinate system (Default: Inactive)
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Display the coordinate system at program start-up.

Display 3D-compass (Default: Active)
Display the 3D-compass at program start-up

Rotate around screen center (Default: Active)
Use the center of the screen as the center of rotation when models are rotated with the mouse. Otherwise, the
center of all models will be used.

Perspective view (Default: Inactive)
Display the models in perspective view at program start-up.

@ Note
Rotate around screen center does not work with the perspective view.

Global shade mode resets local part settings (Default: Active)
Reset all parts to the render mode of the display when it is changed.
If this option is not active, only the display mode of such parts that do not have an individual render mode
assigned is changed.

3D - Model Tree
Default settings of the Model Tree.

Options tab > Preferences group > & Preferences > E 3D - Model Tree.

¥ Preferences

Hg Common 3D - Model Tree
ab

30 - Display Size

["E| 3D - Model Tree () small

- Color O Regular

- Cross Section

- Annotations B Highlight while moving mouse over parts
- Import Basic

- Import Adv/Prem
- Publish/Export

- Display

: - Annotations
El Print/Picture/Capture
E# Hardware

1 File Assodiations

Ok Cancel

Size (Default: Double size)
Select the size of the Model Tree at program start-up
e Small
Display the Model Tree in half size.
e Regular
Display the Model Tree in regular size.

Highlight while moving mouse over parts (Default: Active)
Highlight parts and assemblies when moving the mouse over their names in Model Tree.
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= 3D - Color

Default settings of transparency, brightness, and light position.

Options tab > Preferences group > & Preferences > = 3D - Color.

¥, Preferences

Eb’_ Common 3D - Color (5|
an

3D - Display Transparency / Brightness
[ 3D - Model Tree
-[#¥] 3D - Color

ﬁ 3D - Cross Section
& 3D - Annotations
E 3D - Import Basic
B 3D - Import Adv,/Prem Lightat 44

i 20 - Display g’ﬁi‘\“l}‘;
& 2D - Annotations \\‘Eﬁ;
r_@___] Print,Picture /Capture
E@ Hardware
8% File Associations

Transparent ] Solid

Dull ] Shirry

oK Cancel

Transparency/Brightness
Set the values of transparency and brightness at the program start-up.
o Transparent ... Solid (Default: 70%)
Opacity of parts that are displayed transparent.
e Dull ... Shiny (Default: 50%)
Brightness of parts that are displayed shaded.

Light (Default: Light at 4/4)
Drag the yellow light spot to set the default light position.

73D - Cross Section
Default settings for 3D cross sections.

Options tab > Preferences group > & Preferences > 7 3D - Section.

¥ Preferences

S Common 3D - Cross Section ﬁ'

an
@ 3D - Display 8 show section line during section move

3D - Model Tree

[ 30 - Color Section line color [ |

ﬁ 3D - Cross Section

& 3D - Annotations

B 3D - Import Basic

B 3D - Import Adv/Prem

& 2D - Annotations
\EL Print/Picture (Capture
E# Hardware

L4 File Assodations

OK Cancel

Show section line during section move (Default: Active)
Do not hide the section line while moving the cross section.

Section line color (Default: Red)
Choose a color for the section line.
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< 3D - Annotations
Default settings of dimensions and annotations.

Options tab > Preferences group > & Preferences > <”3D - Annotations.

¥, Preferences

Eb’_ Common 3D - Annotations &
&
L[] 3D - Display Attributes for new dimensions/markups
3D - Model Tree Text color .
--[#] 3D - Color

ﬁ 3D - Cross Section Background color D
& 3D - Annotations

[ 3D - Import Basic Line color | ]

L= 30 - Import Adv Prem

E 30 - Publish/Expart Text size 14 ~
E

i 2D - Display Distance decimal format 0XX v

& 2D - Annotations X
I_E.:I Print/Picture [Capture Angle decimal format [0 '+ S
E# Hardware

[ Always on top
4% File Associations

[CJuse leading text description

oK Cancel

Foreground color (Default: Black)
Choose the text color of new dimensions/annotations.

Background color (Default: Light yellow)
Choose the color of the text box of new dimensions/annotations.

Line color (Default: Red)
Choose the color of the lines of new dimensions/annotations.

Text height (Default: 14)
Choose the text height of new dimensions/annotations.

Distance: Decimal format (Default: 0.XX - 2 places for mm, 0.XXX - 3 places for inch)
Choose the number of decimal places used with newly measured distances.

Angle: Decimal format (Default: 0.XX - 2 places)
Choose the number of decimal places used with newly measured angles.

Stay on top (Default: Inactive)
Always display new dimensions/annotations in front of the model, even if they are located behind the model.

Use leading text description (Default: Inactive)
Display a leading text description for the dimension type.

= 3D - Import Basic
Default settings used with the Basic 3D Import.

Options tab > Preferences group > 2 Preferences > 3D - Import Basic.

¥ Preferences

By Common 3D - Import Basic =
ab
; ﬂ] 3D - Display [C)smoothen flat meshes on import

3D - Model Tree - =
[ 30 - Color =
ﬁ 3D - Cross Section STL files
& 3D - Annotations B Load * s.stl files in one shell
[~ 3D - Import Basic B Load colored STL files as colored
£ 30 - Import Adv/Prem O Assign color to non-colored STL files

(O select a color for all non-colored STL files

20]
E 2D - Display Sort STL and SLP files while loading
‘59 2D - Annotations B sort shells by
@J Print/Picture/Capture .
9 Hardware (_) Number of triangles
4% Fila Associations O Volume O Upwards
O volume of bounds O Downwards

(_) Number of open edges

oK Cancel
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Smoothen flat meshes on import (Default: Inactive)
Calculate smooth vectors while loading files that do not contain smooth vectors. To do so, set Smooth angle.
Angles between 20 and 35 degrees deliver the best results.

Load *_s.stl files in one shell (Default: Active)
Load STL-Support files (*_s.stl) as one shell.

Load colored STL files as colored (Default: Active)
Load the colors from STL files that contain color data.

Assign color to non-colored STL files (Default: Active)
Automatically assign a new color to every STL file that does not contain color data.

Select a color for all non-colored STL files (Default: Inactive)
Assign the selected color to all STL files that do not contain color data. Click the square button to select the color.

Sort shells while loading STL or SLP files (Default: Active)

Sort the shells of the models while loading STL and SLP files.
Select the type and direction of sorting.

By number of triangles.

By volume.

By volume of bounds (Default).

By number of open edges.

Up / Down

23D - Import Advanced/Premium
Default settings used with the advanced and premium 3D import.

Options tab > Preferences group > & Preferences > 3D - Import Adv/Prem.

¥ Preferences

ﬁ 3D - Cross Section
& 3D - Annotations
B3 - Import Basic

L a0 - Import Adv /Prem
----- H 3D - Publish/Export

S Common 3D - Import Advanced,Premium
<
30 - Display B show import settings dialog
&[T 30 - Mode! Tree [ Load hidden entities
[ 30 - Color

[CJLoad face boundaries

Default import setting

Custom tessellation settings

High Quality w

Angle control 20.00

Chord height 0.050

Premium Importer

[ Use Premium Importer for STEP, IG5, VDA, SAT and
Parasolid files

& 2D - Annotations
ElL Print/Picture /Capture
E# Hardware
% File Associations 18 show import warnings and errors
I8 Use black color for white PMI

OK Cancel

L% 4

Show import settings dialog (Default: Active)
Show the import settings dialog when loading 3D-CAD files.

Load hidden entities (Default: Inactive)
Activate the Load hidden entities option in the import settings.

Load face boundaries (Default: Inactive)
When loading models, load their face boundaries as curves.

Default import settings (Default: High Quality)

Use one of the following presets for the tessellation settings in the import settings dialog.
Custom

High Quality

Low Quality

CAD Graphical data

NoHeal(BREPs only)

Custom tessellation settings
Set the values for the Custom preset in the import settings dialog.
e Chord height (Default: 0,05 mm / 0.002 inch)
Enter a value for the chord height.
¢ Angle control (Default: 20)
Enter a value for the angle control.
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Premium-Importer (3D-Tool Premium only)
e Use Premium-Importer for STEP, IGS, VDA, SAT and Parasolid (Default: Active)
Use the Premium Importer with STEP, IGS, VDA, SAT, and Parasolid files.
Otherwise the Advanced Importer will be used with these files.
o Show import warnings and errors (Default: Active)
After loading, shows import errors and warnings, e.g. missing parts and information on non-supported formats.
¢ Use black color for white PMI
During import, change the color of white colored product manufacturing information to black to increase their
visibility

& 3D - Publish / Export

Default settings for publishing and saving data.

Options tab > Preferences group > & Preferences >[5 3D - Publish/Export.

¥ Preferences

Cg Common 3D - Publish/Export H
30
{-[77 3D - Display EXE,/DDD short message: Full path to txt file
3D - Model Tree
(%] 3D - Color
ﬁ' 3D - Cross Section STL files
<2 £ - IAnnot::on.S ] overwrite STL files without confirmation
> 0 :Izgs:t AZ?;Prem B save STL files with color information
n 3D - Publish/Export
[20) 305 files

i-[d 20 - Display [ tndude smooth groups in 305 files
& 2D - Annotations
EL Print/Picture /Capture
EZ Hardware
4 File Associations

Angel to create smooth groups 45 ~

oK Cancel

EXE/DDD short message: Full path to txt file (Default: Empty)
Enter the path and file name of a text file (*.txt) that is used as short message for publishing every time an
EXE/DDD file is published. The text is limited to 2000 characters and can be edited before the file is published.

Overwrite STL files without confirmation (Default: Inactive)
When saving models as STL files overwrite already exiting files without any warning.

Save STL files with color information (Default: Active)
Save the colors of the model with STL files. The files can be used with any other program. But since there is no
standard of STL colors, the colors may not be displayed correctly.

Include smooth groups in 3DS files (Default: Inactive)
When 3DS files are saved, create smooth groups based on the angle set in Angle to create smooth groups.
(Default 45)
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2 2D - Display

Default settings of the 2D display when the program is started.

Options tab > Preferences group > & Preferences >[= 2D - Display.

¥, Preferences

Eb’_ Common

&

3D - Display

[ 3D - Model Tree
5] 3D - Color

ﬁ 3D - Cross Section
& 3D - Annotations
E 3D - Import Basic

2D - Display

Resolution for curves and drdes

Background
10 Black color
() White colar

[CJuse antialiased lines

() Custom color =

EIE 2D - Display [:] Use thin lines
& 2D - Annotations
r_@___] Print/Picture /Capture
E@ Hardware
8% File Associations
OK Cancel

Resolution for curves and circles (Default: 32)

Set the value of the arc resolution. A large value will result in a better display of arcs but reduce the speed of the

display.

Background (Default: Black)'
Choose the color for the background at program start-up

e Black

Use a black background.

o White

Use a white background.

e Custom color

Choose any color for the background. Click the square button to choose the color.

Use antialiased lines (Default: Inactive)
Smooth the display of lines in the drawing.

Use thin lines (Default: Inactive)

At program start-up, show all lines of the drawing with a width of 1 point.

< 2D - Annotations

Default settings of new 2D Annotations and Dimensions.

Options tab > Preferences group > 2 Preferences > <" 2D - Annotations.

¥ Preferences

Text height (Default: 14)

By Common 2D - Annotations &
ab
i (77 3D - Display Dimensions
3D -Model Tree Text size and color 14~ .
[ 3D - Color
ﬁ 3D - Cross Section
{9 3D - Annotations Line thickness and color | ]
[ 3D - Import Basic
E 3D - Import AdvPrem
E m 3D - Publish/Export Arrow length and type
H
{4 20 - Display Distance dedmal format 0 v
{9 2D - Annotations
@J Print/Picture/Capture Angle decimal format 0Xx
E# Hardware
L File Associations Redline markups
Line thickness .
oK Cancel
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Choose the text height of new Dimensions.

e Color (Default: Red)

Choose the text color of new Dimensions.

Line thickness (Default: 1)

Choose the width of lines of new Dimensions.

e Color (Default: Red)
Choose the color of lines of new Dimensions.

Arrow (Default: inner triangle)

Choose the arrow head of new Dimension.

e Length (Default: 3)

Choose the length of an arrow head of new Annotations and Dimensions.

Distance: Decimal format (Default: 0.XX - 2 places for mm, 0.XXX - 3 places for inch)
Choose the number of decimal places used with newly measured distances.

Angle: Decimal format (Default: 0.XX - 2 places)

Choose the number of decimal places used with newly measured angles.

Redline markups

e Line thickness (Default: 3)
Choose the width of new redline markups.

e Color (Default: Red)
Choose the color of a new redline markups.

E Print / Picture / Capture

Default settings for print-outs, pictures and captures.

Options tab > Preferences group > & Preferences > & Print/Picture/Capture.

¥ Preferences

E# Hardware

i

- Display

- Model Tree

- Color

- Cross Section

- Annotations

- Import Basic

- Import Adv /Prem
- Publish/Export

- Display
& 2D - Annotations
=L, Print/Picture/Capture

i File Assodations

Print /Picture

Print/Picture /Capture

Print / Picture
Preferred print format
() Portrait
© Landscape

IPG quality 90

Capture to Clipboard
B Use white background
B Use antialias

[ Indude frame

OK Cancel

.

Change the default settings for print-outs and pictures.
o Preferred print format (Default: Landscape)
Choose the preferred format for printing: Landscape or Portrait

o Jpeg quality (Default: 90)
Set the quality of JPG pictures that were created with 3D-Tool. Possible values are between 30 and 100. Larger

values will result in better quality but also in a larger file.

Capture to Clipboard

Settings for capturing sections of the screen to the Clipboard.

o Use white background (Default: Inactive)

Draw a black frame around the captured screenshot.
o Use antialias (Default: Active)

Use antialias on the captured screenshot.
o Include frame (Default: Inactive)

Draw a black frame around the captured screenshot.

= Hardware

Activate the hardware acceleration and adjust the zoom speed of the mouse wheel.

Options tab > Preferences group > & Preferences > B Hardware.
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¥ Preferences

By common Hardware =]
an

[T 3D - Display Graphic Hardware
| 30 - Model Tree B Enable hardware acceleration

[E=%] 3D - Color 18 Use OpencL 3.3
ﬁ 3D - Cross Section

{9 3D - Annotations
B 3D - Import Basic
3D - Import AdwPrem Slow v Fast
3D - Publish,/Export

Mouse wheel zoom

[CJReverse wheel zoom direction
[2 2D - Display

&<9 2D - Annotations 3D Mouse Speed
Print/Picture/Capture
E# Hardware (O Slow © Normal (O Fast

% File Associations

oK Cancel

Enable Hardware Acceleration (Default: Inactive)

Activate the OpenGL hardware acceleration of the graphics card at program start-up. In rare cases, problems

may occur after the hardware acceleration is activated.
Enable OpenGL 3.3 (Default: Inactive)

When the hardware acceleration is enabled, the OpenGL 3.3 hardware acceleration of the graphics card can also
be activated to optimize the display performance. In rare cases, after the activation some older graphic drivers

may show incorrect shading or colors.

@ Note

When enabling the OpenGL 3.3 option for the first time, you can perform a short, one-minute test that tests the

display performance of the graphics card. This test is recommended.

Mouse wheel zoom
Set the speed of the zoom when using the scroll wheel.
¢ Reverse wheel zoom direction (default: Inactive).
Reverses the direction of the mouse wheel for zooming in/out the view.

3D Mouse Speed
Set the speed of the 3D mouse.
e Slow
e Normal
o Fast

# File Associations

The file extensions associated with 3D-Tool.

]

Options tab > Preferences group > 2 Preferences > ‘i File Associations.

s e

H5 Common File Associations gt
o]
) File formats opened in 3D-Tool by double-dicking
- Display
-Model Tree —- 3D Basic formats —
- col ¥ (=.ddd) 30-Tool files
eer 4 (*.3ds) 30-Studio fies
- Cross Section ¥ (=.3mf) 3MF files
- Annotations B (*.asc) ASC files
- Import Basic g E‘-DFJ'; S_%Jﬁf?'es
- *ply. es
;mgfr':;dval;em ¥ (*.slp) Pro/E Render files
- Fublish/Expor H (=.5t) S5TL files
B (=wrl, =wrz, %iv) VRML files
- Display B (=.xgl, *.zgl) XGL files
- Annotations - 3‘3.“"2’?*" s =
L PrintfPictureCapture ® (*.igs, *.iges) IGS files
nn P ® (=.sat, *.sab) ACIS files
[E2 Hardware B (=.stp, *.step, *.stpz) STEP files
i File Associations ¥ (=.vda) VDA files
M (=.x_t, *.x_b) Parasolid files
% Apply
K Cancel

" J

Check all file formats you want to associate with 3D-Tool, and click Apply.
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The list contains all file formats that are supported by 3D-Tool. Non-selectable (gray colored) file formats are not
available with your 3D-Tool Version/License.

@ Notes
¢ Once a file association is set, it will be activated until it is overwritten by another program.
e To set a file connection, you have to have administrative rights. Starting with Windows Vista, you will be asked to
confirm and possibly to re-enter the administrative password by the User Account Control (UAC).
¢ File associations set by a Windows user manually may fail to be changed by 3D-Tool.
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% 3D-NativeCAD Converter (only available with 3D-Tool Premium)

Use the 3D-Native CAD Converter to convert CATIA, Pro/E, Inventor, SolidWorks, SolidEdge, UG/Siemens NX, STEP,
IGS, VDA, SAT, JT and Parasolid files to CATIA V4/5, STEP, IGS, VDA, SAT, SAB, ASAT, and STL files.

Open CAD File and Adjust Conversion

&

3D-MativeCAD Converter

Options  Help
Convert CAD part or assembly to a CATIA V5-6R.2015 file

File to convert:
C:\Test\Model\Spannrolle.stp

Qutput file: Format:
C:\Test\Model\Spannrolle. CATProduct ... | |CATIAVS ~
Format specific options: Version:
B CATIAVS: Use Hybrid Bodies W5-GR2015
Options

_ Configurations/Simplified Rep.

|_| Convert hidden entities B convert curves < =z s

B Healing B convert points No configuration data available

B Create log file

(s Convert Complete % cm:;;s-.ﬂit::nd

Convert all parts and assemblies. Read the assembly structure and
choose parts and assemblies,
which should be converted.

File to convert

Click on & Choose a file to convert to select the 3D-CAD file you want to convert.

Supported file formats:

CATIA V6 files and assemblies, V6R2013 - V6R2023
(only saved as *.CATPart, *.CATProduct)

CATIA V5 files and assemblies, V5R8 - V5-6R2023
(*.CATPart, *.CATProduct)

CATIA V4 files and assemblies, 4.1.9-4.2.4
(*.model, *.exp, *.session)

Pro/E, Creo files and assemblies, 16 - WF 5, Creo 10.0
(*.prt, *.prt.*, *.asm, *.asm.*, *.xpr, *.xas)

Inventor files and assembilies, 6 - 2024

(*.ipt off Inventer 6, *.iam off Inventor 11)
SolidWorks files and assemblies, 98 - 2023

(*.sldprt, *.sldasm)

SolidEdge files and assemblies, 18 - 2023

(*.par, *.psm, *.asm)

UG/Siemens NX files, 11 - NX 2306

(*.prt)

Parasolid files, V10 - V35

(*x_t, x_b)

Rhino files, 2 -7

(*.3dm)

JT-files, Version 8 - Version 10.3, 10.5, 10.6, 10.7 only CAD/BREP-Data (*jt)
DWG files, 2.5 - 2024, (*.dwg)

DXF files, 2.5 - 2024, (*.dxf)

IGS files (*.igs)

STEP files (*.stp)

VDA-files (*.vda)

SAT/SAB files, ASIC-Text (*.sat), ASIC-Binar (*.sab)

Output file

The complete path to the output file.The file that was converted will be saved in the same folder and under the
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same name as the original file by default. The file extension will be adjusted according to the output format. The
path can be edited. Non-existent directories will be created. Click the [...] button to browse existing drives and
folders and to create new folders.

Format

From the drop down list, choose one of the supported output formats.

CATIA V5: 3D-CAD model in the Catia V5 format. CATproduct will be displayed as file extension of the output file
by default. If the file that is to be converted is not an assembly, a CATPart file will be created automatically.
CATIA V4: 3D-CAD model in the Catia V4 format.

STEP: 3D-CAD model in the STEP format.

STL: Triangulated 3D model in the STL format.

ACIS SAT: 3D-CAD model in the SAT format (ASIC-text).

ACIS SAB: 3D-CAD model in the SAB format (ASIC-binary).

ACIS ASAT: 3D-CAD model in the ASAT format (ASIC-text with assemblies). If the file to be converted is not an
assembly, the conversion into ASAT is not possible, and a SAB file will be created. ASAT files can be imported
into 3D-Tool.

X_T: 3D-CAD model in the X_T-Format (Parasolid-Text).

XML-E-BOM: 3D-CAD model in the XML E-BOM format (XML assembly structure and SAB parts). When
converting assemblies, there may be parts that cause problems. In these cases, first convert to the XML E-BOM
format, and then, in a second step, to the desired output format. If the direct conversion of an assembly fails
because of defective parts, this approach will often lead to success. Please note that XML files can only be used
from the folder they were created in.

Version

From the dropdown list, choose the file version when converting to CATIA V5, SAT, SAB and X_T. Possible
values are:

For CATIA V5: V5R15 to V5-6R2023

For SAT: V7, V8 and V10 to R2023

For SAB: V18 to R2023

For X_T: V12 to V35

Format specific options

CATIAVS5: Use hybrid bodies (Default: active)
Create so called "Hybrid Bodies" when converting models to CATIA V5. With "Hybrid Bodies" wire and face
geometries are created directly within the solid bodies and not within separate geometrical sets.

Options

Output units (Default depends on Windows settings: mm for metric, inch for US system units)

Set the units of the output file. If the units of the output file differ from the units of the native file, the model will be
scaled. This option is not available for conversions to CATIA V5 because CATIA V5 only supports millimeter (mm)
units.

Convert curves (Default: Active)

Convert curves too. If inactive, curves and lines will not be converted.

Convert points (Default: Active)

Convert point too. If inactive, the points will not be converted.

Healing (Default: Active)

Resolve problems that are caused by specific attributes of the various file formats or inaccuracies that occur
during the conversion.

Create Log file (Default: Active)

Create Log files (*.log) in the directory of the output file during the conversion. The name of the Log files is the
same as the file that is converted. During 2-Step conversion two log files will be created. The files contains
information about the conversion process, and can be opened with a text editor.

Convert hidden entities (Default: Inactive)

Activate the conversion of elements that are hidden in the file that will be converted.

Tessellation-Chord height (Default: 0.05 mm / 0.002 inch)

Enter the chord height used for triangulation when converting to STL. Smaller values increase the quality of the
display but also increase the file size.

Tessellation-Angle control (Default: 20.00)

Enter the tolerance angle used for triangulation when converting to STL. Smaller values increase the quality of the
display but also increase the file size.

Read Configurations

Pro/Engineer and Creo assemblies can contain Simplified Representations and SolidWorks models so called
Configurations. To set a representation/configuration for conversion, click the = Read Configurations button.

@ Note

The default values for these options can be changed in the Preferences of the 3D-NativeCAD Converter:
Options menu > Preferences
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% Convert Complete

Click % Convert Complete to convert all parts and assemblies of the file to be converted.

The converter starts in a new window which displays information on the conversion progress. Do not close this

window before the conversion is complete unless you want to abort the conversion. The window will automatically
close when the conversion is completed.

& Choose Parts and Assemblies

Click @ Choose Parts and Assemblies to choose the parts and assemblies to be converted.

#5 3D-NativeCAD Converter
Options  Help
Convert CAD part or assembly to a CATIA V5-6R2015 file Select parts which should be converted

E|E|E| 8B

File to convert:

|C: \Test\Modell\Original_Spannrolle.stp |

~ {0 Original_Spannrolle
Spannrolle{mit Einbaubedingungen)

v
Output file: Format:

|C: ‘\Test\Modell\Original_Spannrolle. CATProduct | .. | |CATIAVS ~

Format specific options: Version: H mﬁl Winkel
CATIAVS: Use Hybrid Bodies Y5-BR2015

& Winkel

Options

Configurations/Simplified Rep.
[ Convert hidden entities [ Convert curves g (e z

Healing Convert points Mo configuration data available
Create log file

% Convert Selected

The assembly structure of the file to be converted will be read. For complex assemblies this may take some time.

When the assembly structure is completely read, the Model Tree is displayed to Select the parts which should be
converted.

Select the parts which should be converted
To expand and collapse an assembly, click the arrow symbol in front of the assembly.
To disable a part, click "s.
To enable a part, click ™.
To disable an assembly, click & .
To enable an assembly, click 5,

% Convert Selected

Convert all enabled parts and assemblies. Disabled parts ' and assemblies "+ will not be converted. For
conversion at least one part must be enabled.

The converter starts in a new window which displays information on the conversion progress. Do not close this
window before the conversion is complete unless you want to abort the conversion. The window will close
automatically when the conversion is completed

E Expand all assemblies in the Model Tree
Expand all assemblies in the Model Tree. All parts and assemblies of the model can be seen in the Model Tree.

E Collapse all assemblies in the Model Tree
Collapse all assemblies in the Model Tree. Only the model can be seen in the Model Tree.

£ Enable all parts and assemblies
Enable all parts and assemblies for conversion.

Z Disable all parts and assemblies
Disable all parts and assemblies for conversion.
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Preferences

Change the language of the interface and the converters default conversion options.

Preferences

Common

Program language English v
18 Healing B Convert curves
[ Convert hidden entities B Convert points
Tessellation settings
Chord height 0.050 Angle control 20,00

8 Create log file

Default units
Omm Oinch

B CATIAVS: Use Hybrid Bodies

OK Cancel

Program language
Set the language of the user interface.

Healing (Default: Active)
Activate Healing on start-up of the converter.

Convert hidden entities (Default: Inactive)
Activate the conversion of hidden entities on startup of the converter.

Convert curves (Default: Active)
Activate the conversion of curves on start-up of the converter.

Convert points (Default: Active)
Activate the conversion of points on start-up of the converter.

Tesselation - Chord height (Default: 0.05 mm / 0.002 inch)
For conversions to STL set the default chord height value.

Tesselation - Angle control (Default: 20.00)
For conversions to STL set the default angle control value.

Create Log file (Default: Active)
Activate the creation of log files on start-up of the converter.

Default units (Default depends on Windows settings: mm for metric, inch for US system units)

Set the default units used for file output.

CATIAVS: Use hybrid bodies (Default: active)
On start-up of the converter activate hybrid bodies for the CATIA V5 output.
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Batch Mode

Convert complete models via command line. This enables you to create your own batch files for conversion.

& 3D-NativeCAD Converter

Options  Help

Convert CAD part or assembly to a CATIA V5-6R2015 file
File to convert:

C:\Test\Model\Spannrolle.stp

Output file: Format:
C:\Test\Model\Spannrolle. CATProduct ... CATIAVS ~
Format specific options: Version:
I8 CATIAVS: Use Hybrid Bodies V5-6R2015
Options

— Configurations/Simplified Rep.

|_| Convert hidden entities B convert curves g fnz »

B Healing B convert paints No configuration data available

B Create log file

Choose Parts and
% Convert Complete @ Aesemblics

Batch content for the converter:

"C:\Program Files\3D-Tool V16\Convert.exe” - "C:\Test\Model\Spannrolle.stp™ -0 "C:\Test\Model
\Spannrolle, CATProduct” -oversion V5R.25 -ounit mm -healing 1 -hidden 0 -curves 1 -points 1 -hybridbodies 1 Hog "C:
Test\Model\Spannrolle.stp.log™

Show Batch Content
For help when creating your own batch files, open a file to be converted and setup the conversion.

In the Options menu, click Show Batch Content. The field Batch content for the converter shows the command
line to call up the converter with the current conversion settings. You can copy the content of the field and use it
with your batch file.

Call of the converter

"InstallationPath\Convert.exe" -i "CADfile" -o "OutputFile"
[~ounit [mm/in]] [-healing [1/0]] [-hidden [1/0]] [-curves [1/0]] [-points [1/0]] [-config [Name]]
[-chord [Number]] [-angle [0 - 90]] [-hybridbodies [1/0]] [-log [Path\filename.log]]

"CADfile" > Path and file name of the file that is to be converted.
"OutputFile" > Path and file name of the converted file.

The file format of the output file is specified by its file extension:
e * CATPart, *.CATProduct
To create CATIA V5 files both file extensions can be used. If the file to be converted is an assembly always a
CATProduct will be created. If the file to be converted is only a part always a CATPart will be created.
*.model for Catia V4
*.stp for STEP
*.igs for IGES
*.vda for VDA
*.sat for ASIC SAT (ASIC text)
*.sab for ASIC SAB (ASIC binary)
*.asat for ASIC ASAT
If the file to be converted is not an assembly, the conversion into ASAT is not possible, and a SAB file will be
created automatically.
o *.x_t for X_T (Parasolid-Text)
o *.xml for XML E-BOM

If the file to be converted is not an assembly, the conversion into XML-E-BOM is not possible, and no file will be
created.

o *stlfor STL

@ Notes

o Directories cannot be created in the batch mode. If the directory that has been assigned to an output file does not
exist, the file cannot be saved.

¢ In batch mode, only complete models can be converted. It is not possible to choose parts and assemblies.
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¢ In Windows batch files (*.bat) any special chars and international chars within file names and other parameters
can only be used if an according code page is specified via CHCP command.

Optional parameters
The following parameters are optional. For parameters that have not been set, the default values as specified
here, and not the default values as set in the Preferences of the 3D-NativeCAD Converter will be used.

-oversion [Version name] > Version of the output file (Defaults: CATIAV5: V5-6R2015, SAT: V21, SAB: V21. X_T:
V19)

When converting to CATIA V5, SAT and SAB a file version can be specified for the output file. Possible version
names are: For CATIA V5: V5R15 to V5-6R2023, for SAT: V7, V8 and V10 to R2023, for SAB: V18 to R2023, and
for X_T: V12 to V35.

-unit [mm/in] > Units of the output file (Default: mm)

Units: mm = Millimeter, in = Inch. If the units of the file to be converted differ then the model will be scaled.
-healing [1/0] > Healing (Default: 1 = enabled)

-hidden [1/0] > Convert hidden entities (Default: 0 = disabled)

-curves [1/0] > Convert curves for STEP, SAT, SAB, ASAT (Default: 1 = enabled)

-points [[1/0] > Convert points for STEP, SAT, SAB, ASAT (Default: 1 = enabled)

-config [Name] > Name of a representation/configuration (Default: Default configuration)

Pro/Engineer and Creo assemblies can contain Simplified Representations and SolidWorks models so called
Configurations. To set a representation/configuration for conversion, specify the name of the
representation/configuration after the -config parameter.

-chord [Number] > Chord height for STL output (Default: 0.05)

-angle [0 - 90] > Angle control for STL output (Default: 20.00)

-log [Path\filename.log] > Log file (Default: No Log file)

-hybridbodies [1/0] > CATIA V5: Use hybrid bodies (Default: 1 =enabled)

Requirements
The following requirements have to be met to use the 3D-NativeCAD Converter.

Supported Operating Systems
Windows 10 (64bit)
Windows 11

Software Requirements to use the converter
The following software will be installed if necassary together with 3D-Tool as it is required for the converter:
Microsoft Visual C++2015 -2022 Redistributable [x86/x64]

64bit Interfaces
3D-Tool is a 32bit and 64bit software. The 64bit version of the program is supported by Windows 7 x64; Windows
8 x64, Windows 10 x64, and Windows 11. The 3D-Tool Premium interfaces and the 3D-NativeCAD Converter are
only available in Windows 10 x64 and Windows 11.

Limitations
The following limitations apply to the 3D-NativeCAD Converter.

Common

e 32bit Operating Systems
The 3D-Tool Premium interfaces and the 3D-NativeCAD Converter are not supported on 32bit operating systems.

e Assembly attributes
Attributes assigned on the assembly level are not read by the converter, e.g. colors assigned on the assembly
level get lost and elements hidden on the assembly level will be loaded.

e Assembly features
Features (e.g. cuts, bodies, holes) added on the assembly level are not supported and will be ignored by the
converter. The support of patterns added on the assembly level is limited in the converter.

e Properties and attributes
General properties, such as color and name, are supported by the converter to a limited extent. Other properties
and custom attributes are not supported by the converter unless specifically noted.

¢ Material properties (name and density)
The converter does not support material properties. The viewer supports material names and material densities for
native models from CATIA V5/V6, Pro/Engineer, Creo, Siemens/UG NX, Inventor and SolidWorks. Loading the
material properties into the viewer does not work for the import settings "CAD - graphical data" and "NoHeal".
Further restrictions when loading material information can be found in the format-specific restrictions

¢ Product Manufacturing Information (PMI)
The converter does not support the conversion of PMI-data, not even to output formats that support PMI.

e 2D-data / 2D-sketches
2D-data and 2D-sketches are not supported by the converter.

e Layers
In the converter the translation of layer information is limited.

¢ Free parts, faces, and curves
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The converter supports free parts, faces, and curves on the top assembly level only and not within sub-
assemblies.

Axes, planes, and local coordinate systems

The support of axes, planes, and local coordinate systems is limited in the converter.

User-defined views

User-defined views and component views are not supported by the converter.

Graphical data (visualization data)

The converter does not support graphical visualization data that is contained in 3D-CAD files in addition to the
CAD/BREP-data.

Embedded triangulated data

Triangulated data embedded in 3D-CAD-files is not supported by the converter.

Supressed elements

Suppressed element will not be read by the converter, not even by activating the "Convert hidden elements”
option.

Hidden elements

Hidden elements will be read by the converter when the "Convert hidden elements" option is activated. If hidden
elements are converted to file formats that do not support hidden elements (e.g. STEP) the hidden elements will
be visible.

Native CAD Files

Native CAD files from alpha, beta, PR and training versions of CAD systems are not supported by the viewer and
converter.

3DXML

The converter does not support 3DXML files.

Catia V5/V6

When reading CATPart files that contain bodies that share topology, the topology is duplicated for each body. This
may lead to very high memory usage and conversion time and may even cause the system to freeze.

When writing to CATIA V5 the converter supports rotation matrizes of direct isometry. The indirect isometry
(reflection) is not allowed.

The converter will not support files made with CATIA educational licenses.

CGR files are not supported by the converter.

All parts and sub-assemblies of an assembly file (*.CATProduct) have to be in the folder of the assembly file or its
sub-folders otherwise they will not be read by the converter.

The viewer and the converter will read CATIA files with names that contain non-ASCII characters only from drives
providing 8dot3 file names.

During the conversion to CATIA V5, all non ASCII characters in file and part names will be replaced by an
underscore. Additionally, in part names the characters ! : / \\ will be replaced by an underscore.

The converter require a complete file path to read and write CATIA V5 files in batch mode.

During the conversion to CATIA V5 the attributes line-type and line-thickness will be translated for free wires and
curves only but not for edges.

During the conversion to CATIA V5 multi-color wire bodies are output monochrome.

CATPart files created using the geometry scale "Small Scale" or "Big Scale" are not supported by the converter.
The converter supports only English characters in Publication Names. All non-English characters will be replaced
by a underline.

Due to hardware requirements, it may not be possible to view and to convert CATIA V5 files when using an older
computer (approx. before 2003). If you plan to use the CATIA V5 import on such a system, request a free Trial
Key to test the import.

Pro/Engineer, Creo

All parts and sub-assemblies of an assembly file (*.asm) have to be in the same folder otherwise they will not be
read by the converter.

The converter does not support Simplified Representations at part level.

Instances in family tables are read by the converter only if the corresponding XPR and XAS files are present, even
though these are only optional in Pro/E. Without the XPR and XAS files the generic parts are read.

The converter translates local coordinate systems only to file formats that support assemblies (CATIA V5, STEP,
IGES, ASAT).

The curves "using equation" and "local push" are not supported by the converter.

Cosmetic features are not supported by the viewer or the converter.

Hidden "merge features" will not always be read accurately by the converter.

Geometries that have been added to a component using SolidGeom filter are loaded by the viewer and the
converter, even if they have been hidden.

The converter does not support flexible assemblies. Thus, positioning and/or sizing of these components might be
incorrect.

In certain complex BREP scenarios, the converter may not show the ecpected results for bodies with multiple
lumps or for lumps with multiple shells.

The converter does not support electrical harness data - neither as BREPs nor as graphical visualization.

The converter do not support monolithic assembly files introduced with Creo 8.0. These are assemblies that
consist of a single file rather than multiple assembly and part files.

UG / Siemens NX
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All parts and sub-assemblies of an assembly file (*.prt) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the converter.

For body cuts the converter does not distinguish between the cutting tool body and the body to be cut. Both will be
converted as bodies.

SolidWorks

All parts and sub-assemblies of an assembly file (*.sldasm) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the converter.

Colors are supported by the converter starting with SolidWorks 2004.

The converter supports hidden elements starting with SolidWorks 2009.

The units of a model are read by the converter starting with SolidWorks 2001. With earlier versions the units are
always assumed as meters. This also applies to unsupported units such as feet and inch.

Hidden bodies and features within parts are not supported by the converter.

There is only limited support of hole features in the converter.

Free points (reference points) are not supported by the converter.

Free points (reference points) are not supported by the converter.

Pattern features are not supported by the converter.

The attributes "Show", "No-show" and "Hidden" will be read by the converter starting with SolidWorks 2004.
Configurations are supported starting with SolidWorks 98. In order to convert a part within an assembly in its
correct configuration, the according configuration must be saved in the part file. This is not necessarily the case,
especially not, if older parts have been opened and saved with a newer version of SolidWorks. If configurations
are missing, open the part in Solidworks, activate each configuration, and save the part. Faulty or missing part
configurations within SolidWorks assemblies may cause the converter to read the assembly only partial or even
not at all."

3D sketches and free curves are only partially supported by the viewer and converter, and only when opening and
converting the active configuration. Hidden curves or curves that are only visible in other configurations can not be
loaded and converted. Curves in the graphical data of the active configuration are supported by the Viewer as of
SolidWorks 2014.

External referenced features are not supported by the viewer and converter.

Parts and Assemblies embedded via ,.3D Interconnect® will only be supported by the viewer and the converter
from SolidWorks 2020.

Coordinate systems, work planes, and free points are not supported by the converter.

Unicode text is only supported from the "Basic Multilingual Plane" (Plane 0, BMP). Filenames from the
"Supplementary Ideographic Plane" (SIP) are not supported by the converter.

SolidEdge

All parts and sub-assemblies of an assembly file (*.asm) have to be in the folder of the assembly file or its sub-
folders otherwise they will not be read by the converter.

Coordinate systems (WCS) are not supported by the converter.

Simplified views will not be read by the converter.

SolidEdge sub-assemblies can have multiple family tables. In the root assembly one can select one of the tables
for each instance of the sub-assembly. The converter do not support this, so that the instances may have
unwanted or wrongly transformed parts.

Inventor

Rhino

JT

Inventor Model States are not supported by the viewer and the converter. The active model state will be loaded.
All parts and sub-assemblies of an assembly file (*.iam) have to be in the same folder otherwise they will not be
read by the converter.

Attributes, such as color and layer, are not read by the converter.

Some special Inventor features, such as "Lofting" and "Weld Symbols", are not supported by the converter.
Free curves and points (reference points) are not supported by the converter.

Flexible assemblies are not supported by the viewer and the converter. Positioning and/or sizing of flexible
components might be incorrect.

Tables are not supported by the converter. The position and size of table-driven iParts and iAssemblies may be
incorrect.

The viewer and the converter do not support Inventor files that contain Mesh features, such as STL-data.
Sheet metal bodies are not supported by the viewer and the converter prior to Inventor version 11.

Layer information is not supported by the converter. Only the current layer will be read.
Kilometer, mile, and higher units are not supported by the converter.

"Big Endian" files are not supported by the converter.

The Name and Layer attributes are not supported by the converter.

Free points are not supported by the converter.

The converter will not support smart-topology-tables, STEP BREPs, AEC-shape- und ULP-Segmente.

DWG/DXF

The converter do not support block properties (Color, Layer, Hidden, Show).
The converter only support the original RGB-color of an entity/layer. Insert Layer Mode color handling is not
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supported.

The name of BREPs are not supported by the converter.

AEC, AECB, and MEP entities are not supported by converter.

External references (XREF) are not supported by the converter.

Generally the converter will only support object of the basic version of AutoCAD und no industry specific objects
out of AutoCAD Architecture, AutoCAD Civil 3D, AutoCAD Electrical, AutoCAD Map 3D, AutoCAD Mechanical,
AutoCAD MEP, AutoCAD P&ID, AutoCAD Plant 3D und AutoCAD Utility Design.

STEP
e Faceted data (FACETED_BREP) within STEP files may lead to very high memory usage and conversion time and
even to system freezes.
e Some CAD formats support mirroring and scaling of assembly instances. Converting such transformed instances
to STEP is not supported since the STEP format requires "manufacturable" products.

IGES
e Binary and compressed IGES files are not supported by the converter.

VDA
e Errors can occur when reading VDA files with the viewer or the converter, especially if the accuracy of the VDA
data is insufficient. If such errors occur, as much data as possible is read.

Parasolid X_T
e The converter creates an empty Parasolid body for various types of elements such as material properties, axis
systems and user defined attributes. Some applications based on the Parasolid kernel have issues while opening
such files. This is not a limitation and we suggest that you contact the support for that particular Parasolid-based
application.
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14. Credits

3D-Tool thanks the following persons and companies.

3Dconnexion
3D input device development tools and related technology are provided under license from 3Dconnexion. ©
3Dconnexion 1992-2013. All Rights Reserved.

Bsalsa Productions
EmbeddedWebBrowser is provided by Bsalsa Productions.

Fitminimizers
Provided by Dmitry Morozov and distributed under the MPL 2.0 License. See MPL Licensed Source Code.
Copyright © by Dmitry Morozov

MPL Licensed Source Code
Portions of this software are licensed under the MPL License. The source code is available from https://www.3d-
tool.de/downloads/mpl licensed code.zip

Spatial Corporation
Portions of this software are owned by Spatial Corp.
© 1986-2023. All Rights Reserved.

Siemens PLM
Portions of this software are owned by Siemens Product Lifecycle Management Software Inc.
© 1986-2023. All Rights Reserved.

HarmonyWare
Portions of this software are owned by HarmonyWare, Inc.
© 1998-2023. All Rights Reserved.

SoftGold
Portions of this software are owned by SoftGold Software Company.
© 2001-2022 Soft Gold Ltd. All Rights Reserved.

3Dconnexion
3D input device development tools and related technology are provided under license from 3Dconnexion.
© 3Dconnexion 1992-2023. All Rights Reserved.

Intel Corporation
U3D Libraries are provided by the Intel Corporation under the Apache 2.0 License
© 1999-2006 Intel Corporation. All Rights Reserved.

Independent JPEG Group
Portions of this software are based on the work of the Independent JPEG Group
Copyright © 1991-2022, Thomas G. Lane, Guido Vollbeding, All Rights Reserved

Freelmage Open Source Image Libraty
This software uses the Freelmage open source image library. Seee http://freeimage.sourceforge.net for details.
Freelmage is used under the Freelmage Public License (FIPL), version 1.0.
Copyright © 2003-2012 by Freelmage

Dipl. Ing. Mike Lischke
Portions of this software are provided by Dipl. Ing. Mike Lischke
Copyright © 1999, Mike Lischke, mike@lischke-online.de

Bsalsa Productions
EmbeddedWebBrowser is provided by Bsalsa Productions.

Fitminimizers
Provided by Dmitry Morozov and distributed under the MPL 2.0 License. See MPL Licensed Source Code.
Copyright © by Dmitry Morozov

MPL Licensed Source Code
Portions of this software are licensed under the MPL License. The source code is available from
https://www.3d-tool.de/downloads/mpl_licensed_code.zip

DCPcrypt Cryptographic Component Library
Released under the MIT license
© 1999-2009, David Barton

3MF Consortium
Portions of this software are provided by the 3MF Consortium
Copyright © 2019, 3MF Consortium
All rights reserved

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
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disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The Apache Xerces Project

NOTICE file corresponding to section 4(d) of the Apache License, in this case for the Apache Xerces distribution.
This product includes software developed by The Apache Software Foundation (http://www.apache.org/). Portions
of this software were originally based on the following:

Software copyright © 1999, IBM Corporation., http://www.ibm.com

ICU - International Components for Unicode

Copyright © 1991-2023 Unicode, Inc. All rights reserved.
Distributed under the Terms of Use in https://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the Unicode data files and any
associated documentation (the "Data Files") or Unicode software and any associated documentation (the
"Software") to deal in the Data Files or Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Data Files or Software, and to permit persons to
whom the Data Files or Software are furnished to do so, provided that either (a) this copyright and permission
notice appear with all copies of the Data Files or Software, or (b) this copyright and permission notice appear in
associated Documentation.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO
EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to
promote the sale, use or other dealings in these Data Files or Software without prior written authorization of the
copyright holder.

SIL Open Font License version 1.1

7-zip

Copyright 2018 The Noto Project Authors (github.com/googlei18n/noto-fonts) with Reserved Font Name
GoNotoCurrent.ttf.

The SIL Open Font License version 1.1 can be found in the 3D-Tool installation folder as OFL-1.1.txt and is also
available with a FAQ at http://scripts.sil.org/OFL.

Copyright ©1999-2022, Igor Pavlov, https://www.7-zip.org

The licenses for files are:

1) 7z.dll:
- The "GNU LGPL" as main license for most of the code
- The "GNU LGPL" with "unRAR license restriction" for some code
- The "BSD 3-clause License" for some code

2) All other files: the "GNU LGPL".

Redistributions in binary form must reproduce related license information from this file.

Note: You can use 7-Zip on any computer, including a computer in a commercial organization. You don't need to
register or pay for 7-Zip.

PUGIXML

Portions of this software are based on the pugixml library (http://pugixml.org).
© 2006-2018 Arseny Kapoulkine
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GNU LGPL information

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General
Public License as published by the Free Software Foundation; either version 2.1 of the License, or (at your
option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY:; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details.

You can receive a copy of the GNU Lesser General Public License from http://www.gnu.org/

BSD 3-clause License

The "BSD 3-clause License" is used for the code in 7z.dll that implements LZFSE data decompression. That code
was derived from the code in the "LZFSE compression library" developed by Apple Inc,
that also uses the "BSD 3-clause License":

Copyright (c) 2015-2016, Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder(s) nor the names of any contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

unRAR license restriction

The decompression engine for RAR archives was developed using source
code of unRAR program. All copyrights to original unRAR code are owned by Alexander Roshal.

The license for original unRAR code has the following restriction:

The unRAR sources cannot be used to re-create the RAR compression algorithm, which is proprietary.
Distribution of modified unRAR sources in separate form or as a part of other software is permitted, provided that
it is clearly stated in the documentation and source comments that the code may not be used to develop a RAR
(WinRAR) compatible archiver.
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15. Additional Help

Use the following additional help when working with 3D-Tool.

3D-Tool Quick Reference
The 3D-Tool Quick Reference Card gives a quick overview of the user interface of 3D-Tool:
Windows Start > Programs > 3D-Tool V16 > Quick Reference.

3D-Tool Manual
This help is available as a PDF manual:
Windows Start > Programs > 3D-Tool V16 > Manual.

3D-Tool Tips and Tricks
Go to our website https://www.3d-tool.com/en-cad-viewer-fag.htm to find many useful tips that make it easier to

work with 3D-Tool..

3D-Tool tool tips
When the cursor is moved onto a button (e.g. on the Ribbon Menu) and remains there a moment, a short
description of the function is displayed.

3D-Tool website
Go to our website www.3D-Tool.com to find the newest information about 3D-Tool.
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